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Manuals for This Printer

For particular functions, see the relevant parts of the manual.

❖ Printer Reference
Provides information about printer setup, options, and dealing with paper
jams and error messages.

❖ Software Guide (HTML) (this manual)
Provides basic information about installing the printer driver and software, us-
ing the printer in a network environment, and configuration and setup.
Also, provides information about configuring and monitoring printer status us-
ing software and a Web browser.

❒ Some functions cannot be used depending on your printer.
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Preparing for Printing

Quick Install

Windows 95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0 users
can easily install this software using the CD-ROM provided.

Using Quick Install, the PCL printer driver and/or RPCS printer driver and Smart-
DeviceMonitor for Client is installed under network environment, and TCP/IP
port will be set.

❒ To install printer driver under Windows 2000/XP Professional, Windows Serv-
er 2003, and Windows NT 4.0, you must have an account that has Manage
Printers permission. Log on as an Administrator.

❒ The Quick Install is not available when using this printer under USB connec-
tion. If you connect using USB, see p.59 “Installing the Printer Driver Using
USB”.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [Quick Install].

The software license agreement appears in the [License Agreement] dialog box.

E After reading the agreement, click [I accept the agreement], and then click
[Next].

F Select the printer model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the printer whose IP address is dis-
played in [Connect To].

For parallel connection, select the printer whose printer port is displayed in
[Connect To].

G Click [Install].

The printer driver installation starts.

H Click [Finish].

A message about restarting the computer may appear. Restart the computer
to complete installation.
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I Click [Exit] in the first dialog box of the installer, and then take out the
CD-ROM.

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

❒ Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

❒ Select a printer to whose IP address is displayed in [Connect To] to install
SmartDeviceMonitor for Client when using TCP/IP.

Quick Install is not available unless bidirectional communication between
the printer and computer is enabled via parallel connection. See p.79 “If Bi-
directional Communication is Disabled” for details about bidirectional com-
munication between printer and computer.
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Confirming the Connection Method

This printer supports network and local connection.

Before installing the printer driver, check how the printer is connected. Follow the
driver installation procedure that is appropriate to the connection method.

Network Connection

This printer can be used as a Windows printing port or network printer.

Using this printer as the Windows printing port

Network connections can be established through Ethernet, IEEE 802.11b, and
IEEE 1394 (IP over 1394).

Available ports are determined based on the combination of Windows operating
system version and connection method used.

❖ Windows 95/98

❖ Windows Me

❖ Windows 2000

Connection Method Available Ports

Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

IEEE 1394 (IP over 1394) None

Connection Method Available Ports

Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

IEEE 1394 (IP over 1394) SmartDeviceMonitor for Client port

Connection Method Available Ports

Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port



Preparing for Printing

12

❖ Windows XP

❖ Windows Server 2003

❖ Windows NT 4.0

See the explanation of how to install the printer driver for each type of port.
For the SmartDeviceMonitor for Client port, see p.15 “Using the SmartDevice-
Monitor for Client Port”.

For the Standard TCP/IP port, see p.39 “Using the Standard TCP/IP Port”.

For the LPR port, see p.44 “Using the LPR Port”.

IEEE 1394 (IP over 1394) None

Connection Method Available Ports

Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port

IEEE 1394 (IP over 1394) SmartDeviceMonitor for Client port

Standard TCP/IP

Connection Method Available Ports

Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port

IEEE 1394 (IP over 1394) SmartDeviceMonitor for Client port

Standard TCP/IP

Connection Method Available Ports

Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

LPR port

IEEE 1394 (IP over 1394) None

Connection Method Available Ports
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Using as a network printer

This printer can be used as the Windows network printer, the NetWare print serv-
er, or the NetWare remote printer.

See the explanation of how to install the printer driver for each type of network
printer.

For the Windows network printer, see p.49 “Using as the Windows Network
Printer”.

For the NetWare print server and remote printer, see p.56 “Using as the Net-
Ware Print Server/Remote Printer”.

Local Connection

Local connections can be established via parallel, USB, IEEE 1394 (SCSI print),
and Bluetooth connections.

Windows operating system version determines the available connection meth-
ods.

• Windows 95:

• Parallel connections

• Windows 98:

• Parallel and Bluetooth connections

• Windows 98 SE/Me:

• USB, Parallel, and Bluetooth connections

• Windows 2000:

• USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

• Windows XP:

• USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

• Windows Server 2003:
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• USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

• Windows NT 4.0:

• Parallel and Bluetooth connections

See the explanation of how to install the printer driver for each method of
connection.

For the USB connection, see p.59 “Installing the Printer Driver Using USB”.

For the parallel connection, see p.65 “Printing with Parallel Connection”.

For the IEEE 1394 (SCSI print) connection, see p.70 “Installing the Printer
Driver Using IEEE 1394 (SCSI print)”.

For the Bluetooth connection, see p.74 “Printing with Bluetooth Connec-
tion”.
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Using the SmartDeviceMonitor for Client 
Port

Installing SmartDeviceMonitor for Client

❒ To install SmartDeviceMonitor for Client under Windows 2000/XP Profession-
al, Windows Server 2003, and Windows NT 4.0, you must have an account
that has Manage Printers permission. Log on as an Administrator.

❒ Install SmartDeviceMonitor for Client before installing the printer driver when
using the SmartDeviceMonitor for Client port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [SmartDeviceMonitor for Client/Admin].

E The SmartDeviceMonitor for Client installer starts.

F Click [SmartDeviceMonitor for Client], and then click [Next >].

The SmartDeviceMonitor for Client installer starts.

G The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [Yes] to accept it.

H Follow the instructions on the display to install SmartDeviceMonitor for
Client.

I Click [OK].

If you are required to restart the computer after installing SmartDeviceMonitor
for Client, restart the computer.

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete.
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❒ SmartDeviceMonitor for Client supports the following languages: Czech,
Danish, German, English, Spanish, French, Italian, Hungarian, Dutch, Nor-
wegian, Polish, Portuguese, Finnish, Swedish, Chinese Simple and Chi-
nese Traditional.

Installing the PCL or RPCS Printer Driver (TCP/IP)

❒ To install this printer driver under Windows 2000/XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement], and then click [Next].

F Select the printer driver you want to use in the [Printer Program] dialog
box.

You can select several printer drivers.

G Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Double-click the printer name to display the printer settings.

❒ The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

I Click [Port:], and then click [Add].

J Click [SmartDeviceMonitor], and then click [New Port...].

K Click [TCP/IP], and then click [Search].
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A list of printers using TCP/IP appears.

L Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify address], and then enter the IP address
or host name of the printer.

Under Windows 95/98/Me, you cannot add an IP address partially similar to
the one already used. For example, if “192.168.0.2” is in use, “192.168.0.2xx”
cannot be used. Similarly, if “192.168.0.20” is in use, “192.168.0.2” cannot be
used.

M Check that the port of the selected printer is displayed in [Port:].

N Set a user code, if necessary.

This allows a SmartDeviceMonitor for Admin user to display and check statis-
tics about the number of sheets which each user prints. For details, see
SmartDeviceMonitor for Admin Help.

Up to 8 numeric characters can be entered. Neither alphabetic characters nor
symbols are available.

O Select the [Default Printer] check box to configure the printer as default.

P Click [Finish].

Installation starts.

Q Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run. If
you still want to install the printer driver, install use [Add Printer]. See p.77
“If a Message Appears during Installation”.

Installing the PCL or RPCS Printer Driver (NetBEUI)

❒ To install this printer driver under Windows 2000, and Windows NT 4.0, you
must have an account that has Manage Printers permission. Log on as an Ad-
ministrators or Power Users group member.

❒ Windows XP and Windows Server 2003 do not support NetBEUI.

❒ You cannot print using printers beyond routers.

A Quit all applications currently running.
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B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe”on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement] , and then click
[Next].

F Select the printer driver you want to use in the [Printer Program] dialog
box.

You can select several printer drivers.

G Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Double-click the printer name to display the printer settings.

❒ The details shown in [Comment:], [Driver:], and [Port] vary depending on the
operating system, printer model, and port.

I Click [Port:], and then click [Add].

J Click [SmartDeviceMonitor], and then click [New Port...].

K Click [NetBEUI], and then click [Search].

A list of printers using NetBEUI appears.

L Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify address], and then enter the NetBEUI ad-
dress. The NetBEUI address can be checked with the configuration page. For
information about printing a configuration page, see p.141 “Printing a Config-
uration Page”. The NetBEUI address appears in the format of “\\RN-
Pxxxx\xxx” on the configuration page. Enter the printer's network path in the
format of “%%Computer name\Share name”. Use “\\” instead of “%%” at the
beginning.

M Check that the port of the selected printer is displayed in [Port:].

N Set a user code, if necessary.
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This allows a SmartDeviceMonitor for Admin user to display and check statis-
tics about the number of sheets which each user prints. For details, see
SmartDeviceMonitor for Admin Help.

Up to 8 numeric characters can be entered. Neither alphabetic characters nor
symbols are available.

O Select the [Default Printer] check box to configure the printer as default.

P Click [Finish].

The printer driver installation starts.

Q Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

❒ The protocol is set to inactive as default. Enable it using Web Image Mon-
itor or Telnet.

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run. If
you still want to install the printer driver, use [Add Printer]. See p.77 “If a
Message Appears during Installation”.

Installing the PCL or RPCS Printer Driver (IPP)

❒ To install printer driver under Windows 2000/XP Professional, Windows Serv-
er 2003, and Windows NT 4.0, you must have an account that has Manage
Printers permission. For this, log on as an Administrators or Power Users
group member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [PCL/RPCS Printer Drivers].
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E The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement], and then click [Next].

F Select a printer driver you want to use in the [Printer Program] dialog box.

You can select several printer drivers.

G Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Double-click the printer name to display the printer settings.

❒ The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

I Click [Port:], and then click [Add].

J Click [SmartDeviceMonitor], and then click [New Port...].

K Click [IPP].

L In the [Printer URL] box, enter “http://printer's address/printer” as the
printer's address.

If the server authentification is issued, to enable SSL( a protocol for encrypted
communication), enter “https://printer's address/printer” (Internet Explorer
5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://printer's address/ipp” as the printer's address.

M Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box
becomes the IPP port name.

N Click [Detailed Settings] to make necessary settings.

For information about the settings, see SmartDeviceMonitor for Client Help.

O Check that the port of the selected printer is displayed in [Port:].

P Set a user code, if necessary.

This allows a SmartDeviceMonitor for Admin user to display and check the
number of sheets each user prints. For details, see SmartDeviceMonitor for
Admin Help.



Preparing for Printing

21

Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols can be entered.

Q Select the [Default Printer] check box to configure the printer as default.

R Click [Finish].

Installation starts.

S Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run. If
you still want to install the printer driver, use [Add Printer]. See p.77 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me - 
TCP/IP)

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.
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G Select the name of the printer whose driver you want to install, and then
click [Next].

H In the [Available ports:] box, click [Printer Port], and then click [Next].

I Change the printer name if you want, and then click [Next].

Select the [Yes] check box to configure the printer as default.

J Specify whether or not to print a test page, and then click [Finish].

K On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

L Click the icon of the printer you want to use. On the [File] menu, click
[Properties].

M On the [Details] tab, click [Add Port…].

N Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].

O Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

P Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify address], and then enter the IP address
or host name of the printer.

You cannot add an IP address partially similar to the one already used. For
example, if “192.168.0.2” is in use, “192.168.0.2xx” cannot be used. Similarly,
if “192.168.0.20” is in use, “192.168.0.2” cannot be used.

Q Click [OK].

R Check that the selected port is highlighted in [Printer to the following port],
and then click [OK].

S Restart the computer to complete installation.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me - 
NetBEUI)

A Quit all applications currently running.
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B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe”on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the printer whose driver you want to install, and then
click [Next].

H In the [Available ports:] box, click [Printer Port], and then click [Next].

I Change the printer name if you want, and then click [Next].

Select the [Yes] check box to configure the printer as default.

J Specify whether or not to print a test page, and then click [Finish].

K On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

L Click the icon of the printer you want to use. On the [File] menu, click
[Properties].

M On the [Details] tab, click [Add Port…].

N Click [Other] in the [SmartDeviceMonitor] list, and then click [OK].

O Click [NetBEUI], and then click [Search].

A list of printers using [NetBEUI] appears.

P Click the printer you want to use, and then click [OK].
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Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify address], and then enter the NetBEUI ad-
dress. The NetBEUI address can be checked with the configuration page. For
information about printing a configuration page, see p.141 “Printing a Config-
uration Page”. The NetBEUI address appears in the format of “\\RN-
Pxxxx\xxx” on the configuration page. Enter the printer's network path in the
format of “%%Computer name\Share name”. Use “\\” instead of “%%” at the
beginning.

You cannot print using printers beyond routers.

Q Click [OK].

R Check that the selected port is highlighted in [Printer to the following port],
and then click [OK].

S Restart the computer to complete installation.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me - IPP)

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.
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G Select the name of the printer whose driver you want to install, and then
click [Next].

H In the [Available ports:] box, click [Printer Port], and then click [Next].

I Change the printer name if you want, and then click [Next].

Select the [Yes] check box to configure the printer as default.

J Specify whether or not to print a test page, and then click [Finish].

K On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

L Click the icon of the printer you want to use. On the [File] menu, click
[Properties].

M On the [Details] tab, click [Add Port…].

N Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].

O Click [IPP].

P In the [Printer URL] box, enter “http://(printer's address)/printer” as the
printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Explorer
5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://(printer's address)/ipp” as the printer's address.

Q Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box
becomes the IPP port name.

R Click [Detailed Settings] to configure proxy server, IPP user name, and oth-
er settings. Make these settings, and then click [OK]. For details, see
Help on the CD-ROM.

❒ For information about the settings, see SmartDeviceMonitor for Client
Help.

S Click [OK].
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T Check that the selected port is highlighted in [Printer to the following port],
and then click [OK] .

U Restart the computer to complete installation.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Add Port...].

H Click [SmartDeviceMonitor], and then click [Next >].

I Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

J Select the printer you want to use, and then click [OK].
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Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify address], and then enter the IP address
or host name of the printer.

K Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

M Click [Next >].

N Specify whether or not to print a test page, and then click [Next >].

O Click [Finish].

The printer driver installation starts.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000 - 
NetBEUI)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next >].
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F Click [Local printer], and then click [Next >].

G Click [Add Port...].

H Click [SmartDeviceMonitor], and then click [Next >].

I Click [NetBEUI], and then click [Search].

A list of printers using NetBEUI appears.

J Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify address], and then enter the NetBEUI ad-
dress. The NetBEUI address can be checked with the configuration page. For
information about printing a configuration page, see p.141 “Printing a Config-
uration Page”. The NetBEUI address appears in the format of “\\RN-
Pxxxx\xxx” on the configuration page. Enter the printer's network path in the
format of “%%Computer name\Share name”. Use“%%” instead of “\\” at the
beginning.

You cannot print using printers beyond routers.

K Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

M Click [Next >].

N Specify whether or not to print a test page, and then click [Next >].

O Click [Finish].

The printer driver installation starts.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.
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Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Add Port...].

H Click [SmartDeviceMonitor], and then click [Next >].

I Click [IPP].

J In the [Printer URL] box, enter “http://(printer's address)/printer” as the
printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Explorer
5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://(printer's address)/ipp” as the printer's address.

K Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the name of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box
becomes the IPP port name.

L Click [Detailed Settings] to configure proxy server, the IPP user name and
other settings. Specify the necessary settings, and then click [OK].

For information about the settings, see SmartDeviceMonitor for Client Help.

M Click [OK].

N Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].
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O Change the printer name if you want, and then click [Next >].

P Click [Next >].

Q Specify whether or not to print a test page, and then click [Next >].

R Click [Finish].

The printer driver installation starts.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003 - TCP/IP)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe”on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Create a new port:].

H Click [SmartDeviceMonitor], and then click [Next >].

I Click [TCP/IP], and then click [Search].
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A list of printers using [TCP/IP] appears.

J Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify address], and then enter the IP address
or host name of the printer.

K Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

M Click [Next >].

N Specify whether or not to print a test page, and then click [Next >].

O Click [Finish].

The printer driver installation starts.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003 - IPP)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
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Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Create a new port:].

H Click [SmartDeviceMonitor], and then click [Next >].

I Click [IPP].

J In the [Printer URL] box, enter “http://(printer's address)/printer” as the
printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Explorer
5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://(printer's address)/ipp” as the printer's address.

K Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box
becomes the IPP port name.

L Click [Detailed Settings] to make necessary settings.

For information about the settings, see SmartDeviceMonitor for Client Help.

M Click [OK].

N Check that the name of the printer driver you want to install is selected,
and then click [Next >].

O Change the name of the printer if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

P Click [Next >].

Q Specify whether or not to print a test page, and then click [Next >].

R Click [Finish].

The printer driver installation starts.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.



Preparing for Printing

33

Installing the PostScript 3 Printer Driver (Windows NT 4.0 - 
TCP/IP)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Add Port:].

G Click [SmartDeviceMonitor], and then click [New Port...].

H Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

I Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify address], and then enter the IP address
or host name of the printer.

J Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

K Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

L Specify whether or not to print a test page, and then click [Finish].
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The printer driver installation starts.

M Restart the computer to complete installation.

❒ A user code can be set after the printer driver installation . For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0 - 
NetBEUI)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Add Port:].

G Click [SmartDeviceMonitor], and then click [New Port...].

H Click [NetBEUI], and then click [Search].

A list of printers using NetBEUI appears.

I Select the printer you want to use, and then click [OK].
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Only printers that respond to a broadcast from the computer are displayed. To
use a printer not listed here, click [Specify address], and then enter the Net-
BEUI address. The NetBEUI address can be checked with the configuration
page. For information about printing a configuration page, see p.141 “Printing
a Configuration Page”. The NetBEUI address appears in the format of “\\RN-
Pxxxx\xxx” on the configuration page. Enter the printer's network path in the
format of “%%Computer name\Share name”. Use “%%” instead of “\\” at the
beginning.

You cannot print using printers beyond routers.

J Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

K Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

L Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

M Restart the computer to complete installation.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0 - IPP)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].



Preparing for Printing

36

Add Printer Wizard starts.

E Click [Next].

F Click [Add Port:].

G Click [SmartDeviceMonitor], and then click [New Port...].

H Click [IPP].

I In the [Printer URL] box, enter “http://(printer's address)/printer”as the
printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Explorer
5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://(printer's address)/ipp” as the printer's address.

J Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box
becomes the IPP port name.

K Click [Detailed Settings] to make necessary settings.

For information about the settings, see SmartDeviceMonitor for Client Help.

L Click [OK].

M Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

N Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

O Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

P Restart the computer to complete installation.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

❒ There are no settings for NetBEUI protocol.

Windows 95/98:

A Open [Printers] window from [Start] menu.

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C Click the [Details] tab, and then click [Configure Port].

The [Port Settings] dialog box appears.

Windows 2000 / Windows NT 4.0:

A Open [Printers] window from [Start] menu.

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C On the [Ports] tab, click [Configure Port].

The [Port Settings] dialog box appears.

Windows XP, Windows Server 2003:

A On the [Start] menu, point to [Settings], and then click [Printers].

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C Click the [Details] tab, and then click [Configure Port].

The [Port Settings] dialog box appears.

• For TCP/IP, timeout setting can be configured.

❒ If no settings on the [Recovery/Parallel Printing] tab are available, follow
the procedure below.

A Click [Cancel] to close the [Port Configuration:] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the Smart-
DeviceMonitor for Client icon on the taskbar.
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C Click [Extended Features Settings], and then select the [Set Recovery/Par-
allel Printing for each port] check box.

D Click [OK] to close the [Extended Features Settings] dialog box.

• User, proxy, and timeout settings can be configured for IPP.

For information about these settings, see SmartDeviceMonitor for Client
Help.
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Using the Standard TCP/IP Port

Installing the PCL or RPCS Printer Driver

❒ To install printer driver under Windows 2000/XP Professional, and Windows
Server 2003, you must have an account that has Manage Printers permission.
Log on as an Administrators or Power Users group member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement], and then click [Next].

F Select a printer driver you want to use in the [Printer Program] dialog box.

You can select several printer drivers.

G Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Double-click the printer name to display the printer settings.

❒ The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

I Click [Port:], and then click [Add].

J Click [Standard TCP/IP], and then click [New Port...].

Configure the Standard TCP/IP port settings, and then see Windows Help if
[Standard TCP/IP Port] does not appear.

K Click [Next] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

L Enter the printer name or IP address in the [Printer Name or IP Address] box.
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The [Port Name] text box automatically obtains a port name. Change this name
if necessary.

When screen for Device selection appears, select “RICOH NetworkPrinter
Driver C Model”.

M Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

The installation start dialog box reappears.

N Check that the port of the selected printer is displayed in [Port:].

O Configure the default printer as necessary.

P Click [Finish].

The printer driver installation starts.

Q Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run. If
you still want to install the printer driver, use [Add Printer]. See p.77 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 2000)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.
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❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Add Port...].

H Click [Standard TCP/IP], and then click [New Port...].

I Click [Next] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

J Enter the printer name or IP address in the [Printer Name or IP Address] box,
and then click [Next>].

When screen for Device selection appears, select “RICOH NetworkPrinter
Driver C Model”.

K Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

L Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

M Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

N Click [Next >].

O Specify whether or not to print a test page, and then click [Next >].

P Click [Finish].

The printer driver installation starts.

❒ A user code can be set after the printer driver installation . For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.
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A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Create a new port:].

H Click [Standard TCP/IP] in [Create a new Port], and then click [Next].

I Click [Standard TCP/IP], and then click [OK].

J Click [Next] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

K Enter the printer name or IP address in the [Printer Name or IP Address] box,
and then click [Next >].

When screen for Device selection appears, select “RICOH NetworkPrinter
Driver C Model”.

L Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

M Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

N Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

O Click [Next >].

P Specify whether or not to print a test page, and then click [Next >].

Q Click [Finish].

The printer driver installation starts.
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❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using the LPR Port

Installing the PCL or RPCS Printer Driver

❒ To install this printer driver under Windows 2000/XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement], and then click [Next].

F Select a printer driver you want to use in the [Printer Program] dialog box.

You can select several printer drivers.

G Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Double-click the printer name to display the printer settings.

❒ The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

I Click [Port:], and then click [Add].

J Click [LPR Port], and then click [New Port...].

If [LPR Port] does not appear, see Windows Help and install it.

K Enter the printer's IP address in the [Name or address of server providing lpd]
box.
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L Enter “lp” in the [Name of printer or print queue on that server] box, and then
click [OK].

The port is added.

M Check that the port of the selected printer is displayed in [Port:].

N Configure the default printer as necessary.

O Click [Finish].

The printer driver installation starts

P Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run. If
you still want to install the printer driver, use [Add Printer]. See p.77 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 2000)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next >].
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F Click [Local printer], and then click [Next >].

G Click [Add Port...].

H Click [LPR Port], and then click [New Port...].

I Enter the printer's IP address in the [Name or address of server providing lpd]
box.

J Enter “lp” in the [Name of printer or print queue on that server] box, and then
click [OK].

K Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

M Click [Next >].

N Specify whether or not to print a test page, and then click [Next >].

O Click [Finish].

The printer driver installation starts.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory. 

C Select an interface language, and then click [OK].

The default interface language is English.
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❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next >].

F Click [Local Printer], and then click [Next >].

G Click [Create a new port:].

H Click [LPR Port] in [Create a new Port], and then click [Next >].

I Enter the printer's IP address in the [Name or address of server providing lpd]
box.

J Enter “lp” in the [Name of printer or print queue on that server box], and then
click [OK].

K Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

M Click [Next >].

N Specify whether or not to print a test page, and then click [Next >].

O Click [Finish].

The printer driver installation starts.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
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The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Add Port:].

G Select [LPR Port], and then click [OK].

H Enter the printer's IP address in the [Name or address of server providing lpd
box] box.

I Enter “lp” in the [Name of printer or print queue on that server] box, and then
click [OK].

J Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

K Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

L Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

M Restart the computer to complete installation.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using as the Windows Network Printer

Installing the PCL or RPCS Printer Driver

To use the print server, install the printer driver by selecting “Network printer
server”, and then select the Windows 2000/XP, Windows Server 2003, or Win-
dows NT 4.0 shared printer.

This section assumes that the client has already been configured to communi-
cate with a Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 print
server. Do not begin the following procedure before the client is set up and con-
figured correctly.

❒ To install printer driver under Windows 2000/XP Professional, Windows Serv-
er 2003, and Windows NT 4.0, you must have an account that has Manage
Printers permission. For this, log on as an Administrators or Power Users
group member.

❒ If you print with a print server connected to the printer using the SmartDevice-
Monitor port, Recovery Printing and Parallel Printing cannot be used from the
client.

❒ If you print with a Windows XP or Windows Server 2003 print server, notifica-
tion functions of SmartDeviceMonitor may not be used with the client.

❒ If you print with a Windows NT 4.0 print server, install the printer driver before
you connect the print server to the printer.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement], and then click [Next].

F Select a printer driver you want to use in the [Printer Program] dialog box.

You can select several printer drivers.
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G Select the [Printer Name:] check box to select the printer models you want
to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

I Click [Port:], and then click [Add].

J Click [Network Printer], and then click [OK].

K Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

L Select the printer you want to use, and then click [OK].

M Check that the port of the selected printer is displayed in [Port:].

N Configure the user code as necessary.

For an RPCS printer driver, a user code can be set after the printer driver in-
stallation. For information about user code, see the printer driver Help.

O Select the [Default Printer] check box to configure the printer as default.

P Click [Finish].

The printer driver installation starts.

Q Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run. If
you still want to install the printer driver, use [Add Printer]. See p.77 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me)

❒ If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
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The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Network Printer], and then click [Next].

G Click [Browse].

H Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

I Select the printer you want to use, and then click [OK].

J Check the location of the selected printer is shown, and then click [Next].

K Change the printer name if you want, and then click [Next].

Select the [Yes] check box to configure the printer as default.

L Specify whether or not to print a test page, and then click [Finish].

M Restart the computer.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000)

❒ Installing a printer driver requires Administrators permission. Log on using an
account that has Administrators permission.

❒ If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

A Quit all applications currently running.
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B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Network printer], and then click [Next].

G Click [Next].

H Double-click the computer name you want to use as a print server in the
[Shared printers] window.

I Select the printer you want to use, and then click [Next].

J The printer driver installation starts.

K Click [Next>].

Select the [Yes] check box to configure the printer as default.

L Click [Finish].

Restart the computer to complete installation.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.
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❒ If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

❒ If you print with a Windows XP or Windows Server 2003 print server, Smart-
DeviceMonitor notification functions may not be possible for the client.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Network printer] and then click [Next].

G Click [Next].

H Double-click the computer name you want to use as a print server in the
[Shared printers] window.

I Select the printer you want to use, and then click [Next].

J The printer driver installation starts.

K Click [Next >].

Select the [Yes] check box to configure the printer as default.

L Click [Finish].

Restart the computer to complete installation.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

❒ If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

❒ To print from a Windows NT 4.0 print server, install the printer driver before
you connect the print server to the printer.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Network printer], and then click [Next].

G Click [Next].

H Double-click the computer name you want to use as a print server in the
[Shared printers] window.

I Select the printer you want to use, and then click [Next].

J Check the location of the selected printer is shown, and then click [Next].

K Change the printer name if you want, and then click [Next].

L Specify whether or not to print a test page, and then click [Finish].

Restart the computer to complete installation.
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❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using as the NetWare Print Server/Remote 
Printer

This explains how to set up the Windows computer used as the NetWare client.

❒ To install this printer driver under Windows 2000/XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

The following explanation assumes NetWare Client is installed on the client com-
puter and the NetWare server environment is correctly set up. Install all neces-
sary client applications before following this procedure.

Set up the printer driver while logging on to the NetWare file server.

The following values are used in the example:

• Operating system: Windows 98

• NetWare version: 4.1

• File server name: CAREE

• Queue name: R-QUEUE

A Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].

The default interface language is English.

C Click [PCL/RPCS Printer Drivers].

D The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement], and then click [Next].

E Select the printer driver you want to use in the [Printer Program] dialog
box.

You can select several printer drivers.

F Select the [Printer Name] check box to select the printer models you want
to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

G Double-click the printer name to display the printer settings.
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The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

H Click [Port:], and then click [Add].

I Click [Network Printer], and then click [OK].

J Double-click the name of the NetWare file server on the network tree.

The created queue is displayed.

K Select the print queue, and then click [OK].

L Check that the port of the selected printer is displayed in [Port:].

M Click [Finish].

The printer driver installation starts.

N Click [Finish] in the [Component selection] dialog box.

O Click [Finish] in the [Introduction complete] dialog box.

P In the [Printers] window, open the printer properties.

Under Windows XP or Windows Server 2003, open the printer properties from
the [Printers and Faxes] window.

Q On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check
boxes.

Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, click
the [NetWare setting] tab.

Do not select these check boxes since they are automatically selected by the
printer driver. If you select the check boxes, the printer may not print correctly.

R Click [OK] to close the printer properties dialog box.

❒ The protocol is set to inactive as default. Enable it using Web Image Mon-
itor or Telnet

When using the PostScript 3 Printer Driver

Follow the procedure below to set up the PostScript 3 printer driver.

A In the [Printers] or [Printers and Faxes] window, open the printer properties.

B Click the [PostScript] tab.

❒ When using Windows 2000/XP or Windows NT 4.0, click the [Device Set-
tings] tab, and then proceed to step to clear the check box.



Preparing for Printing

58

C Click [Advanced].

D Clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes,
and then click [OK].

E Click [OK] to close the printer properties dialog box.

Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the printer
driver on Windows. If NetWare form feed is configured, the printer may not print
properly.

Follow the procedure below to disable form feed according to the operating sys-
tem used:

• Under Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-
tings] tab in the printer properties dialog box.

• Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, clear
the [Form feed] check box on the [NetWare Settings] tab in the printer properties
dialog box.

Banner Page

Do not use NetWare to configure a banner page.

Follow the procedure below to disable banner pages according to the operating
system used:

• Under Windows 95/98/Me, clear the [Enable banner] check box on the [Printer
Settings] tab in the printer properties dialog box.

• Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, clear
the [Enable banner] check box on the [NetWare Settings] tab in the printer prop-
erties dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the
printer is reset. During this period, jobs may be accepted (depending on Net-
Ware specifications) but not printed.

To print after resetting the printer as the remote printer, check on the print server
that the remote printer is disconnected, or wait for two minutes before trying to
print.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

❒ Make sure that printer is connected to the computer's USB ports using the
USB interface cable.

Before installing, check that only the operating system is running on the comput-
er and no print jobs are in progress.

The printer drivers can be installed from the CD-ROM provided with this printer.

Windows 98 SE/Me - USB

❒ Installation via USB is not possible under Windows 95/98. Upgrade to Win-
dows 98 SE/Me.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

A Check that the power of the printer is off.

B Connect the printer and computer using the USB cable.

C Turn on the power of the printer.

The plug and play function starts and the [New Hardware Found], [Device Driver
Wizard], or [Add New Hardware Wizard] dialog box appears, depending on the op-
erating system.

D Click [Next >].

E Click [Search for the best driver for your device. {Recommended}.], and then click
[Next >].

F Select the [Specify a location:] check box, and then click [Browse...].

The [Browse for Folder] dialog box appears.

G Insert the CD-ROM into the CD-ROM drive.

❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the {Shift} key when inserting the CD-ROM into
the drive and keep it pressed until the computer finishes reading from the
CD-ROM.

H Specify the location where USB Printing Support is located, and then
click [Next >].
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If the CD-ROM drive is D, the source files of USB Printing Support are stored
in the following location:

D:DRIVESRPCSWIN2K_XP(Language)DISK1

I Check the location, and then click [Next].

USB Printing Support is installed.

J Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.

K Click [Next >].

L Click [Search for the best driver for your device. {Recommended}.], and then click
[Next >].

M Select the [Specify a location:], check box, and then click [Browse...].

The [Browse for Folder] dialog box appears.

N Insert the CD-ROM into the CD-ROM drive.

❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the {Shift} key when inserting the CD-ROM into
the drive and keep it pressed until the computer finishes reading from the
CD-ROM.

O Specify the location where the source files of the printer driver is stored,
and then click [Next >].

If the CD-ROM drive is D, the source files of the printer driver are stored in the
following location:

• RPCS
D:DRIVESRPCSWIN2K_XP(Language)DISK1

• PCL 5e
D:DRIVESPCL5EWIN98_ME(Language)DISK1

• PCL 6
D:DRIVESPCL6WIN98_ME(Language)DISK1

• PostScript 3
D:DRIVESPS3WIN98_ME(Language)DISK1

P Check the location, and then click [Next].

Add Printer Wizard starts.

Q Click [Finish].
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Installation is complete. If installation is successful, the icon of the printer con-
nected to the “USB001” port is added to the [Printers] window.

❒ The number after “USB” varies depending on the number of printers con-
nected.

❒ It is not necessary to reinstall USB Printing Support when connecting a dif-
ferent printer via USB interface when USB Printing Support is installed.

❒ After installing USB Printing Support, if the printer driver is not installed, fol-
low the plug-and-play instructions of the printer.

❒ Install the printer driver from the CD-ROM provided with the printer.

Windows 2000 - USB

❒ Installing a printer driver requires Administrators permission. Log on using an
account that has Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

A Check that the power of the printer is off.

B Connect the printer and computer using the USB cable.

C Turn on the power of the machine.

Found New Hardware Wizard starts, and USB Printing Support is installed au-
tomatically.

D Click [Next] in the [Found New Hardware Wizard] dialog box.

E Select the [Search for a suitable driver for my device (recommended)] check box,
and then click [Next].

F Select the [Specify location] check box, and then click [Next].

G Insert the CD-ROM into the CD-ROM drive.

❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

H Specify the location where the source files of the printer driver is stored.
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If the CD-ROM drive is D, the source files of the printer driver are stored in the
following location:

• RPCS
D:DRIVESRPCSWIN2K_XP(Language)DISK1

• PCL 5e
D:DRIVESPCL5EWIN2K_XP(Language)DISK1

• PCL 6
D:DRIVESPCL6WIN2K_XP(Language)DISK1

• PostScript 3
D:DRIVESPS3WIN2K_XP(Language)DISK1

I Check the printer driver location, and then click [OK].

J Click [Next].

K Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.

❒ The number after “USB” varies depending on the number of printers con-
nected.

Windows XP, Windows Server 2003 - USB

❒ Installing a printer driver requires Administrators permission. Log on using an
account that has Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

The printer drivers can be installed from the CD-ROM provided with this printer.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

A Check that the power of the printer is off.

B Connect the printer and computer using the USB cable.

C Turn on the power of the machine.

Found New Hardware Wizard starts, and USB Printing Support is installed au-
tomatically.

D In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].
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E To disable Auto Run, press the left {SHIFT} key when inserting the CD-
ROM into the drive and keep it pressed until the computer finishes read-
ing from the CD-ROM.

❒ If Auto Run starts, click [Cancel], and then [Exit].

F Select the [Include this location in the search] check box under [Search for the
best driver in these location], and then click [Browse] to select the printer driv-
er location.

If the CD-ROM drive is D, the source files of the printer driver are stored in the
following location:

• RPCS
D:DRIVESRPCSWIN2K_XP(Language)DISK1

• PCL 5e
D:DRIVESPCL5EWIN2K_XP(Language)DISK1

• PCL 6
D:DRIVESPCL6WIN2K_XP(Language)DISK1

• PostScript 3
D:DRIVESPS3WIN2K_XP(Language)DISK1

G Check the printer driver location, and then click [Next].

H Click [Continue].

I Click [Finish].

If installation is successful, the icon of the printer connected to the “USB001”
port is added to the [Printers] window.

❒ The number after “USB” varies depending on the number of printers con-
nected.

Troubleshooting USB

Problem Solutions

The printer is not recognized auto-

matically.

Turn off the power of the printer, reconnect the USB cable, 

and then turn it on again.
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Windows has already configured 

the USB settings.

Open Windows' Device Manager, and then, under [Univer-

sal Serial Bus controllers], remove any conflicting devices. 

Conflicting devices have a yellow [!] or [?] icon by them. 

Take care not to accidentally remove required devices. 

For details, see Windows Help.

❒ When using Windows 2000/XP or Windows Server 

2003, an erroneous device is displayed under [USB 

Controller]in the [Device Manager] dialog box.
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Printing with Parallel Connection

To use a printer connected using a parallel interface, click [LPT1] when installing
the printer driver.

Installing the PCL or RPCS Printer Driver

❒ To install this printer driver under Windows 2000/XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement], and then click [Next].

F Select a printer driver you want to use in the [Printer Program] dialog box.

You can select several printer drivers.

G Select the [Printer Name:] check box to select the printer models you want
to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

H Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

I Check that [LPT1:] is shown in [Port:].

J Select the [Default Printer] check box to configure the printer as default.

K Click [Finish].
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The printer driver installation starts.

L Click [Finish] in the installation completion dialog box.

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run. If
you still want to install the printer driver, use [Add Printer]. See p.77 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me)

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the printer whose driver you want to install, and then
click [Next].

H In the [Available ports:] box, click [Printer Port], and then click [Next].

I Change the printer name if you want, and then click [Next].

Select the [Yes] check box to configure the printer as default.

J Specify whether or not to print a test page, and then click [Finish].
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K Restart the computer to complete installation.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the printer whose driver you want to install, and then
click [Next].

H Specify whether or not to print a test page, and then click [Finish].

I Restart the computer to complete installation.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Local Printer], and then click [Next].

G Select the port you want to use, and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

H Select the name of the printer whose driver you want to install, and then
click [Next].

I Change the printer name if you want, and then click [Next].

J Specify whether or not to print a test page, and then click [Finish].

K Restart the computer to complete installation.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0)

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

❒ The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Select the port you want to use, and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the printer whose driver you want to install, and then
click [Next].

H Change the printer name if you want, and then click [Next].

I Click [Next].

J Specify whether or not to print a test page, and then click [Finish].

K Restart the computer to complete installation.

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the Printer Driver Using IEEE 1394 
(SCSI print)

The printer drivers can be installed from the CD-ROM provided with this printer.

❒ Quit all applications currently running, and do not print during installation.

❒ Do not connect IEEE 1394 or USB devices to the computer or turn on another
printers during installation.

❒ Before uninstalling the printer driver, check that the IEEE 1394 interface cable
is disconnected from the computer.

❒ SCSI print must be set to “active” from the control panel. For details, see
p.158 “Host Interface Menu”.

❒ This printer can receive print data from one computer at a time only. An mes-
sage may appear if jobs from different computers collide.

❒ If jobs collide, the first received is printed first.

❒ When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

Windows 2000

❒ If [Found New Hardware Wizard] appears every time the computer is started or
the cable is connected, disable the device. To install another printer driver af-
ter setting the “1394_00n” port, click [1394_00] as a port during the printer
driver installation.

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

❒ The optional 1394 interface unit can be used only with Service Pack 1 (SP1)
or higher.

A Connect the printer and computer using the IEEE 1394 interface cable.

B Click [Next] in the [Found New Hardware Wizard] dialog box.

CWhen the message “This wizard will complete the installation for this
Device: Unknown” appears, click [Specify a location], and then click [Next
>].

DWhen the message “Locate Driver Files” appears, select the [Optional
search locations] check box, and then click [Specify a location], and then click
[Next >].
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E To disable Auto Run, press the left {SHIFT} key when inserting the CD-
ROM into the drive and keep it pressed until the computer finishes read-
ing from the CD-ROM.

If Auto Run starts, click [Cancel], and then [Exit].

F Click [Browse].

G Select the printer driver you want to use.

If the CD-ROM drive is D, the source files of the printer driver are stored in the
following location:

• RPCS
D:DRIVESRPCSWIN2K_XP(Language)DISK1

• PCL 5e
D:DRIVESPCL5EWIN2K_XP(Language)DISK1

• PCL 6
D:DRIVESPCL6WIN2K_XP(Language)DISK1

• PostScript 3
D:DRIVESPS3WIN2K_XP(Language)DISK1

H Click [Open].

I Click [OK].

J Follow the instructions.

When installation is complete, the printer connected to “1394_00n” appears
in the [Printers] window. (“n” shows the number of printers connected.)

❒ If the printer driver has already been installed, the printer icon is added to
the [Printers] window. In this case, printer driver installation is not neces-
sary.

❒ If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see “Printer Does Not Print”, Printer
Reference.

❒ If you do not want to install the printer when Found New Hardware Wizard
starts under an operating system that supports SCSI print, disable the de-
vice by following the procedure below.

A When the [Found New Hardware Wizard] dialog box appears, click [Next >].

B When the message “This wizard will complete the installation for this
Device: Unknown” appears, select the [Search for a suitable driver for my
device [recommended]] check box, and then click [Next >].

C When the message “Please choose your search and installation option.”
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next >].
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D When the message “Driver Files Search Results” appears, select the
[Disable the device. The Add/Remove Hardware Wizard in the control Panel can
be able to complete the driver installations.] check box, and then click [Fin-
ish].

Windows XP, Windows Server 2003

❒ SCSI print must be set to “active” from the control panel. For details, see
p.158 “Host Interface Menu”.

❒ Installing this printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

❒ This printer can receive print data from one computer at a time only. If a job
from a computer collides with other data, a message may appear on the com-
puter.

❒ To install another printer driver after setting the “1394_00n” port, click
[1394_00] as a port during the printer driver installation.

❒ When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

A Connect the printer and computer using the IEEE 1394 interface cable.

When the [Found New Hardware Wizard] dialog box appears, check that [This wiz-
ard helps you install software for: (Unknown)] is displayed.

B Select the [Install from a list on specific location (Advanced)] check box, and
then click [Next >].

CWhen the message “Please choose your search and installation op-
tion.” appears, select the [Search for the best driver in these locations.] check
box, select the [Include this location in the search:] check box, and then select
the [Include this location in the search:] check box.

D To disable Auto Run, press the left {SHIFT} key when inserting the CD-
ROM into the drive and keep it pressed until the computer finishes read-
ing from the CD-ROM.

❒ If Auto Run starts, click [Cancel], and then [Exit].

E Specify the location where the source files of the printer driver is stored,
and then click [Next].

If the CD-ROM drive is D, the source files of the printer driver are stored in the
following location:

• RPCS
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D:DRIVESRPCSWIN2K_XP(Language)DISK1

• PCL 5e
D:DRIVESPCL5EWIN2K_XP(Language)DISK1

• PCL 6
D:DRIVESPCL6WIN2K_XP(Language)DISK1

• PostScript 3
D:DRIVESPS3WIN2K_XP(Language)DISK1

When installation is complete, the printer connected to “1394_00n” appears
in the [Printers and Faxes] window. (“n” shows the number of printers connect-
ed.)

F Follow the instructions.

❒ If the printer driver has already been installed, the printer icon is added to
the [Printers and Faxes] window. In this case, printer driver installation is not
necessary.

❒ Even if the printer driver is already installed, the message “ Found New
Hardware Wizard” may appear when the printer and the computer are con-
nected using the IEEE 1394 interface cable for the first time. If it does, in-
stall the printer driver.

❒ If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see “Printer Does Not Print”, Printer
Reference.

❒ If you do not want to install the printer when Found New Hardware Wizard
starts under an operating system that supports SCSI print, disable the de-
vice by following the procedure below

A When the [Found New Hardware Wizard] dialog box appears, check that
[This wizard helps you install software for: Unknown] displayed, select [Install
from a list on specific location (Advanced)] check box, and then click [Next >].

B When the message “Please choose your search and installation option.”
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next >].

C When the message “The wizard could not find the software on your
computer for.” appears, click [OK].

D When the message “Cannot Install this Hardware” appears, select the
[Don't prompt again to install the software] check box, and then click [Finish].
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Printing with Bluetooth Connection

Supported Profiles

❖ SPP, HCRP

• A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

• When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is
selected. When selecting the connection between the other devices, can-
cel the first established connection.

• Conditions for bidirectional communications

• SPP connection does not support bidirectional communications.

• HCRP connection supports bidirectional communications.

❖ BIP

• For BIP connection, a module including PostScript 3 must be installed in
the printer.

• Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-
nected via BIP.

• Only JPEG images that can be printed using BIP.

• User codes are disabled for BIP.
You cannot print if print functions are restricted.

• Some printers do not support BIP.

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel interface.

❒ To install the printer driver under Windows 2000/XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

❒ System requirements vary depending on the Bluetooth standard and specifi-
cations. For details, see the manuals provided with each product.

❒ For information about setting up Bluetooth under other operating systems or
using it with different utilities, see the manuals provided with those operating
systems or utilities.
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A Start 3Com Bluetooth Connection Manager.

B Check that the printer you want to use appears in 3Com Bluetooth Con-
nection Manager.

C On the [Tool] menu, click [COM port].

D Check that the message “Bluetooth Serial Client (COMx) “ appears un-
der Client Ports. (X indicates the COM port number used by Bluetooth.)

E Click [Close].

F On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

G Click the icon of the printer you want to use.

H On the [File] menu, click [Properties].

I Click the [Ports] tab.

J Under [Port], select the [COMx:] check box. X indicates the COM port num-
ber used by Bluetooth.

K Click [OK].

Close the [Printers] window.

❖ If a dialog box appears while transmitting a print job, reestablish network connec-
tion as follows:

A Select the printer you want to use in the [Printers and Faxes] box.

B Click [Connect].

❒ To always use the same printer, select the [Always use for this connection]
check box.

For details, see the manuals provided with the Bluetooth adaptor or
computer equipped with Bluetooth.

Configuring Security Mode Settings

A Start 3Com Bluetooth Connection Manager.

B On the [Tools] menu, click [Security Mode].

The [Security Mode] dialog box appears.

C Select the security mode in the [Security Mode:] list.
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If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.76 “Send the print job to the printer in use.”.

For all other security modes and custom settings, no password is required.

❒ For information about each mode, see the manuals provided with the utility.

D Click [OK].

Close the [Security Mode] dialog box.

For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.76 “Printing in the Security Mode”.

Printing in the Security Mode

A Send the print job to the printer in use.

Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

B The [Authentication] dialog box appears.

C Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the printer's serial num-
ber. You can find the serial number on the label on the back of the printer. For
example, if the serial number is 00A0-001234, the Bluetooth password is
1234.

D The print job is sent.

❒ The Bluetooth password differs for each printer and cannot be changed.
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If a Message Appears during Installation

Message number 58 or 34 indicates the printer driver cannot be installed using
Auto Run. Install the printer driver using [Add Printer] or [>Install Printer].

For Windows 95/98/Me, Windows 2000 and Windows NT 4.0:

A On the [Start] menu, point to [Settings], and then click [Printers].

B Double-click the Add Printer icon.

C Follow the instructions in Add Printer Wizard.

❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver
is either D:DRIVERSRPCSWIN9X_ME, D:DRIVERSRPCSWIN2K_XP, or
D:DRIVERSRPCS T4. If the installer starts, click [Cancel] to quit.

For Windows XP Professional and Windows Server 2003:

A On the [Start] menu, click [Printers and Faxes].

B Click [Add a printer].

C Follow the instructions in Add Printer Wizard.

❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver
is D:DRIVERSRPCSWIN2K_XP. If the installer starts, click [Cancel] to quit.

For Windows XP Home Editions:

A On the [Start] menu, click [Control Panel].

B Click [Printers and Other Hardware].

C Click [Printers and Faxes].

D Click [Install Printer].

E Follow the instructions in Add Printer Wizard.

❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver
is \DRIVERS\RPCS\WIN2K_XP. If the installer starts, click [Cancel] to quit.
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Making Option Settings for the Printer

Make option settings for the printer using the printer driver when bidirectional
communication is disabled.

For details about making option settings for the printer, see p.79 “If Bidirec-
tional Communication is Disabled”.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed direc-
tion settings to be automatically sent to the printer. You can check printer status
from your computer.

• Bidirectional communication is supported by Windows 95/98/Me/2000/XP,
Windows Server 2003, and Windows NT 4.0.

• If you use the RPCS printer driver and bidirectional communication is enabled
under Windows 2000, the [Change Accessories] tab is unavailable.

❒ The RPCS printer driver supports bidirectional communications and updates
the printer status automatically.

❒ The PCL printer driver supports bidirectional communications. You can up-
date printer status manually.

❒ The PostScript 3 printer driver does not support bidirectional communications.

To support bidirectional communication, the following conditions must be met:

❖ When connected with parallel cables

• The computer must support bidirectional communication.

• The printer must support bidirectional communication.

• The interface cable must support bidirectional communication.

• The printer must be connected to the computer using the standard parallel
cables and parallel connectors.

• Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Port] tab with the RPCS
printer driver.

❖ When connected with the network

• The printer must support bidirectional communication.

• SmartDeviceMonitor for Client included on the CD-ROM must be installed,
and TCP/IP must be used.
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• Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Port] tab with the RPCS
printer driver.

• In addition to the above, one of the following conditions must also be met:

• The SmartDeviceMonitor for Client port and the TCP/IP protocol must
be used.

• The standard TCP/IP port must be used without changing the default
port name (for Windows 2000/XP and Windows Server 2003).

• Microsoft TCP/IP print IP address must be specified for use (for Win-
dows NT 4.0).

• IPP port name must include the IP address when using the IPP protocol.

❖ When connected with IEEE 1394

• The computer must support bidirectional communication.

• The printer must be connected to the IEEE 1394 connector of a computer
using the IEEE 1394 interface cable.

• [Activate] must be selected in the SCSI print of IEEE 1394 and [Activate]
must be selected in the Bidi-SCSI print.

• Under Windows 2000/XP or Windows Server 2003, [Enable bidirectional sup-
port] must be selected, and [Enable printer pooling] must not be selected on
the [Port] tab with RPCS printer driver.

❖ When connected with USB
The printer must be connected to the computer's USB port using the USB in-
terface cable.
The computer must support bidirectional communication.

❒ Install SmartDeviceMonitor for Client from the CD-ROM provided.

If Bidirectional Communication is Disabled

Set up option settings when bidirectional communications are disabled.

❒ Under Windows 2000/XP and Windows Server 2003, Manage Printers per-
mission is required to change the printer properties in the [Printers] folder. Log
on as an Administrators or Power Users group member.

❒ Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] folder. Log on as an Administrators or Power
Users group member.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.
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B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

D Click the [Accessories] tab.

If options in the [Change Accessories] tab are disabled, bidirectional connection
is enabled. In this case, no change is necessary for option settings.

❒ If you are using the RPCS printer driver, click the [Change Accessories] tab.

❒ If you are using the PS printer driver, click the [Device Settings] tab.

E Select options installed from the [Option] area, and then make the neces-
sary settings.

F Select the total amount of the memory in [Total Memory:], when the option-
al SDRAM module is added.

G Under [Paper source tray settings], click and highlight the tray to be used,
and then select the appropriate size, position, and type for the tray. Se-
lect the [Tray locking] check box to exclude the tray from the targets of au-
tomatic tray selection.

H Click [OK] to close the printer properties dialog box. Click the [Defaults]
tab, and then click [Change Accessories] to display the option selection.

Click [OK] to close the printer properties dialog box. Click the [Defaults] tab,
and then click [Change Accessories] to display the option selection.
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Setting Up the Printer Driver

PCL - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

D Make the necessary settings, and then click [OK].

❒ With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties di-
alog box from that application. The following explains how to make settings for
the WordPad application provided with Windows 95/98/Me.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

The printer properties dialog box appears.

C Make the necessary settings, and then click [OK].

D Click [OK] to start printing.
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❒ The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

For details, see Printer Driver Help.

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission by
default.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

For details, see Printer Driver Help.
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Making printer default settings - Printing Preferences

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings for
the WordPad application provided with Windows 2000.

❒ The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the applica-
tion you use.

❒ Any settings you make in the following procedure are valid for the current ap-
plication only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

C Make the necessary settings, and then click [Apply] to start printing.

For details, see Printer Driver Help.
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Windows XP, Windows Server 2003 - Accessing the Printer 
Properties

Making printer default settings - the printer properties

❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission by
default.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

For details, see Printer Driver Help.

Making printer default settings - Printing Preferences

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

D Make the necessary settings, and then click [OK].
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❒ Settings you make here are used as the default settings for all applications.

For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings for
the WordPad application provided with Windows XP.

❒ The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the applica-
tion you use.

❒ Any settings you make in the following procedure are valid for the current ap-
plication only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

C Make the necessary settings, and then click [Apply] to start printing.

For details, see Printer Driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
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The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

For details, see Printer Driver Help.

Making printer default settings - Default

❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Document Defaults].

The [Default] dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties di-
alog box from that application. The following explains how to make settings for
the WordPad application provided with Windows NT 4.0.
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❒ The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

❒ With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current ap-
plication only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

The printer properties dialog box appears.

C Make the necessary settings, and then click [OK].

D Click [OK] to start printing.

For details, see Printer Driver Help.
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RPCS - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two dialog box types of the printer properties dialog box.

“Multi-tab” is used as an example in this manual. For details about changing the
dialog box types, see the printer driver Help.

❖ Multi-tab
This dialog box type is designed for users who often change print settings to
perform various printing operations.

❖ Custom Setting
This dialog box type is designed for users who rarely change print settings.
This type of dialog box may vary depending on the installed options.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

❒ With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

❒ When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK],
the printer properties dialog box appears.

D Make the necessary settings, and then click [OK].

For details, see Printer Driver Help.
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Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties di-
alog box from that application. The following explains how to make settings for
the WordPad application provided with Windows 95/98/Me.

❒ The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

❒ With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current ap-
plication only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

The printer properties dialog box appears.

C Make the necessary settings, and then click [OK].

D Click [OK] to start printing.

For details, see Printer Driver Help.

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission by
default.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
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The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

❒ When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK],
the printer properties dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

For details, see Printer Driver Help.

Making printer default settings - Printing Preferences

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings for
the WordPad application provided with Windows 2000.
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❒ The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the applica-
tion you use.

❒ Any settings you make in the following procedure are valid for the current ap-
plication only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

C Make the necessary settings, and then click [Apply] to start printing.

For details, see Printer Driver Help.

Windows XP, Windows Server 2003 - Accessing the Printer 
Properties

Making printer default settings - the printer properties

❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission by
default.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

❒ When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK],
the printer properties dialog box appears.
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D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

For details, see Printer Driver Help.

Making printer default settings - Printing Preferences

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings for
the WordPad application provided with Windows XP.

❒ The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the applica-
tion you use.

❒ Any settings you make in the following procedure are valid for the current ap-
plication only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.



Setting Up the Printer Driver

93

A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

C Make the necessary settings, and then click [Apply] to start printing.

For details, see Printer Driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

❒ When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK],
the printer properties dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

For details, see Printer Driver Help.
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Making printer default settings - Default

❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Document Defaults...].

The [Default] dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties di-
alog box from that application. The following explains how to make settings for
the WordPad application provided with Windows NT 4.0.

❒ The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

❒ With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current ap-
plication only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print].

The [Print] dialog box appears.
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B Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

The printer properties dialog box appears.

C Make the necessary settings, and then click [Apply].

D Click [OK] to start printing.

For details, see Printer Driver Help.
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PostScript 3 - Setting Up for Printing

Windows 95/98/Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

❒ With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

D Make the necessary settings, and then click [OK].

E Click [OK].

For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties di-
alog box from that application. The following explains how to make settings for
the WordPad application provided with Windows 95/98/Me.

❒ The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

❒ With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.
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❒ Any settings you make in the following procedure are valid for the current ap-
plication only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

The printer properties dialog box appears.

C Make the necessary settings, and then click [OK].

D Click [OK] to start printing.

For details, see Printer Driver Help.

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission by
default.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].
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For details, see Printer Driver Help.

Making printer default settings - Printing Preferences

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings for
the WordPad application provided with Windows 2000.

❒ The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the applica-
tion you use.

❒ Any settings you make in the following procedure are valid for the current ap-
plication only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

C Make the necessary settings, and then click [Print] to start printing.
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For details, see Printer Driver Help.

Windows XP, Windows Server 2003 - Accessing the Printer 
Properties

Making printer default settings - the printer properties

❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission by
default.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

For details, see Printer Driver Help.

Making printer default settings - Printing Preferences

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.
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D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings for
the WordPad application provided with Windows XP.

❒ The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the applica-
tion you use.

❒ Any settings you make in the following procedure are valid for the current ap-
plication only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

C Make the necessary settings, and then click [Print] to start printing.

For details, see Printer Driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.
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A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears .

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

For details, see Printer Driver Help.

Making printer default settings - Default

❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made
in the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Document Defaults].

The [Default] dialog box appears.

D Make the necessary settings, and then click [OK].

❒ Settings you make here are used as the default settings for all applications.

For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.
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To make printer settings for a specific application, open the printer properties di-
alog box from that application. The following explains how to make settings for
the WordPad application provided with Windows NT 4.0.

❒ The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

❒ With some applications, the printer driver settings are not used, and the appli-
cation's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current ap-
plication only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

The printer properties dialog box appears.

C Make the necessary settings, and then click [OK].

D Click [OK] to start printing.

For details, see Printer Driver Help.

Mac OS - Setting Up for Printing

Making paper settings from an application

A Open the file you want to print.

B On the [File] menu, click [Page Setup].

C Check that the printer you want to use is displayed in [Format for:], and
then select the paper size you want to use in [Paper].

Under Mac OS X, select the paper size in [Paper Size].

❒ If the printer you want to use is not displayed in [Format for:], select the print-
er you want to use.
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The [Page Setup] dialog box varies depending on the application you use.
For details, see the manuals provided with the Mac OS.

D Configure the settings, and then click [OK].

Setting up for printing from an application

A Open the file you want to print.

B On the [File] menu, click [Print].

C Check that the printer is selected in the [Printer] list, and then make the
printer settings.

D Configure the settings, and then click [OK].
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Other Print Operations

Printing a PDF File Directly

You can send PDF files directly to this printer to print, without opening its appli-
cation.

❒ This is possible for Adobe PDF files only.

❒ PDF files of versions 1.3, 1.4, and 1.5 are supported.

❒ Transparency and JBIG2 which are functions of version 1.4 are not support-
ed.

❒ Functions of 1.5 file format are not supported.

Using DeskTopBinder Lite

PDF files added with DeskTopBinder Lite can be sent directly to this printer for
printing.

❒ The RPCS printer driver must be installed.

❒ PDF Direct Print is not available with some versions of DeskTopBinder Lite.
Use DeskTopBinder Lite installed from the CD-ROM provided with this print-
er.

❒ PDF Direct Print settings can be made from PDF Direct Print properties.

❒ To print password-protected PDF files, you must do the following:

• Enter the PDF password using PDF Direct Print properties.

• Using the control panel, press [PDF: Change PW] on the [PDF] menu to set
the PDF password.

❒ If a group password is set with DeskTopBinder Lite, set the group password
by pressing [PDF Group PW] on the [PDF] menu using the control panel.

For details, see DeskTopBinder Lite Help.

Installing DeskTopBinder Lite

Follow the procedure below to install DeskTopBinder Lite.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.
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❒ Auto Run may not work under certain operating system settings. In this
case, launch “Setup.exe” located on the CD-ROM root directory.

C Select an interface language, and then click [OK].

D Click [DeskTopBinder Lite] , and then click [Next].

E Follow the instructions on the display to install DeskTopBinder Lite.

If you are required to restart the computer after installing DeskTopBinder Lite,
restart the computer and continue the configuration.

Using Commands

Under Windows and UNIX, you can print PDF files directly, using commands
such as “ftp” and “lpr”.

For details about printing using commands under Windows, see p.255 “Print-
ing Files Directly from Windows”.

For details about printing using commands under UNIX, see UNIX Supple-
ment.
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Sample Print

Use this function to print the first set of a multiple-set print job. After checking the
results, the remaining sets can be printed using the control panel. This function
can protect you from printing a large quantity of misprints.

❒ The number of pages the printer can save varies depending on the contents
of the print images. At most, the printer can save 30 jobs or 1,100 pages for
Sample Print and Locked Print. At most, the printer can store up to 1,000 pag-
es for 1 job.

❒ If you turn off the power, the job saved on the hard disk will be deleted.

❒ Sample Print files will not appear on the display panel if they have already
been executed or deleted using the Web browser before you select “Sample
Print“ from the control panel.

❒ Sample Print files printed or deleted using Web Image Monitor, after you se-
lect [Sample Print] using the control panel will appear on the display panel.
However, an error message will appear if you try to print or delete those Sam-
ple Print files.

❒ You can identify the file you want to print by the user ID and the time when the
job was stored.

❒ If the first set of the Sample Print file is not as you expected and you do not
want to print the remaining sets, delete the Sample Print file using the control
panel or Web Image Monitor.

❒ The job in the printer is deleted automatically after all Sample Print files are
printed.

❒ Follow the procedure below to use this function with the PCL or RPCS printer
driver under Windows. If you want to use this function under Mac OS, see
p.271 “Using PostScript 3”.

For details about settings for the printer driver, see the printer driver Help.

Files specified for Sample Print can be printed or deleted using Web Image
Monitor. For details, see Web Image Monitor Help.

Printing the First Set

A From an application, select a command to print.

The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Prop-
erties].
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The printer properties dialog box appears.

C In the [Job Type:] box, click [Sample Print].

D In the [User ID:] box, enter a user ID using up to eight alphanumeric char-
acters.

This is used to identify the user. The user ID can be entered using up to eight
alphanumeric (a-z, A-Z, 0-9) characters.

E Execute a command to print.

The job is saved on the hard disk.

F Check the print job, and then use the control panel to print the remaining
sets or delete them.

p.107 “Printing the Remaining Sets”

p.108 “Deleting a Sample Print File”

Printing the Remaining Sets

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {U} or {T} key to display [Sample Print], and then press the {#
Enter} key.

The user ID and the time when the job was stored appear.

C Press the {U} or {T} key to display the file you want to print, and then
press the {# Enter} key.

D Check that [Print File] is displayed, and then press the {# Enter} key.

The number of remaining sets appears.

To cancel printing, press the {Escape} key.
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E Press the {# Enter} key. To change the number of sets you want to print,
press the {U} or {T} key and select the number of sets, and then press
the {# Enter} key.

After the job is printed, the job saved on the hard disk is deleted.

Deleting a Sample Print File

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {U} or {T} key to display [Sample Print], and then press the {#
Enter} key.

C Press the {U} or {T} key to display the file you want to delete, and then
press the {# Enter} key.

D Press the {U} or {T} key to display [Delete File], and then press the {# En-
ter} key.

To cancel deleting a Sample Print file, press the {Escape} key.

E Press the {# Enter} key to delete the file.

The message [Deleted] appears.

F Press the {Online} key.

The initial screen appears.

Checking the Error Log

When a print job is not saved on the hard disk, it remains in the error log and can
be checked using the control panel.
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❒ The latest 50 error files are stored in the error log. If a new error file is added
when there are 50 error files already stored, the oldest file is deleted. Howev-
er, if the oldest error file is a sample print file, it is not deleted, but stored in-
stead in the sample print error log until the number of sample print error files
reaches 20.

❒ If you turn off the power, the logs will be deleted.

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {U} or {T} key to display [Sample Print], and then press the {#
Enter} key.

The user ID and the time when the job was stored appear.

C Press the {U} or {T} key to display [Error File(s)], and then press the {#
Enter} key.

D Press the {U} or {T} key to check the log.

To print error files, either print or delete the file saved on the hard disk, and
then print the file from the computer again.

EWhen you finish checking the error log, press the {Escape} key.

The Sample Print job selection screen appears.

F Press the {Online} key.

The initial screen appears.
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Locked Print

Use this function to print confidential documents. Documents will not be printed
automatically unless a password is entered using the control panel.

❒ The number of pages the printer can save varies depending on the print im-
age content. At most, the printer can store 30 jobs or 1100 pages for Sample
Print and Locked Print. At most, the printer can store a maximum of 1000 pag-
es for a single job.

❒ If you turn off the power, the job saved on the hard disk will be deleted.

❒ Locked Print files will not appear on the display panel if they have already
been printed or deleted using Web Image Monitor before you select [Locked
Print] using the control panel.

❒ Locked Print files printed or deleted using Web Image Monitor after you have
selected [Locked Print] using the control panel will still appear on the display
panel. However, an error message will appear if you try to print or delete those
Locked Print files.

❒ Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.

• When there are 30 Sample Print and Locked Print jobs saved on the hard
disk.

• When the total number of pages saved on the hard disk exceeds 1000 pag-
es.

❒ You can identify the file you want to print by the user ID and the time when the
job was stored.

❒ After the Locked Print file is printed, the job in the printer is deleted automati-
cally.

❒ Follow the procedure below to use this function with the PCL or RPCS printer
driver under Windows. If you want to use this function under Mac OS, see
p.271 “Using PostScript 3”.

For details about settings for the printer driver, see the printer driver Help.

Files specified for Locked Print can be printed or deleted using Web Image
Monitor. For details, see Web Image Monitor Help.

Sending Print Job to the Printer

A From an application, select a command to print.

The [Print] dialog box appears.
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B Select the printer you want to use in the [Name] list, and then click [Prop-
erties].

C In the [Job Type:] box, click [Locked Print].

D In the [User ID:] box, enter a user ID using up to eight alphanumeric char-
acters.

This is used to identify the user. The user ID can be entered using up to eight
alphanumeric (a-z, A-Z, 0-9) characters.

E In the [Password:] box, enter a four to eight digit password (0-9).

F Execute a command to print.

The job is saved on the hard disk.

G Enter the password using the control panel, and then specify whether to
print or delete the job.

p.111 “Entering a Password”

p.112 “Deleting a Locked Print File”

Entering a Password

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {U} or {T} key to display [Locked Print], and then press the {#
Enter} key.

The user ID and the time when the job was stored appear.

C Press the {U} or {T} key to display the file you want to print, and then
press the {# Enter} key.

D Enter the password. Press the {U} or {T} key to enter the leftmost digit
of the password, and then press the {# Enter} key.
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E The next digit appears.

F Repeat steps to enter all the digits of the password, and then press the
{# Enter} key.

G Check that [Print File] is displayed, and then press the {# Enter} key.

To cancel printing, press the {Escape} key.

H Press the {# Enter} key.

After the job is printed, the job saved on the hard disk is deleted.

Deleting a Locked Print File

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {U} or {T} key to display [Locked Print], and then press the {#
Enter} key.

C Press the {U} or {T} key to display the file you want to delete, and then
enter the {# Enter} key.

D Enter the password of the Locked Print file. Press the {U} or {T} key to
enter the leftmost digit of the password, and then press the {# Enter} key.

E The next digit appears.

F Repeat steps to enter all the digits of the password, and then press the
{# Enter} key.

G Press the {U} or {T} key to display [Delete File], and then press the {# En-
ter} key.

To cancel deleting a Locked Print file, press the {Escape} key.

H Press the {# Enter} key.
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The message [Deleted] appears, and then the Locked Print job selection
screen appears.

Checking the Error Log

When a print job is not saved on the hard disk, it remains in the error log and can
be checked using the control panel.

❒ The latest 50 error files are stored in the error log. If a new error file is added
when there are 50 error files already stored, the oldest file is deleted. Howev-
er, if the oldest error file is a sample print file, it is not deleted, but stored in-
stead in the sample print error log until the number of sample print error files
reaches 20.

❒ If you turn off the power, the logs will be deleted.

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {U} or {T} key to display [Locked Print], and then press the {#
Enter} key.

The user ID and the time when the job was stored appear.

C Press the {U} or {T} key to display [Error File(s)], and then press the {#
Enter} key.

D Press the {U} or {T} key to check the log.

To print error files, either print or delete the file saved on the hard disk, and
then print the file from the computer again.

EWhen you finish checking the error log, press the {Escape} key.

The Locked Print job selection screen appears.

F Press the {Online} key.

The initial screen appears.
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Form Feed

This message appears when the paper tray is empty, or when the paper in the
paper tray is not of the same size or form as that specified by the printer driver.
You can form feed using tray.

A Press the {Form Feed} key, and then select the paper tray on the screen.

B Press the {# Enter} key.

The job is printed from the selected tray.
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Canceling a Print Job

You can cancel printing from either the printer or a client computer. Since can-
celing procedures vary depending on the print job status, check the job status
and cancel printing according to the following procedure.

Windows - Canceling a Print Job

❒ When the printer is connected to multiple computers, be careful not to acci-
dentally cancel other users' print jobs.

If the print job you want to cancel is being printed

A Check if the print job you want to cancel is currently being printed.

While the print job may not be being printed, the printer is receiving data if the
Data In indicator is lit or blinking.

B Press the {Job Reset} key.

The [Job Reset?] screen appears.

C Select the current job or all jobs (including the current job) using the {U}
or {T} key.

It is also possible to annul the cancellation. Printing resumes if you select [Re-
sume Print], and then press the {# Enter} key.

D Press the {# Enter} key.

A confirmation message appears.

Printing resumes if you press the {Escape} key after the message appears.

E Press the {# Enter} key.

The job is canceled. When the cancellation procedure is complete, a mes-
sage appears.

❒ A print job that contains a large volume of data may take considerable time
to cancel.

❒ If printing resumes after being canceled, the period of time set for [I/O Tim-
eout] is too short. Set a longer period of time for [I/O Timeout] on the [Host
Interface] menu.
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If the print job you want to cancel is not being printed

A Double-click the printer icon on the Windows task tray.

A window appears showing all print jobs that are currently queuing to be print-
ed. Check the current status of the job you want to cancel.

You can also open the print job queue window by double-clicking the printer
icon in the [Printer] window.

B Select the name of the job you want to cancel.

C On the [Document] menu, click [Cancel Printing].

❒ When this printer is used as a network printer, other users' print jobs cannot
be canceled from a client computer.

❒ Clicking [Purge Print Documents] on the [Printer] menu deletes all currently
queued print jobs. However, when this printer is used as a network printer,
print jobs from other users' computer cannot be canceled from a client
computer.

❒ When the print job you selected starts printing, it takes some time before
the print job disappears from the printer window.

Mac OS - Canceling a Print Job

❒ When the printer is connected to multiple computers, be careful not to acci-
dentally cancel other users' print jobs.

If the print job you want to cancel is being printed

A Check if the print job you want to cancel is currently being printed.

While the print job may not be being printed, the printer is receiving data if the
Data In indicator is lit or blinking.

B Press the {Job Reset} key.

[Job Reset?] appears on the display panel.

C Select the current job or all jobs (including the current job) using the {U}
or {T} key.

It is also possible to annul the cancellation. Printing resumes if you select [Re-
sume Print], and then press {# Enter} key.

D Press the {# Enter} key.

A confirmation message appears.
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Printing resumes if you press the {Escape} key after the message appears.

E Press the {# Enter} key.

The job is canceled. When the cancellation procedure is complete, a mes-
sage appears.

❒ A print job that contains a large volume of data may take considerable time
to cancel.

❒ If printing resumes after being canceled, the period of time set for [I/O Tim-
eout] is too short. Set a longer period of time for [I/O Timeout] on the [Host
Interface] menu.

If the print job you want to cancel is not being printed

A Double-click the printer icon on the desktop.

A window appears showing all print jobs that are currently queuing to be print-
ed. Check the current status of the job you want to cancel.

Under Mac OS X, start Print Center.

B Select the name of the job you want to cancel.

C Click the pause icon, and then click the trash icon.

❒ When this printer is used as a network printer, other users' print jobs cannot
be canceled from a client computer.
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Caution During Printing

Collate

The Collate function allows you to print while sorting printouts into page-ordered
sets, such as when printing multiple copies of meeting materials.

For details about collate and job separation, see the printer driver Help.

❖ Collate
Output can be assembled as sets in sequential order.

❒ Up to 150 pages can be sorted using RAM. With hard disk drive, up to 1000
pages can be sorted.

Printing with the Finisher

You can collate, staple or punch holes in printed paper by installing the optional
finisher. Make sure you read the following precautions when using the optional
finisher:

For information about optional finishers, see Printer Reference.

To use the staple function, see p.119 “Staple”.

To use the punch function, see p.121 “Punch”.

❖ Be sure to make settings for options installed on the machine in the printer drivers.

To make settings for options in the printer drivers, see printer driver Help.

❖ Be sure to set the paper size and paper orientation in the printer driver when using
duplex printing, booklet, combine (layout), staple and punch functions.

For information about duplex printing, booklet, and layout, see the printer
driver Help.

To use the staple function, see p.119 “Staple”.
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To use the punch function, see p.121 “Punch”.

❒ Depending on the application, print settings may not be enabled and printed
output may not be as expected.

❖ When setting staple or collate in the printer driver, make sure that the Collate check
box is cleared in the application's [Print] dialog box.
If Collate is enabled in the application, printing will not be as intended.

Staple

With the optional finisher installed, sets can be stapled individually when printing
multiple sets.

Staple Position

The specified staple position varies depending on paper size, type, quantity and
feed orientation. The following table shows staple positions:

For paper sizes and maximum numbers of sheets available for stapling, see
“Specifications”, Printer Reference.

For printing methods, see the printer driver Help.

The staple position will vary when using the PostScript 3 printer driver. For
more information, see the PostScript 3 printer driver Help.

Stapling Precautions

❒ Stapling can be done only with the optional finisher installed.

❒ Stapling cannot be done when paper is fed from the bypass tray.
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❒ You cannot interrupt the current job with a job for another function requiring
stapling or collating.

❒ When printing on letterhead, stapling may not be at the specified position.

❒ When the finisher is installed, and when an output tray that cannot output us-
ing the staple function has been selected, the paper will be output according
to System Settings.

❒ If you cannot make staple settings even with the finisher installed, options
may not be set correctly in the printer driver. Correct option settings in the
printer driver. For details, see the printer driver Help.

❒ When duplex printing is selected, adjust staple positions to the binding orien-
tation.

❒ When the finisher is being used for another function's job (for example, a copy
job), printing will start after that job ends.

❒ When [Top left slant] or [Top right slant] is selected, the machine tries to staple
at an angle. However, if slanted staple is mechanically impossible, the ma-
chine staples horizontally or vertically.

❒ When setting Staple in the printer driver settings, make sure that a collate op-
tion is not selected in the print settings of the application. If a collate option is
selected in the application, printing will not be as intended.

❒ Be sure to set paper size and orientation in the printer driver when stapling.

• Depending on the software you are using, print settings may not be saved
and the printed result may not be as expected.

❒ When printing restarts after removing jammed paper, the printing position
may be different, depending on the location of the jam.

• If the paper jam occurred in the optional finisher, printing will restart from
the top page of the data currently being printed, or from the page where the
paper jam occurred.

• If the paper jam occurred in the machine, printing will restart from the page
where the paper jam occurred.

❒ Even if the paper jam occurred in the machine, the error will not be cleared
unless the cover of the finisher is opened and closed.

❒ Staple printing will be canceled under the following conditions:

• If the number of staple jobs exceeds maximum. For information about the
maximum number, see “Specifications”, Printer Reference.

• If a paper size that cannot be stapled is selected. For information about pa-
per sizes that can be stapled, see “Specifications”, Printer Reference.

• If positions other than those fixed for stapling are specified.

• If there are inconsistencies between the orientation in duplex mode and the
staple position.
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• If paper sizes are mixed when a different paper size is specified during a
print job.

• When staples have run out.

• When feeding paper from the bypass tray.

• When staples have run out and Auto Continue is set, printing will continue
without stapling after the message has been displayed.

Punch

With the optional finisher installed, holes can be punched into printed output.

Punch Position

The specified punch position varies depending on paper feed and print data ori-
entation. The following table shows punch positions:

❒ Punch positions will vary slightly from page to page as holes are punched into
each sheet individually.

For information about paper sizes that can be punched, see “Specifications”,
Printer Reference.

For printing methods, see the printer driver Help.

The punch position will vary when using the PostScript 3 printer driver. For de-
tails, see the PostScript 3 printer driver Help.

Punching Precautions

❒ Punching cannot be done when paper is fed from the bypass tray.
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❒ If you cannot make punch settings even with the finisher installed, options
may not be set correctly in the printer driver. Correct option settings in the
printer driver. For details, see the printer driver Help.

❒ When duplex printing is selected, adjust punch positions according to binding
orientation.

❒ Be sure to set the punch position the same as the staple position when using
it with the staple function.

❒ Be sure to set paper size and orientation in the printer driver when punching.

• Depending on the software you are using, print settings may not be en-
abled and the printed result may not be as expected.

❒ Punch will be canceled under the following conditions:

• When a paper size that cannot be punched is selected. For information
about paper sizes that can be punched, see “Specifications”, Maintenane
Guide.

• If positions other than those fixed for punching are specified.

• If there are inconsistencies between the orientation in duplex mode and the
punch position.

• When feeding paper from the bypass tray.

• When the punch receptacle has become full and Auto Continue is set,
printing will continue without punching after the message appears.

Spool Printing

With Spool Printing, the print data is saved in the hard disk before printing. To
use this function, set it from the menu. See p.150 “System Menu”.

❒ Do not turn off the printer or the computer when a print job is being spooled
and the Data In indicator is blinking. The print job will remain in the hard disk
and be printed when the printer is turned on. The setting can be changed us-
ing the “spoolsw clear job” command on the telnet

❒ The Spool Printing function is available for data received using diprint, lpr, ipp,
ftp, and smb.

❒ When using diprint, the Spool Printing function cannot be used with bidirec-
tional communication.

❒ The domain reserved for spool printing is about 2 GB.

❒ When Spool Printing is on, the size of a single print job cannot exceed 500
MB.
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❒ When sending print jobs spooled from several computers, up to one diprint
job, 10 lpr jobs, one ipp job, one ftp job, and one smb job can be spooled. Jobs
exceeding this spooling capacity cannot be executed. It is necessary to wait
to add new jobs.

❒ First page takes longer to print when using spool printing.

❒ With Spool Printing, the computer is freed from print processing earlier, even
when processing a large amount of data.

❒ Spool jobs stored in the printer can be viewed or deleted using Web Image
Monitor.

For information about the “spoolsw clear job” command on the telnet, see
p.212 “spoolsw”.

Setting Spool Printing

Spool printing settings can be made using telnet or Web Image Monitor.

• Using Web Image Monitor
In [System] on the [Cancel] menu, click [Enable] in [Spool Printing].
For details, see Web Image Monitor Help.

• Using telnet
Enter “spoolsw spool on”.
For details, see p.212 “spoolsw”.

Checking or deleting spooled jobs using Web Image Monitor

Follow the procedure below to check or delete spooled jobs using Web Image
Monitor.

A Open a Web browser.

B Enter “http: //(printer's address)/” in the address bar to access the print-
er whose settings you want to change.

Top Page of Web Image Monitor appears.

C Click [Login].

The dialog box for entering the user name and password appears.

D Enter the user name and password, and then click [OK].

To use the default account, enter “admin” as user name, and leave the pass-
word blank.

E In the menu area, click [Job].

A submenu will appear.

F On the [Printer] menu, click [Spool Printing].
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A list of spooled jobs appears.

G To delete a job, select the check box of the job you want to delete, and
then click [Delete].

The selected job is deleted.

H Quit Web Image Monitor.

For details, see Web Image Monitor Help.

Covers

Using this function, you can insert cover and back sheets fed from a different tray
to that of the body of the document, and print on them.

For printing methods, see the printer driver Help.

❒ To use this function, Collate must be set. Rotating Collate cannot be set.

❒ The cover sheets should be the same size and orientation as the body of the
paper.

❒ If “Auto Tray Select” is set as the paper feed tray for the body paper, the paper
will be delivered from a tray containing paper in the K orientation. Therefore,
if the cover paper is set to L orientation, the orientation of cover and body will
be different.

❒ The cover sheets will not be printed when the sheet for the cover page is fed
from the optional interposer.

• For information about setting paper when using the optional interposer, see
“Loading Paper in the Interposer”, Printer Reference.

❖ Cover Sheet
Prints the first page of the document on the sheet for the cover page.

• Print on one side
Prints on one side of the cover sheet only, even when duplex printing is se-
lected.

• Print on both sides
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Prints on both sides of the cover sheet when duplex printing is selected.

• Front cover printed on both sides

• Front cover printed on one side

• Blank

• When printing one side

• When printing both sides

❖ Front/Back covers
Prints the first and last page of the document as the cover and back cover
pages.

• Print on one side
Prints on one side of the cover sheets only, even when duplex printing is
selected.



Other Print Operations

126

• Back cover page face inside

• Back cover page face outside

• Print on both sides
Prints on both sides of the cover sheets when duplex printing is selected.

• Front cover printed on both sides, back cover page face inside, and the
number of pages is even

• Front cover printed on both sides, back cover page face inside, and the
number of pages is odd

• Front cover printed on one side, back cover page face inside, and the
number of pages is even
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• Front cover printed on one side, back cover page face inside, and the
number of pages is odd

• Blank

• When printing one side

• When printing both sides

Slip Sheets

❖ Inserting a slip sheet between each page

• Print
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• Blank

❖ Inserting a slip sheet between OHP transparencies

• Print

• Blank

❒ Collate cannot be set when using slip sheets.

❒ Slip sheets cannot be inserted while duplex printing.

❒ The slip sheet should be the same size and orientation as the body of the doc-
ument.

❒ If “Auto Tray Select” has been set as the paper feed tray for the body paper,
the paper will be delivered from a tray containing paper in K orientation.
Therefore, when the cover paper has been set to L orientation, the orienta-
tion of the output cover paper and body paper will be different.

❒ Slip sheets cannot be printed when paper for the slip sheet is fed from the op-
tional interposer.

• For information about setting paper when using the optional interposer, see
“Loading Paper in the Interposer”, Printer Reference.

❒ The same paper feed tray cannot be set for the main paper and slip sheets.
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Chaptering

The specified page is printed on the same side as the first page, like a book. Al-
so, you can insert chapter slip sheets before specified pages, and select whether
or not to print on the slip sheets.

For printing methods, see the printer driver Help.

❒ Up to 20 pages can be specified as the front pages of chapters using the print-
er driver.

❖ No slip sheets

❒ This function is only valid with duplex printing.

❒ This function can be used together with combine (layout) printing.

❖ Inserting chapter slip sheets

• Print
Prints on the chapter slip sheets. When duplex printing is selected, both
sides of the slip sheets are printed on.

• Print on front side only
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Prints on the front side of the chapter slip sheets even if duplex printing is
selected.

• Blank

❒ The slip sheet should be the same size and orientation as the body of the
paper.

❒ If “Auto Tray Select” has been set as the paper feed tray for the body paper,
the paper will be delivered from a tray containing paper in K orientation.
Therefore, when the cover paper has been set to L orientation, the orien-
tation of the output cover paper and body paper will be different.

❒ The same paper feed tray cannot be set for the body of the document and
the slip sheet.

❒ Slip sheets cannot be printed on when paper is fed from the optional inter-
poser.

• For information about setting paper when using the optional interposer,
see “Loading Paper in the Interposer”, Printer Reference.

Tab Sheet

Prints on tab sheets.
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❒ Make sure to install the optional tab sheet holder when setting tab sheets.
Contact your service representative regarding the optional tab sheet holder
installation.

❒ Only tab sheets with the tab on the right (at the top part of the paper) can be
printed on.

For information about tab sheets size that can be printed, see Printer Refer-
ence.

For printing method, see the printer driver Help.

❒ Make sure to check the position of the tab beforehand, so that images to be
printed do not come out slanted. If there are any letters in a position where the
tab is not present, toner may dirty the back of the paper.

❒ If there are any inconsistencies between the position of the tab, the staple and
the punch hole, the tab position will be prioritized.

Memory Capacity and Paper Size

❒ When printing from bypass tray, duplex printing will not be supported regard-
less of the memory capacity, and only one-side will be printed.

One-sided printing (600 x 600 dpi)

❖ 384 MB (standard)

• A6, A5, B5 JIS, A4, B4 JIS, A3, Letter, and Legal sized paper printing is
guaranteed.

One-sided printing (1200 x 1200 dpi)

❖ 384 MB (standard)

• A6, A5, B5 JIS, A4, B4 JIS, A3, Letter, and Legal sized paper printing is
guaranteed.

Duplex printing (600 x 600 dpi)

❖ 384 MB (standard)

• A6, A5, B5 JIS, A4, B4 JIS, A3, Letter, and Legal sized paper printing is
guaranteed.
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Duplex printing (1200 x 1200 dpi)

❖ 384 MB (standard)

• A6, A5, B5 JIS, A4, Letter, and Legal sized paper printing is guaranteed.
A3, and 11 x 17 sized paper can be printed.
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Making Printer Settings Using the Control Panel

Menu Chart

This section explains how to change the default settings of the printer and pro-
vides information about the parameters included in each menu.

❖ Sample Print

❒ For details, see p.106 “Sample Print”.

❖ Locked Print

❒ For Details, see p.110 “Locked Print”.

❖ Paper Input

❖ List/Test Print

❖ Maintenance

Menu

Bypass Size

Tray Paper Size

Paper Type

Tray Locking

Tray Priority

Menu

Config.P/Er.Log

Config. Page

Error Log

Menu List

PCL Config.Page

PS Config. Page

PDF Config.Page

Hex Dump

Operations Test

Menu

Registration

HD Format

WL.LAN Signal
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❖ System

WL.LAN Defaults

Key Repeat

Menu Protect

List Print Lock

File Locking

Unlock Files

Menu

Prt. Err Report

Auto Continue

Memory Overflow

Copies

Printer Lang.

Sub Paper Size

Page Size

Edge-Edge Print

Def.Print Lang.

Duplex

Blank Pages

Output Tray

Job Separation

Rotate 180 deg.

Energy Saver

Auto Reset Time

Memory Usage

Unit of Measure

Edge Smoothing

Toner Saving

Spool Printing

Spool Image

Letterhead Mode

Bypass Priority

Email Date

Menu
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❒ [Spool Printing] appears when the optional hard disk is installed.

❒ [RAM Disk] will not appear when the optional hard disk is installed.

❖ Host Interface

❒ [IEEE 1394 Setup] appears when the optional IEEE 1394 interface board is
installed.

❒ [IEEE 802.11b] appears when the optional IEEE 802.11b interface unit is in-
stalled.

❖ PCL Menu

❖ PS Menu

Menu

I/O Buffer

I/O Timeout

Network Setup

IEEE 802.11b

USB Setting

Menu

Orientation

Form Lines

Font Source

Font Number

Point Size

Font Pitch

Symbol Set

Courier Font

Ext. A4 Width

Append CR to LF

Resolution

Menu

Data Format

Resolution
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❖ PDF Menu

❖ Language

Menu

PDF: Change PW

PDF Group PW

Resolution

Menu

English

German

French

Italian

Dutch

Swedish

Norwegian

Danish

Spanish

Finnish
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Paper Input Menu

This section explains about paper settings on the Paper Input menu such as pa-
per sizes and types on each tray.

Changing the paper input menu

Tray locking

Follow the procedure below to lock/unlock trays.

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {U} or {T} key to display [Paper Input], and then press the {#
Enter} key.

C Press the {U} or {T} key to display [Tray Locking], and then press the {#
Enter} key.

D Press the {U} or {T} key to display the tray to unlock, and then press
the {# Enter} key.

E Press the {U} or {T} key to display [Off], and then press the {# Enter} key.

Wait for two seconds. The [Paper Input] screen appears.

F Press the {Online} key.

The initial screen appears.

Tray priority

Follow the procedure below to change the tray priority.



Making Printer Settings Using the Control Panel

138

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {U} or {T} key to display [Paper Input], and then press the {#
Enter} key.

C Press the {U} or {T} key to display [Tray Priority], and then press the {#
Enter} key.

D Press the {U} or {T} key to select a tray you want to use.

E Press the {# Enter} key.

Wait for two seconds. The [Paper Input] screen appears.

F Press the {Online} key.

The initial screen appears.

Paper Input menu parameters

This section explains about parameters that can be set on the Paper Input menu.

❖ Bypass Size
You can specify the paper size for Bypass tray.
For details about the size of paper loaded in the bypass tray, see “Paper and
Other Media Supported by This Printer”, Printer Reference.

❖ Tray Paper Size
Paper size for tray 2, 3.
When you select sizes that are not indicated on the paper size dial of tray 2
or tray 3, you should set the dial to “p”, and then select the paper size here.
For details about the size of paper loaded in each tray, see “Paper and Other
Media Supported by This Printer”, Printer Reference.

❒ Only the installed trays appear on the display panel.



Making Printer Settings Using the Control Panel

139

❖ Paper Type
If you use various types of paper, select the paper type for tray 1, tray 2, tray
3, bypass tray or LCT.
For details about types of paper loaded in each tray, see “Paper and Other
Media Supported by This Printer”, Printer Reference.

❖ Tray 1, 2, 3
Plain Paper, Recycled Paper, Color Paper 1, Color Paper 2, Special Paper,
Color Paper, Letterhead, Preprinted, Prepunched, Bond Paper, Translu-
cent, Thick Paper

❖ Tray 2, 3
Tab Stock

❖ Bypass Tray
Plain Paper, Recycled Paper, Special Paper, Color Paper 1, Color Paper
2, Letterhead, Preprinted, Prepunched, Labels, Bond Paper, Cardstock,
Translucent, Transparency, Thick Paper

❒ Default : Plain Paper

❒ Only the installed trays and LCT appear on the display panel.

❖ Tray Locking
If you use various types of paper, you can lock a tray to prevent printing on
different types of paper such as letterhead or colored paper. When [Auto Se-
lect] is selected in [Paper Source] from the printer driver, the locked tray is not
used. You can select each tray set to on or off.

❒ Default : Off

❒ Only installed trays appear on the display panel.

❒ You cannot lock multiple trays.

❒ If you need to have a tray locked, you must select the tray using printer driv-
er.

❒ When a locked tray is selected from the printer driver, the printer does not
search for another tray.

❖ Tray Priority
You can set a tray to be checked first when [Auto Tray Select] is selected in [Pa-
per Source] from the printer driver.

• Tray 1, Tray 2, Tray 3, LCT

❒ Default : Tray 1

❒ Only installed trays appear on the display panel.
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❒ It is recommended that you load paper of the size and orientation you use
most frequently in the tray selected in [Tray Priority].
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List/Test Print Menu

You can print lists of configurations on printer or the paper printings.

Also, you can check the types and characters of all the printable fonts.

Printing a Configuration Page

Follow the procedure below to print the configuration page.

❒ The configuration page is printed on A4 or Letter (8 1/2 x 11) size paper, so
load them in the same paper tray.

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {T} or {U} key to display [List/Test Print], and then press the {#
Enter} key.

C Press the {T} or {U} key to display [Config. Page], and then press the {#
Enter} key.

The configuration page is printed. The test print menu screen returns on com-
pletion of printing.

D Press the {Online} key.

The initial screen appears.

Interpreting the configuration page

❖ System Reference

❖ Printer ID
The serial number assigned to the board by its manufacturer is displayed.
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❖ Firmware Version

• Firmware
The version number of the printer controller firmware is displayed.

• Engine
The version number of the printer engine firmware is displayed.

• NCS
The version number of the network interface board is displayed.

❖ Pages Printed
The total number of pages printed by the printer to date is displayed.

❖ Total Memory
The total amount of SDRAM installed on the printer is displayed.

❖ Controller Option
The items are displayed when the controller options are installed.

❖ Printer Language
The version number of the printer language is displayed.

❖ Options
The options installed are displayed.

❖ Consumption Status
The amount of toner remaining is displayed.

❖ Paper Input
Settings made on the [Paper Input] menu are displayed.

For details, see p.137 “Paper Input Menu”.

❖ Maintenance
Settings made on the [Maintenance] menu are displayed.

For details, see p.145 “Maintenance Menu”.

❖ System
Settings made on the [System] menu are displayed.

For more information, see p.150 “System Menu”.

❖ Host Interface
Settings made on the [Host Interface] menu are displayed.
When DHCP is active on the network, the IP address, subnet mask and gate-
way address appear in parentheses on the configuration page.
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For details, see p.158 “Host Interface Menu”.

❖ PCL Menu
Settings made on the [PCL Menu] are displayed.

For details, see p.164 “PCL Menu”.

❖ PS Menu
Settings made on the [PS Menu] are displayed.

For details, see p.167 “PS Menu”.

❖ PDF Menu
Settings made on the [PDF Menu] are displayed.

For details, see p.169 “PDF Menu”.

❖ Interface Information
Interface information is displayed.

List/Test menu parameters

This section explains about parameters that can be set on the List/Test menu.

❖ Config.P/Er.Log
You can print the configuration page and error log.

❖ Config. Page
You can print the current configuration of the printer.

❖ Error Log
You can print an error report.

❖ Menu List
You can print a menu list showing all available menus.

❖ PCL Config.Page
You can print the current PCL configuration.

❖ PS Config. Page
You can print an installed PS font and the Disk Directory List which shows the
optional hard disk.
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❖ PDF Config.Page
You can print an installed PS3 font and the Disk Directory List which shows
the optional hard disk.

❖ Hex Dump
You can print the data sent by the computer using Hex Dump.

❖ Operations Test
Perform a print test to check that paper trays, optional trays, and the finisher
tray's staple and punch functions are operating correctly. If a function is not
operating correctly, an error message appears and printing stops. Print ap-
pears in a black frame if the functions are operating correctly.
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Maintenance Menu

You can set printing conditions such as density and calibration, and printer man-
agement such as formatting the optional hard disk unit.

Changing the maintenance menu

This section explains changing the maintenance menu using examples.

HD Format

Follow the procedure below to format the hard disk unit after initial setup.

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {T} or {U} key to display [Maintenance], and then press the {#
Enter} key.

C Press the {T} or {U} key to display [HD Format], and then press the {# En-
ter} key.

D Read the HD format confirmation message, and then press the {# Enter}
key to start formatting.

The hard disk unit is formatted, and the rebooting message appears.

E Turn off the printer's power. After a few seconds, turn the power on
again.

The hard disk unit is now formatted and ready to use.

Displaying the signal strength

Follow the procedure below to check the IEEE 802.11b (wireless LAN) signal on
the [Maintenance] menu.
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A Press the {Menu} key.

The [Menu] screen appears.

B Press the {T} or {U} key to display [Maintenance], and then press the {#
Enter} key.

C Press the {T} or {U} key to display [WL.LAN Signal], and then press the {#
Enter} key.

Check the display for result.

D Press the {Escape} key.

The initial screen appears.

❒ If [WL.LAN Signal] is not displayed, [IEEE 802.11b] has not been selected for
[LAN Type] in [Network Setup] on the [Host Interface] menu. Select [IEEE
802.11b] for [LAN Type], and then check that [WL.LAN Signal] is displayed on
the [Maintenance] menu again.

❒ Signal status can be measured in [Infrastructure] under [Comm. Mode] of the
wireless LAN. If [Ad hoc] or [802.11 Ad hoc] is selected in [Comm. Mode], sig-
nal status cannot be measured. To measure signal status, select [Comm.
Mode] in [Infrastructure] under [IEEE 802.11b] on the [Host Interface] menu.

❒ Every time you press the {# Enter} key, the signal is updated.

❒ The signal is rated [Good] if signal strength is 86%-100%, [Fair] if 61%-85%,
[Poor] if 31%-60%, and [Unavailable] if 0%-30%. If the signal is unstable or
unavailable, remove any obstructions or move the printer to a place to re-
ceive the signal.

❒ Using wireless devices or microwave sources nearby will affect the signal
transmission.

Resetting the IEEE 802.11b (Wireless LAN) Settings

Follow the procedure below to reset the wireless LAN setting on the [Maintenance]
menu.
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❒ [Comm. Mode], [Channel], [Trans. Speed], [WEP Setting], and [SSID] can be select-
ed on the [Host Interface] menu.

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {T} or {U} key to display [Maintenance], and then press the {#
Enter} key.

C Press the {T} or {U} key to display [WL.LAN Defaults], and then press the
{# Enter} key.

D Press the {# Enter} key.

The wireless LAN setting is reset.

After about three seconds, the initial screen appears.

Maintenance menu parameters

This section explains about parameters that can be set on the Maintenance
menu.

❖ Registration
You can adjust the starting position of the printing page.

❖ Prt. Test Sheet
You can print the registration sets sheet.

• Tray 1, Tray 2, Tray 3, LCT, Bypass Tray, Duplex.BackSide

❒ Only the installed trays appear on the display panel.

❖ Adjustment
You can select the start position for printing on a page.

• Vert: Tray 1, Vert: Tray 2, Vert: Tray 3, Vert: LCT, Vert: Bypass, Vert:
Dup. Back, Horiz.:All Trays
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• -9.0 to +9.0

❒ Only the installed trays appear on the display panel.

❖ HD Format
You can format the hard disk.

❖ WL.LAN Signal
You can check the signal strength when using wireless LAN.

For details about displaying the signal strength, see p.145 “Displaying the
signal strength”.

❖ WL.LAN Defaults
Reset the wireless LAN to default. The menu appears when the 802.11b in-
terface unit is installed.

❖ Key Repeat
Holding down [On] allows users to scroll through items and settings. Pressing
[Off] moves through items and settings one at a time.

❒ Default: On

❖ Menu Protect
This procedure protects menu settings from accidental changes. A key oper-
ation is required to change menu settings. In a network environment, only net-
work administrators can change menu settings.

• Level 1

• Level 2

• Off

❒ Default: Off

❒ While the printer is online, press the {# Enter} key, press the {Escape} key,
and then press the {Menu} key. You can access [Menu Protect] on the dis-
play panel.

❒ You can preserve settings for the [Maintenance], [System], [Host Interface],
and [Language] menus on Level 1.

❒ You can preserve settings for the [Paper Input], [Maintenance], [System], [Host
Interface], and [Language] menus on Level 2.

❖ List Print Lock
Disable users to print the lists or reports in List/Test Print menu or other test
prints.



Making Printer Settings Using the Control Panel

149

• On

• Off

❒ Default: Off

❒ While the printer is online, press the {# Enter} key, then press the {Es-
cape} key, and then press the {Menu} key. You can access [List Print
Lock] from the display panel.

❖ File Locking
If the user tries to access a file and enters the wrong password 10 times, the
file is automatically locked.

• On

• Off

❒ Default: Off

❒ While the printer is online, press the {# Enter} key, then press the {Es-
cape} key, and then press the {Menu} key. You can access [File Locking]
from the display panel.

❖ Unlock Files
You can unlock a file that was locked because a user entered the wrong pass-
word 10 times.

❒ While the printer is online, press the {# Enter} key, then press the {Escape}
key, and then press the {Menu} key. You can access [Unlock Files] from the
display panel.
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System Menu

You can set basic functions required to use the printer. The printer can be used
on factory default, but the configuration can be changed depending on the con-
dition of the user. The changed condition holds even if the printer is turned off.

Changing the system menu

Follow the procedure below to change the settings for Energy Saver Timer.

A Press the {Menu} key.

The [Menu] screen appears.

B Press {U} or {T} key to display [System], and then press the {# Enter} key.

C Press {U} or {T} key to display [Energy Saver], and then press the {# Enter}
key.

D Press the {U} or {T} key to display [E. Saver Timer], and then enter {# En-
ter} Key

E Press {U} or {T} key to select the lead time needed to switch to the En-
ergy Saver mode.

F Press the {# Enter} key.

Wait for two seconds. The [Energy Saver] screen appears.

G Press the {Online} key.

The initial screen appears.

System menu parameters

This section explains about parameters that can be set on the System menu.
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❖ Prt. Err Report
You can select [On] or [Off] to have an error report printed when a printer error
or memory error occurs.

• Off

• On

❒ Default: Off

❖ Auto Continue
You can make the Auto Continue setting. When set to on, printing continues
after a system error occurs.

• Off

• Immediate

• 1 minute

• 5 minutes

• 10 minutes

• 15 minutes

❒ Default: Off

❒ When set to on and certain errors occur, the current job may be canceled,
and the printer automatically perform the next queued job.

❖ Memory Overflow
You can specify whether or not to print a memory overflow error report.

• Do not print

• Error Info.

❒ Default: Do not print

❖ Copies
You can specify the number of pages to print.
This setting is disabled if the number of pages to print is specified by com-
mand or the printer driver.

• 1-999

❖ Printer Lang.
You can specify the printer language.

• Auto Detect

• PCL

• PS

• PDF
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❒ Default: Auto Detect

❖ Sub Paper Size
You can select [Off] or [Auto] to enable the Sub Paper Size function. When
you select [Auto], the printer uses an alternative paper size if the currently
specified paper is not loaded. When you select [Off], the printer uses any size
paper in the current specified paper tray.

• Off

• Auto

❒ Default: Off

❖ Page Size
You can specify the default paper size.
8 1/2 × 14, 8 1/2 × 11, 5 1/2 × 8 1/2, 7 1/4 × 10 1/2, 8 × 13, 8 1/2 × 13, 8 1/4 × 13,
A4 (210 × 297), B5 JIS(182 × 257), A5 (148 × 210), A6 (105 × 148), 11 × 17,
A3 (297 × 420), B4 (257 × 364), Custom Size.

❒ Default:

• Metric version: A4 (210 × 297)

• Inch version: 8 1/2 × 11

❒ The initial paper size is applied when the paper size is not specified in the
print data.

❒ JIS stands for “Japanese Industrial Standard”.

❖ Edge-Edge Print
You can print on the complete area of an A4 sheet leaving no border on any
egde.

• Off

• On

❒ Default: Off

❖ Def.Print Lang.
You can specify the initial printer language if the machine cannot detect the
printer language.

• PCL

• PS

• PDF
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❒ Default: PCL

❖ Duplex
You can specify whether or not to print on both sides of a sheet.

• Off

• Short Edge Bind

• Long Edge Bind

❒ Default: Off

❒ This menu appears only when the optional duplex unit is installed.

❖ Blank Pages
You can specify whether or not to print blank pages.

• Do not print

• Print

❒ Default: Print

❖ Output Tray
You can select the default output tray. 

• Fin. Upper Tray

• Fin. Shift Tray

• Finisher Tray 1

• Finisher Tray 2

❒ Default: Fin. Upper Tray

❖ Job Separation
You can enable Job Separation.

• On

• Off

❒ Default: Off

❖ Rotate 180 deg.
You can specify whether or not to rotate the paper by 180 degrees.

• On

• Off
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❒ Default: On

❖ Energy Saver
You can specify how many minutes for the energy saver mode.

❖ E.Saver On/Off
You can specify whether or not to switch Energy Saver.

• On

• Off

❒ Default: On

❒ When the printer switches to the Energy Saver mode, the Power indica-
tor goes off, while the online indicator stays lit.

❖ E. Saver Timer
You can select the lead time needed to switch to the Energy Saver mode.
The Energy Saver mode reduces electric power consumption.

• 1 minute

• 5 minutes

• 15 minutes

• 30 minutes

• 45 minutes

• 60 minutes

❒ Default: 60 minutes

❒ When the printer switches to the Energy Saver mode, the Power indica-
tor goes off, while the Online indicator stays lit and [Energy Save Mode]
appears.

❖ Auto Reset Time
You can set On or Off and the time for the Auto Reset Timer.

❒ Appears only at network standard model.

❖ Auto Reset

• On

• Off

❒ Default: On
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❖ Reset Time(sec)

• Reset Time

• 60 sec.

❖ Memory Usage
You can select memory to be used from “Font Priority” or “Frame Priority” ac-
cording to the paper size, resolution or printer language.

• Font Priority
This setting uses memory for registering fonts.

• Frame Priority
This seting uses memory for high speed printing.

❒ Default: Frame Priority

❖ Unit of Measure
You can specify the unit of measurement in “mm” or “inch” for the custom pa-
per size.

• mm

• inch

❒ Default value is destination dependant.

❖ Edge Smoothing
You can set whether edge smoothing is enabled. When it is on, jagged lines
appear more smoothly. Set it to off when the print image contains fine grada-
tion in tone.

• On

• Off

❒ Default: On

❒ If “Toner Saving” is “On”, “Edge Smoothing” is ignored even if it is “On”.

❖ Toner Saving
You can select whether or not Toner Saving is enabled

• Off

• On

❒ Default: Off

❒ If “Toner Saving” is “On”, “Edge Smoothing” is ignored even if it is “On”.
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❖ Spool Printing
You can select whether or not all print data is spooled to the hard disk drive
before printing.

• Off

• On

❒ Default: Off

❒ Spooling temporarily stores a sent print job in the printer, and then prints it.

❒ First pages take longer to print when using spool printing.

❖ Spool Image
You can select whether or not the entire print image is spooled to the hard
disk.

• Off

• On

❒ Default: Off

❒ Spooling temporarily stores a sent print job in the printer, and then prints it.

❒ First pages take longer to print when using spool printing.

❖ Letterhead Mode
You can select the letterhead printing mode.

• Off

• Auto Detect

• On (Always)

❒ Default: Off

❖ Bypass Priority
When the different paper size or type is specified from the driver, you can
specify which setting is given priority to, machine setting or command.

• Machine

• Driver/Command

❒ Default: Driver/Command

❒ Appear only at network standard model.

❖ Email Date
When a mail date/time cannot be notified, the user can set whether a dummy
date/time is set or not.

• Off
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• On

❒ default: Off

❒ While the printer is online, press the {# Enter} key, then press the {Es-
cape} key, and then press the {Menu} key. You can access [Email Date]
from the display panel.
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Host Interface Menu

You can set configurations about network connections and communication when
using parallel connection between the printer and the computer. The changed
configuration holds even if the printer is turned off.

Changing the Host Interface menu

Follow the procedure below to change the I/O Timeout

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {U} or {T} key to display [Host Interface], and then press the {#
Enter} key.

C Press the {U} or {T} key to display [I/O Timeout], and then press the {#
Enter} key.

D Press the {U} or {T} key to select the lead time needed to end a printing
operation, and then press the {# Enter} key.

Wait for two seconds. The [Host Interface] menu appears.

E Press the {Online} key.

The initial screen appears.

Host Interface menu parameters

This section explains parameters that can be set on the Host Interface menu.

❖ I/O Buffer
You can select the size of I/O Buffer. Normally it is not necessary to change
this setting.

• 128 KB
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• 256 KB

• 512 KB

❒ Default: 128 KB

❖ I/O Timeout
You can set how many seconds the printer should wait before ending a print
job. If printing operation is frequently interrupted by data from other ports, you
can increase the timeout period.

• 10 seconds

• 15 seconds

• 20 seconds

• 25 seconds

• 60 seconds

❒ Default: 15 seconds

❖ Network Setup
You can make network-related settings.

For details, see “Configuration”, Printer Reference.

❖ DHCP
You can select [On] or [Off] to use DHCP with TCP/IP.

• On

• Off

❒ Default: On

❖ IP Address
You can specify the IP address.

❒ When DHCP is set to on, the IP address cannot be changed. To change
it, set DHCP to off. Contact your network administrator for information
about the network configuration.

❒ Default: 000.000.000.000

❖ Subnet Mask
You can specify the subnet mask.
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❒ When DHCP is set to on, the subnet mask cannot be changed. To
change it, set DHCP to off. Contact your network administrator for infor-
mation about the network configuration.

❒ Default: 000.000.000.000

❖ Gateway Address
You can specify the gateway address.

❒ When DHCP is set to on, the gateway address cannot be changed. To
change it, set DHCP to off. Contact your network administrator for infor-
mation about the network configuration.

❒ Default: 000.000.000.000

❖ Frame Type (NW)
You can select the frame type for NetWare.

• Auto Select

• Ethernet ll

• Ethernet 802.2

• Ethernet 802.3

• Ethernet SNAP

❒ Default: Auto Select

❖ Active Protocol
You can select the active protocol.

• TCP/IP

• NetWare

• SMB

• AppleTalk

❒ Default: All Active

❖ Ethernet Speed
You can select the network speed to operate the printer.

• Auto Select

• 10Mbps Half D.

• 10Mbps Full D.
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• 100Mbps Half D.

• 100Mbps Full D.

❒ Default: Auto Select

❖ LAN Type
You can select Ethernet or IEEE 802.11b for LAN Type.
This menu appears only when the optional 802.11 interface unit is in-
stalled.

• Ethernet

• IEEE 802.11b

❒ Default: Ethernet

❖ IEEE 802.11b
You can make settings for wireless LAN. This menu appears only when the
optional 802.11b interface unit is installed.

❖ Comm. Mode
You can select the transmission mode for IEEE 802.11b.

• 802.11 Ad hoc

• Infrastructure

• Ad hoc

❒ Default: 

❒ Comm. Mode can also be set using a Web Image Monitor. For details,
see Web Image Monitor Help.

❖ Channel
You can select channels: 1-11 (inch version)/1-13 (metric version).

❒ Default: 11(inch version)/13 (metric version)

❖ Trans. Speed
You can select the transmission speed for IEEE 802.11b.

• Auto

• 11 Mbps

• 5.5 Mbps

• 2 Mbps

• 1 Mbps
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❒ Default: Auto

❖ SSID
You can set an SSID in the infrastructure mode and the 802.11 Ad hoc
mode.
Select [View] to check the SSID. Select [Enter ID] to set SSID.

• View

• Enter ID

❒ Select [?] to enter [/] for the SSID. Also, [¥] appears when printing the
configuration page, read it as [/].

❒ Default: blank (ASSID)

❒ Characters used are ASCII 0x20-0x7e (32 bytes).

❒ An SSID is set automatically to the nearest access point if no SSID has
been set.

❒ If no SSID has been set for the 802.11 ad hoc mode, an SSID is set au-
tomatically and the same SSID is used for the 802.11 ad hoc mode and
the infrastructure mode.

❒ If blank is specified in SSID for 802.11b adhoc mode or adhoc mode,
“ASSID” appears.

❒ An SSID can also be set using Web Image Monitor. For details, see
Web Image Monitor Help.

❖ WEP Setting
You can specify whether or not to activate WEP settings.

• Active

• Not Active

❒ Default: Not Active

❒ The WEP key can be entered using a hexadecimal number or an ASCII
character sequence.

❒ When using 64 bit WEP, up to 10 hexadecimal or 5 ASCII characters
can be entered. When using 128 bit WEP, up to 26 hexadecimal or 13
ASCII characters can be entered.

❒ The WEP key can also be set using Web Image Monitor. For details, see
Web Image Monitor Help.

❖ USB Setting
You can select the transmission speed for USB.
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• Full Speed

• Auto

❒ Default: Auto

❒ While the printer is online, press the {# Enter} key, then press the {Escape}
key, and then press the {Menu} key. You can access [USB Setting] from the
display panel.
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PCL Menu

You can set conditions when using PCL for printing.

Changing the PCL menu

Follow the procedure below to change the setting for Orientation.

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {U} or {T} key to display [PCL Menu], and then press the {# En-
ter} key.

C Press the {U} or {T} key to display [Orientation] screen, and then press
the {# Enter} key.

D Press the {U} or {T} key to select the orientation, and then press the {#
Enter} key.

Wait for two seconds. The [PCL Menu] screen appears.

E Press the {Online} key.

The initial screen appears.

PCL Menu parameters

This section explains about parameters that can be set on the PCL menu.

❖ Orientation
You can select the page orientation.

• Portrait

• Landscape
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❒ Default: Portrait

❖ Form Lines
You can specify the number of lines per page between 5 and 128.

❒ Default:

• Metric version: 64

• Inch version: 60

❖ Font Source
You can set the location of the default font.

• Resident

• RAM

• HDD

• SD

❒ Default: Resident

❒ When you select [RAM], you can select only fonts downloaded to the printer
RAM.

❒ When you select [HDD], you can select only fonts downloaded to the hard
disk.

❖ Font Number
You can specify the ID of the default font you want to use.

• 0 to 50 (Internal)

• 1 to 50 (Download)

❖ Point Size
You can specify the point size you want to use for the default font between 4
and 999.75 in 0.25 increments.

❒ Default: 12.00 points

❒ This setting is effective only for a variable-space font.

❖ Font Pitch
You can specify the number of characters per inch you want to use for the de-
fault font between 0.44 and 99.99 in 0.01 increments.

❒ Default: 10.00 pitch

❒ This setting is effective only for fixed-space fonts.
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❖ Symbol Set
You can specify the character set for the default font. Available sets are as
follows:
Roman-8, ISO L1, ISO L2, ISO L5, PC-8, PC-8 D/N, PC-850, PC-852, PC8-
TK, Win L1, Win L2, Win L5, Desktop, PS Text, VN Intl, VN US, MS Publ,
Math-8, PS Math, VN Math, Pifont, Legal, ISO 4, ISO 6, ISO 11, ISO 15, ISO
17, ISO 21, ISO 60, ISO 69, Win 3.0

❒ Default: PC-8

❖ Courier Font
You can select a courier-type font.

• Regular

• Dark

❒ Default: Regular

❖ Ext. A4 Width
You can extend the width of the printable area of A4 sheets reducing side
margin width.

• Off

• On

❒ Default: Off

❖ Append CR to LF
You can specify whether or not to append a CR code to each LF code to print
text data clearly.

• Off

• On

❒ Default: Off

❖ Resolution
You can specify the print resolution in dots per inch.

• 300 dpi

• 600 dpi

❒ Default: 600 dpi



Making Printer Settings Using the Control Panel

167

PS Menu

You can set conditions when using Postscript for printing.

Changing the PS menu

Follow the procedure below to change the setting for date format.

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {U} or {T} key to display [PS Menu], and then press the {# Enter}
key.

C Press the {U} or {T} key to display [Data Format], and then press the {#
Enter} key.

D Press the {U} or {T} key to select [TBCP], and then press the {# Enter}
key.

Wait for two seconds. The [PS Menu] screen appears.

E Press the {Online} key.

The initial screen appears.

PS Menu parameters

This section explains about parameters that can be set on the Postscript menu.

❖ Data Format
You can select the data format.

• Binary Data

• TBCP
This setting is effective when using a parallel, USB, or EtherTalk connection.
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When you use a parallel or USB connection, the print job is canceled if binary
data is sent from the printer driver.
When you use an Ethernet connection, the print job is canceled if:

• The printer driver data format is TBCP and the data format selected using
the control panel is Binary Data.

• The printer driver data format is binary and the data format selected using
the control panel is TBCP.

❒ Default: Binary Data

❖ Resolution
You can select the resolution.

• 300 dpi

• 600 dpi

• 1200 dpi

❒ Default: 600 dpi



Making Printer Settings Using the Control Panel

169

PDF Menu

You can set conditions when using PDF printing.

Changing the PDF menu

Follow the procedure below to change the resolution setting.

A Press {Menu} key.

The [Menu] screen appears.

B Press {U} or {T} key to display [PDF Menu], and then press the {# Enter}
key.

C Press {U} or {T} key to display [Resolution], and then press the {# Enter}
key.

D Press {U} or {T} key to select the resolution, and then press the {# En-
ter} key.

Wait for two seconds. The [PDF Menu] screen appears.

E Press the {Online} key.

The initial screen appears.

PDF Menu parameters

This section explains about parameters that can be set on the PDF menu.

❖ PDF: Change PW
You can specify the password for the PDF file executing PDF Direct Print.

• Current PW
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❒ The password can be set using Web Image Monitor, but must be sent
through the network. For increased security, use this menu on the control
panel to set the password directly.

❒ Default: no password set

❖ PDF Group PW
You can set a group password specified using DeskTopBinder Lite.

• Current PW

❒ The password can be set using Web Image Monitor, but must be sent
through the network. For increased security, use this menu on the control
panel to set the password directly.

❒ Default: no password set

❖ Resolution
You can select the resolution for the PDF file executing PDF Direct Print.

• 300 dpi

• 600 dpi
1200 dpi

❒ Default: 600 dpi
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Language Menu

You can set language displayed on the menu.

Changing the language menu

Follow the procedure below to change the language.

A Press the {Menu} key.

The [Menu] screen appears.

B Press the {U} or {T} key to display [Language], and then press the {# En-
ter} key.

C Press the {U} or {T} key to select the language, and then press the {#
Enter} key.

Wait for two seconds. The [Menu] screen appears.

D Press the {Online} key.

The initial screen appears.

Language menu parameters

You can select the language you use. Available languages are as follows:

English, German, French, Italian, Dutch, Swedish, Swedish, Swedish, Spanish,
and Finnish.

❒ Default: English
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Monitoring and Configuring the Printer

Using Web Image Monitor

Using Web Image Monitor, you can check the printer status and change settings. 

❖ Available operations
The following operations can be remotely performed using Web Image Moni-
tor from a client computer.

• Displaying printer status or settings

• Checking the print job status or history

• Interrupting currently printing jobs

• Resetting the printer

• Managing the Address Book

• Making printer settings

• Making e-mail notification settings

• Making network protocol settings

• Making security settings

❖ Configuring the printer
To perform the operations from Web Image Monitor, TCP/IP is required. After
the printer is configured to use TCP/IP, operations from Web Image Monitor
become available.

❖ Recommended Web browser

• Windows:
Internet Explorer 5.5 or higher
Netscape Navigator 7.0 or higher

• Mac OS 8.1 or higher:
Netscape Navigator 7.0 or higher
Safari 1.0 or higher

❒ To use Netscape Navigator with Secured Sockets Layer (SSL: an encryption
protocol), use Netscape Navigator 7.0 or higher.

❒ If the previous versions of the Web browser above are used or JavaScript and
cookies are not enabled with the Web browser used, display and operation
problems may occur.

❒ If you are using a proxy server, change the Web browser settings. Contact
your network administrator for information about the settings.

❒ The previous page may not appear even after the back button of a Web
browser is clicked. If this happens, click the refresh button of a Web browser.

❒ Updating the printer information is not automatically performed. Click [Refresh]
in the display area to update the printer information.
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Displaying Top Page

This section explains the Top Page and how to display Web Image Monitor.

A Start your Web browser.

B Enter “http: //(printer's address)/” in the address bar of a Web browser.

Top Page of Web Image Monitor appears.

❒ If the printer's host name has been registered on the DNS or WINS server,
you can enter it. For details, see p.290 “Using DHCP”.

❒ When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentification is issued , enter “https://(printer's ad-
dress)/“.

Every Web Image Monitor page is divided into the following areas:

1. Header area

The link to help and dialog box for keyword search appears.

2. Menu area

The dialog box for switching to the user mode and administrator mode appears, and
each mode's menu will be displayed.

If you select menu, it's content will be shown on the work area, or the sub area.

3. Display area

Displays the contents of the item selected in the menu area.

Printer information in the display area is not automatically updated. Click [Refresh] at
the upper right in the display area to update the printer information. Click the Web
browser's [Refresh] button to refresh the entire browser screen.

Printer status, network interface board names, and comments are displayed.

4. Help

Use Help to view or download Help file contents.
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About Menu and Mode

There are two modes available with Web Image Monitor: user mode and admin-
istrator mode.

Displayed Items may differ depending on the printers.

❖ About User Mode
In the user mode, printer status, settings, and print job status can be viewed,
but the printer settings cannot be changed.

1. Status

Printer status, including the amount of remaining paper in paper trays and the amount
of remaining toner, is displayed.

2. Job

Allows you to display list of Spooled print Job, Job History, Error Log, Locked Print
and Sample Print jobs. This also perform or delete Locked Print and Sample Print
jobs.

3. Configuration

Display current printer and network settings, and download help files.

❖ Administrator Mode
In the administrator mode, you can configure various printer settings.

1. Status

Printer status, including the amount of remaining paper in paper trays and the amount
of remaining toner, is displayed.
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2. Job

Allows you to display list of Spooled Print Job, Job History, Error Log, Sample Print
and Locked Print. This also allows you to delete Spooled Print Job, Locked Print and
Sample Print Jobs.

3. Address Book

User information can be registered, displayed, changed, and deleted.

4. Configuration

Make system settings for the printer, interface settings, and security.

5. Reset Printer Job

Click to reset current print jobs and print jobs in queue. This button is located on Top
Page.

6. Reset Device

Click to reset the printer. If a print job is being processed, the printer will be reset after
the print job is completed. This button is located on Top Page.

Access in the Administrator Mode

Follow the procedure below to access Web Image Monitor in the administrator
mode.

A On Top Page, click [Login].

The dialog box for entering the user name and password appears.

B Enter your user name and password, and then click [OK].

To use the default account, enter “admin” as user name, and leave the pass-
word blank.

Displaying Web Image Monitor Help

When using Help for the first time, clicking either [Help] in the header area or the
icon marked “?” in the display area makes the following screen appear, in which
you can view Help in two different ways, as shown below:

❖ Viewing Help on our Web site
Downloading Help to your computer

❖ Downloading and Checking Help
You can download Help to your computer. As the Help URL, you can specify
the path to the local file to view the Help without connecting to the Internet.

❒ By clicking [Help] in the header area, the contents of Help appear.

❒ By clicking “?”, the Help icon in the display area, Help for the setting items in
the display area appears.
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Downloading Help

A In the [OS] list, select the operating system.

B In the [Language] list, select the language.

C Click [Download].

D Download Help by following the instructions on the screen.

E Store the downloaded compressed file in a location, and then decom-
press the file.

To view the downloaded Web Image Monitor Help, set the path to the location
of the decompressed file.

Linking the URL of the Help File to the [Help] Button.

You can link the URL of the help file on a computer or Web server to the [Help]
button.

A Log on to Web Image Monitor in the administrator mode.

B In the menu area, click [Configuration].

C Click [Webpage].

D In the [Help URL] box, enter the URL of the help file.

If you saved the help file to “C:HELPEN”, enter “file://C:/HELP/”. For example,
if you saved the file to a Web server, and the URL of the index file is “http://
a.b.c.d/HELP/EN/index.html”, enter “http://a.b.c.d/HELP/”.

E Click [Apply].
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Using SmartDeviceMonitor for Admin

Using SmartDeviceMonitor for Admin, you can monitor the network printers. Al-
so, you can change the configuration of the network interface board using
TCP/IP or IPX/SPX.

❖ Protocol stack provided with Operating System

• Windows 95/98/Me
TCP/IP
IPX/SPX
NetWare
NetWare Client32 for Windows 95
IntraNetWare Client for Windows 95
Novell Client for Windows 95/98/Me

• Windows 2000
TCP/IP
IPX/SPX
NetWare
Novell Client for Windows NT/2000/XP

• Windows Server 2003
TCP/IP
IPX/SPX

• Windows XP
TCP/IP
IPX/SPX
Novell Client for Windows NT/2000/XP

• Windows NT 4.0
TCP/IP
IPX/SPX
Client Service for NetWare
NetWare Client32 for Windows NT
IntraNetWare Client for Windows NT
Novell Client for Windows NT/2000/XP

❖ Available operations
The following functions are available:

• Printer Information function

• Display the network settings and detailed information of the printer.

• Display the number of pages printed under each user code.

• Display the status of print jobs sent form computers.

• Change the printer network settings.

• Device Settings function



Monitoring and Configuring the Printer

178

• Lock some of the setting items on the control panel so that they cannot
be changed using the control panel.

• Select type of paper loaded in the paper trays.

• Energy Saver function

• Enable or disable the Energy Saver mode.

• System Status function

• Display the information such as when paper is depleted during printing
on a computer .

• Groups function

• Monitor multiple printers at the same time. When there are multiple print-
ers to manage, you can create groups and classify the printers to facili-
tate management.

• You can customize printer status according to groups, and send status
notification e-mail to a computer.

Installing SmartDeviceMonitor for Admin

Follow the procedure below to install SmartDeviceMonitor for Admin.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

❒ Auto Run may not work under certain operating system settings. In this
case, launch “Setup.exe” located on the CD-ROM root directory.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [SmartDeviceMonitor for Client/Admin] installation, and then click [Next].

E The software license agreement appears in the [License Agreement] dialog
box.

After reading through its contents, click [I accept the agreement] if you agree,
and then click [Next >].

F Follow the instructions on the screen.

A message appears when the installation is complete.

G Click [OK].
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❒ If you are required to restart the computer after installing SmartDeviceMon-
itor for Admin, restart the computer and continue the configuration.

❒ SmartDeviceMonitor for Admin supports the following languages: Czech,
Danish, German, English, Spanish, French, Italian, Hungarian, Dutch, Nor-
wegian, Polish, Portuguese, Finnish, Swedish, Chinese Simple and Chi-
nese Traditional.

Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configuration
using SmartDeviceMonitor for Admin.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)]. A list of printers using the selected protocol
appears.

❒ Select the protocol of the printer whose configuration you want to change.

C In the list, select a printer whose configuration you want to change.

D On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the user name and
password for the Web Image Monitor administrator appears.

To use the default account, enter “admin” as the user name, and leave the
password blank.

NIB Setup Tool starts when the network interface board is default. Follow the
instruction on the screen.

E Enter required setting items.

Configure settings using Web Image Monitor. For details, see p.172 “Using
Web Image Monitor”.

F Quit Web Image Monitor.

G Quit SmartDeviceMonitor for Admin.

Locking the Menus on the Printer's Control Panel

Follow the procedure below to lock the menus on the printer's control panel.

A Start SmartDeviceMonitor for Admin.
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B On the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)].

A list of printers using the selected protocol appears.

❒ Select the protocol of the printer whose configuration you want to change.

C Select a printer.

D On the [Tools] menu, point to [Device Settings], and then click [Lock Operation
Panel Menu].

A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.

E Enter the user name and password, and then click [OK].

To use the default account, enter “admin” as the user name, and leave the
password blank.

The [System] page of Web Image Monitor appears.

F Select [Level 1] or [Level 2] in the [Protect Printer Operation Panel] list.

G Click [Apply].

H Quit Web Image Monitor.

For details about setting items, see Help in the [General Settings] on [Config-
uration] page.

Changing the Paper Type

Follow the procedure below to change the paper type.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)].

A list of printers using the selected protocol appears.

❒ Select the protocol of the printer whose configuration you want to change.

C In the list, select a printer whose configuration you want to change.

D On the [Tools] menu, point to [Device Settings], and then click [Select Paper
Type].

A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.
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E Enter the user name and password, and then click [OK].

To use the default account, enter “admin” as the user name, and leave the
password blank.

The [Paper] page appears.

F Select a paper type in the [Paper Type] list for each tray.

G Click [Apply].

H Quit Web Image Monitor.

For details about setting items, see Help in the [General Settings] on [Config-
uration] page.

Managing User Information

Follow the procedure below to manage the user's information using SmartDe-
viceMonitor for Admin.

Prints jobs can be managed and functions restricted by user codes.

Starting User Management Tool

Follow the procedure below to start User Management Tool.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)].

A list of printers using the selected protocol appears.

❒ Select the protocol of the printer whose configuration you want to change.

C In the list, select a printer you want to manage.

D On the [Tools] menu, click [User Management Tool].

The dialog box for entering the user name and password appears.

E Enter the user name and password, and then click [OK].

The default user name is “admin”, and default password is left blank.

User Management Tool starts.

For details about User Management Tool, see SmartDeviceMonitor for Ad-
min Help.
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Displaying the Number of Sheets Printed

Follow the procedure below to display the number of sheets printed under each
user code.

A Start SmartDeviceMonitor for Admin.

B Click the [User Page Count] tab of User Management Tool.

The number of pages printed under each user code appears.

C Click [Finish] on the [File] menu to quit User Management Tool.

Exporting the information about the number of pages printed

Follow the procedure below to export the information of the number of pages
printed under each user code as a .csv file.

A Start SmartDeviceMonitor for Admin.

B Click the [User Page Count] tab of User Management Tool.

C On the [File] menu, click [Export User Statistics List].

D Specify the save location and file name, and then click [Save].

E Click [Finish] on the [File] menu to quit User Management Tool.

Resetting the number of pages printed to 0.

Follow the procedure below to reset the number of pages printed under each
user code to 0.

A Start SmartDeviceMonitor for Admin .

B Click the [User Page Count] tab of User Management Tool.

C Click the user whose information you want to reset.

D On the [Edit] menu, click [Reset User Counters].

E Select the check box of the items you want to reset, and then click [OK].

A confirmation message appears.

F Click [Yes].

The number of pages printed is reset to 0.

G On the [Edit] menu, click [Apply Settings].

Changes are applied to information on the [User Page Count] tab.

H Click [Finish] on the [File] menu to quit User Management Tool.
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Restricting Functions

Follow the procedure below to restrict use of individual functions.

A Start SmartDeviceMonitor for Admin.

B On the [Edit] menu of User Management Tool, click [Restrict Access To De-
vice].

C Select the check box of the functions you want to restrict.

D Click [OK].

A confirmation message appears.

E Click [Yes].

The settings are applied.

Setting Applicable Functions to New Users

Follow the procedure below to add new users and set functions applicable to
them.

A Start SmartDeviceMonitor for Admin.

B Click the [Access Control List:] tab of User Management Tool.

C On the [Edit] menu, click [Add New User].

D Enter the user code and user name.

E Select the check box of the functions applicable to the new user.

❒ If the check boxes are unavailable, there is no restriction to use that func-
tion. For details, see SmartDeviceMonitor for Admin Help.

F Click [OK].

The new user is added.

G On the [Edit] menu, click [Apply Settings].

The settings are applied.

H Click [Finish] on the [File] menu to quit User Management Tool.

For details about setting restrictions, see SmartDeviceMonitor for Admin
Help.
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Configuring the Energy Saver Mode

Follow the procedure below to configure Energy Saver mode.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)].

A list of printers using the selected protocol appears.

❒ Select the protocol of the printer whose configuration you want to change.

C Select the printer whose settings you want to make.

To make settings for all printers in the selected group, select no printer.

D On the [Group] menu, point to [Energy Save Mode], point to [Set Individually] to
make the settings for only the selected printer or point to [Set By Group]
to make the settings for all printers in the selected group, and then click
[On] or [Off].

E Quit SmartDeviceMonitor for Admin.

For details about the setting value for Energy Saver mode, see SmartDe-
viceMonitor for Admin Help.

Setting a Password

Follow the procedure below to set a password.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)].

A list of printers using the selected protocol appears.

C In the list, select a printer whose configuration you want to change.

D On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the
instructions on the screen.

E Enter the user name and password, and then click [OK].
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To use the default account, enter “admin” as the user name, and leave the
password blank.

Top Page of Web Image Monitor appears.

F Click [Configuration].

G Click [Device Settings].

H Click [Program/Change Administrator].

I Click [Change].

J On the [New Password], enter a password.

Enter the same password in [Confirm Password] .

K Click [OK].

L Quit Web Image Monitor.

M Quit SmartDeviceMonitor for Admin.

Checking the Printer Status

Follow the procedure below to check printer status.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)].

The status of printers is indicated by icons in the list.

❒ For details about status icons, see SmartDeviceMonitor for Admin Help.

C To obtain status details, click the printer in the list, and then click [Open]
on the [Device] menu.

The printer status appears in the dialog box.

D Quit SmartDeviceMonitor for Admin.

❒ For details about items in the dialog box, see SmartDeviceMonitor for Ad-
min Help.

Changing Names and Comments

Follow the procedure below to change the names and comments of the printer.

A Start SmartDeviceMonitor for Admin.
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B On the [Group] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP(SNMPv3)]. A list of printers using the selected protocol
appears.

❒ Select the protocol of the printer whose configuration you want to change.

C Select a printer in the list.

D On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the
instructions on the screen.

E Enter the user name and password, and then click [OK].

Top Page of Web Image Monitor appears.

To use the default account, enter “admin” as the user name, and leave the
password blank.

F Click [Configuration].

G Click [Device Settings].

H On the [System] page, enter the device name in the [Device Name] box and
a comment in the [Comment] box, and click [Apply].

• In the [Device Name] box, enter a device name on the machine using up to
31 characters.

• In the [Comment] box, enter a comment on the printer using up to 31 char-
acters.

I Click [OK].

J Quit Web Image Monitor.

K Quit SmartDeviceMonitor for Admin.
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Using SmartDeviceMonitor for Client

To view the status of printers using SmartDeviceMonitor for Client, configure
SmartDeviceMonitor for Client beforehand.

Monitoring Printers

Follow the procedure below to monitor the printer using SmartDeviceMonitor for
Client.

A Start SmartDeviceMonitor for Client.

The SmartDeviceMonitor for Client icon appears in the task tray.

B Right-click the SmartDeviceMonitor for Client icon, and check that the
printer appears on the pop-up menu.

C Click [Options...] on the pop-up menu if the printer does not appear on the
pop-up menu.

The [SmartDeviceMonitor for Client - Options] dialog box appears.

D Click the printer you want to monitor, and then select the [To Be Monitored]
check box in the [Monitoring Information Settings] area.

❒ To display the printer status in the task tray using the SmartDeviceMonitor
for Client icon, select the [Displayed on Task Bar] check box.

❒ For details about status icons, see SmartDeviceMonitor for Client Help.

E Click [OK].

The dialog box closes and the configured printer is monitored.

Checking the Printer Status

Follow the procedure below to check printer status using SmartDeviceMonitor
for Client.

A Start SmartDeviceMonitor for Client.

B For status details, right-click the SmartDeviceMonitor for Client icon,
and then click the printer.

The printer status appears in the dialog box.

❒ For details about items in the dialog box, see SmartDeviceMonitor for Cli-
ent Help.
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When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:

• The network printer can only receive one print job from SmartDeviceMonitor
for Client at a time. While the network printer is printing, another user cannot
access it until the job is finished. In this case, SmartDeviceMonitor for Client
tries to access the network printer until the retry interval expires.

• If SmartDeviceMonitor for Client cannot access the network printer and times
out, it will stop sending the print job. In this case, you should cancel the
paused status from the print queue window. SmartDeviceMonitor for Client
will resume access to the network printer. You can delete the print job from
the print queue window, but canceling a print job printed by the network printer
might cause the next job sent from another user to be incorrectly printed.

• If a print job sent from SmartDeviceMonitor for Client is interrupted and the
network printer cancels the job because something went wrong, send the print
job again.

• Print jobs sent from another computer do not appear in the print queue win-
dow, regardless of protocol.

• If various users send print jobs using SmartDeviceMonitor for Client to net-
work printers, the printing order might not be the same as that in which the
jobs were sent.

• An IP address cannot be used for the IPP port name because the IP address
is used for the SmartDeviceMonitor for Client port name.

• When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentification is issued, enter “https://(printer's ad-
dress)/”. Internet Explorer must be installed on your computer. Use the
highest version. Internet Explorer 6.0 or higher is recommended.

• If the [Security Alert] dialog box appears when accessing the printer using IPP
to create or configure an IPP port, or when printing, install the certificate. To
select the certificate store location when using Certificate Import Wizard, click
[Place all certificates in the following store], and then click [Local Computer] under
[Trusted Root Certification Authorities].
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Printer Status Notification by E-Mail

Whenever a paper tray becomes empty or paper is jammed, an e-mail alert is
issued to the registered addresses to notify the printer status.

For this notification, you can make the e-mail notification settings.

Notification timing and e-mail content can be set.

A Set [Notify by Email] under the [System] menu to [On] using the control pan-
el. .

The default is [On].

For details, see p.150 “System Menu”.

B Open a Web browser, and then enter “http: //(printer's address)/” in the
address bar.

Top Page of Web Image Monitor appears.

When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentification is issued , enter “https://(printer's ad-
dress)/”.

C Click [Login] on Top Page of Web Image Monitor.

The dialog box for entering the user name and password appears.

D Enter the user name and password, and then click [OK].

To use the default account, enter “admin” as user name, and leave the pass-
word blank.

E In the menu area, click [Configuration].

F Click [Device Settings], and then click [E-mail].

G Make the following settings:

• Items in the Reception column

• Items in the SMTP column

• Items in the POP before SMTP column

• Items in the POP3/IMAP4 column

• Items in the E-mail Reception Port column

• Items in the E-mail Notification column

H Click [Apply].
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Auto E-mail Notification

A In the menu area, click [Auto E-mail Notification].

The dialog box for making notification settings appears.

B Make the following settings:

• Notification Message

• Items in the Select Groups/Items to Notify column

• Items in the Select Groups/Items to Notify column
To make detailed settings for these items, click [Edit] next to [Details of E-
mail Notification Settings].

C Click [Apply].

D Quit Web Image Monitor.

On-demand E-mail Notification

A In the menu area, click [On-demand E-mail Notification].

The dialog box for making notification settings appears.

B Make the following settings:

• Notification Subject

• Items in the Access Restriction to Information column

• Items in the Receivable E-mail Address/Domain Name Settings column

C Click [Apply].

D Quit Web Image Monitor.
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Remote Maintenance by telnet

❒ Remote Maintenance should be password-protected so that access is al-
lowed to administrators only.

❒ The password is the same as the one of Web Image Monitor administrator.
When the password is changed using “mshell”, other passwords change also.

❒ Some commands cannot be used depending on your printer.

Using telnet

Follow the procedure below to use telnet.

❒ Only one user at a time can log on to perform remote maintenance.

A Use the IP address or the host name of the printer to start telnet.

% telnetIP_address

B Enter your user name and password.

To use default account, enter “admin” as user name, and leave the password
blank.

C Enter a command.

D Quit telnet.

msh> logout

The configuration message about saving the changes appears.

E Enter “yes” to save the changes, and then press the {# Enter} key.

If you do not want to save the changes, enter “no”, and then press the {# En-
ter} key. To make further changes, enter “return” at the command line, and
then press the {# Enter} key.

❒ If the message “Can not write NVRAM information” appears, the changes
are not saved. Repeat the procedure above.

❒ When the changes are saved, the network interface board is reset auto-
matically with that changes.

❒ When the network interface board resets, the print job in print process will
be printed. However, print jobs in queue will be canceled.
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access

Use the “access” command to view and configure access control. You can also
specify two or more access ranges.

❖ View settings

msh> access

❖ Configuration

msh> access  range “start-address end-address”

•  represents a target number between 1 and 5. (Up to five access ranges
can be registered and selected.)

Example: to specify accessible IP addresses between 192.168.0.10 and
192.168.0.20:

msh> access 1 range 192.168.0.10 192.168.0.20

❖ Access control initialization

msh> access flush

• Use the “flush” command to restore the default settings so that all access
ranges become “0.0.0.0”.

❒ The access range restricts computers from use of the printer by IP address.
If you do not need to restrict printing, make the setting “0.0.0.0”.

❒ Valid ranges must be from lower (start address) to higher (end address).

❒ Up to five access ranges can be specified. The entry is invalid if the target
number is omitted.

❒ You cannot access Web Image Monitor from a restricted IP address.

appletalk

Use the “appletalk” command to view and configure Appletalk parameters.

❖ View settings

msh> appletalk

• [2] means “active” and [0] means “inactive”.

• The default is [2].

❖ Changing PAP timeout configuration

msh> appletalk ptimeout value > 0

• Timeout value becomes effective.

msh> appletalk ptimeout value = 0



Monitoring and Configuring the Printer

193

• Timeout value becomes ineffective.

autonet

Use the “autonet” command to configure AutoNet parameters.

❖ View settings
The following command displays the current AutoNet settings:

msh> autonet

❖ Configuration
You can configure AutoNet settings.

msh> autonet {on|off}

• {on} means “active” and {off} means “inactive”.

❖ Current interface priority configuration display

msh> autonet priority

❖ Interface priority configuration

msh> autonet priority “interface_name”

• You can give interface's AutoNet parameter priority.

• Priority settings are available when multiple interfaces are installed.

• ip1394 can be specified only when the IEEE 1394 interface is installed.

• wlan can be specified only when the IEEE 802.11b interface is installed.

❒ If an interface is not selected, the current interface connection settings remain
in effect.

For details about AutoNet, refer to autonet parameters.

btconfig

Use the “btconfig” command to make Bluetooth settings.

❖ View settings
Bluetooth settings are displayed.

msh> btconfig

Interface name Interface configured

ether Ethernet interface

ip1394 IEEE 1394 interface

wlan IEEE 802.11b interface
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❖ Mode settings
You can set the Bluetooth operation mode to {private} or {public}.

msh> btconfig {private | public}

• The default is {public}.

devicename

Use the “devicename” command to display and change the printer name.

❖ View settings

msh> devicename

❖ Printer name configuration

msh> devicename name “string”

• Enter a printer name using up to 31 alphanumeric characters.

• Set single names for each printer.

❖ Printer name initialization

msh> devicename clear name

• Reset the printer name to its default.

dhcp

Use the “dhcp” command to configure DHCP settings.

❖ View settings
The following command displays the current DHCP settings.

msh> dhcp

❖ Configuration
You can configure DHCP.

msh> dhcp “interface_name” {on|off}

• Click {on} to enable dhcp. Click {off} to disable DHCP.

• If the DNS server address and domain name are obtained from DHCP, be
sure to click {on}.

• ip1394 can be specified only when the IEEE 1394 interface is installed.

• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured

ether Ethernet interface

ip1394 IEEE 1394 interface
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❖ Current interface priority configuration display

msh> dhcp priority

❖ Interface priority configuration

msh> dhcp priority “interface_name”

• You can select which interface has DHCP parameter priority.

• Priority settings are available when multiple interfaces are installed.

❖ DNS server address selection

msh> dhcp dnsaddr {dhcp | static}

• Specify whether to obtain the DNS server address from the DHCP server
or use the address set by a user.

• To obtain the DNS server address from the DHCP server, specify “dhcp”.
To use the address set by a user, specify “static”.

❖ Domain name selection

msh> dhcp domainname {dhcp | static}

• Specify whether to obtain the domain name from the DNS server or use the
domain name set by a user.

• To obtain the domain name from the DHCP server, specify “dhcp”. To use
the domain name set by a user, specify “static”.

For details about DHCP functions, see p.290 “Using DHCP”.

For details about setting the DNS server address, see p.196 “dns”.

For details about setting the domain name, see p.197 “domainname”.

diprint

The direct printing port enables direct printing from a network-connected com-
puter.

Use the “diprint” command to change direct printing port settings.

❖ View settings
The following command displays the current direct printing port settings:

msh> diprint
Example output:

port 9100
timeout=300(sec)
bidirect on

wlan IEEE 802.11b interface

Interface name Interface configured
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• The “Port” specifies the port number of the direct printing port.

• The “bidirect” setting indicates whether the direct printing port is bidirec-
tional or not.

❖ Setting timeout

msh> diprint timeout [30~65535]

• You can specify the timeout interval to use when the printer is expecting
data from the network.

• The default is 300 seconds.

❖ Setting bidirect

msh> diprint bidirect {on | off}

• You can specify whether the direct printing port is bidrectional or not.

dns

Use the “dns” command to configure or display DNS (Domain Name System)
settings.

❖ View settings
The following command displays current DNS settings:

msh> dns

❖ DNS server configuration
The following command enables or disables the DNS server address:

msh> dns “number” server “server address”
The following command displays a configuration using the IP address
192.168.15.16 on a DNS 1 server:

msh> dns 1 server 192.168.15.16

• You can register up to three DNS server numbers.

• You cannot use “255.255.255.255” as the DNS server address.

❖ Dynamic DNS function setting

msh> dns “interface_name” ddns {on|off}

• You can set the dynamic DNS function “active” or “inactive”.

• {on} means “active” and {off} means “inactive”.

• ip1394 can be specified only when the IEEE 1394 interface is installed.

• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured

ether Ethernet interface

ip1394 IEEE 1394 interface
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❖ Specifying the record overlap operation

msh> dns overlap {update|add}

• You can specify operations performed when records overlap.

• update
To delete old records and register new records.

• add
To add new records and store the old records.

• When CNAME overlaps, it is always changed, irrespective of settings.

❖ CNAME registration

msh> dns cname {on|off}

• You can specify whether to register CNAME.

• {on} means “active” and {off} means “inactive”.

• The CNAME registered is the default name beginning with rnp. CNAME
cannot be changed.

❖ A records registration

msh> dns arecord {dhcp|own}

• {dhcp}
You can specify the method of registering an A record when the dynamic
DNS function is enabled and DHCP is used.

• {own}
To register an A record using the printer as the DNS client.
The DNS server address and the domain name already designated are
used for the registration.

❖ Record updating interval settings

msh> dns interval “time”

• You can specify the interval after which records are updated when using
the dynamic DNS function.

• The updating interval is specified hourly. It can be entered between 1 and
255 hours.

• The default is 24 hours.

domainname

Use the “domainname” command to display or configure the domain name set-
tings.

wlan IEEE 802.11b interface

Interface name Interface configured
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You can configure the Ethernet interface, IEEE 1394 interface, or IEEE 802.11b
interface.

❖ View settings
The following command displays the current domain name:

msh> domainname

❖ Interface domain configuration

msh> domainname “interface_name”

❖ Setting the Domain Name

msh> domainname “interface_name” name “domain name”

• A domain name can be entered using up to 63 alphanumeric characters.

• The Ethernet interface and IEEE 802.11b interface will have the same do-
main name.

• ip1394 can be specified only when the IEEE 1394 interface is installed.

• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Deleting the Domain Name

msh> domainname “interface_name” clear name

help

Use the “help” command to display the available command list and the proce-
dures for using those commands.

❖ Command list display

msh> help

❖ Display of procedure for using commands

msh> help “command_name”

hostname

Use the “hostname” command to change the printer name.

❖ View settings

msh> hostname

Interface Interface set

ether Ethernet interface

ip1394 IEEE 1394 interface

wlan IEEE 802.11b interface



Monitoring and Configuring the Printer

199

❖ Configuration

msh> hostname “interface_name” “printer_name”

• Enter the printer name using up to 63 alphanumeric characters.

• You cannot use a printer name starting with “RNP” or “rnp”.

• The Ethernet interface and IEEE 802.11b interface will have the same
printer name.

• ip1394 can be specified only when the IEEE 1394 interface is installed.

• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Initializing the printer name for each interface

msh>hostname interface_name clear name

ifconfig

Use the “ifconfig” command to configure TCP/IP (IP address, subnet mask,
broadcast address, default gateway address) for the printer.

❖ View settings

msh> ifconfig

❖ Configuration

msh> ifconfig “interface_name” “parameter” “address”

• If you did not enter an interface name, it is automatically set to the Ethernet
interface.

• ip1394 can be specified only when the IEEE 1394 interface is installed.

• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Netmask configuration

msh> ifconfig “interface_name” netmask “address”

❖ Broadcast address configuration

msh> ifconfig “interface_name” broadcast “address”

Interface name Interface configured

ether Ethernet interface

ip1394 IEEE 1394 interface

wlan IEEE 802.11b interface

Interface name Interface configured

ether Ethernet Interface

ip1394 IEEE 1394 Interface

wlan IEEE 802.11b Interface
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❖ Changing the Interface

msh> ifconfig “interface” up

• You can specify either the Ethernet interface or IEEE 802.11b interface
when using the optional IEEE 802.11b interface unit.
You cannot specify the IEEE 1394 interface.

The following explains how to configure an IP address 192.168.15.16 on
Ethernet interface.

msh> ifconfig ether 192.168.15.16
The following explains how to configure a subnet mask 255.255.255.0 on
Ethernet interface.

msh> ifconfig ether netmask 255.255.255.0

❒ To get the above addresses, contact your network administrator.

❒ Use the default configuration if you cannot obtain setting addresses.

❒ The IP address, subnet mask and broadcast address are the same as that for
the ethernet interface and IEEE 802.11b interface.

❒ When installing the optional 1394 Interface board, set the IP address and sub-
net mask so that it does not overlap with the ethernet interface or the IEEE
1394 interface.

❒ TCP/IP configuration is the same for both Ethernet and IEEE 802.11b inter-
face. If interfaces are changed, the new interface inherits the configuration.

❒ Use “0x” as the initial two letters of a hexadecimal address.

info

Use the “info” command to display printer information such as paper tray, output
tray, and printer language.

❖ Printer information display

msh> info

For details about displayed contents, see p.220 “Getting Printer Information
over the Network”.

ipp

Use the “ipp” command to configure IPP settings.

❖ Viewing settings
The following command displays the current IPP settings:

msh> ipp
Example output:
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timeout=900(sec)
auth basic

• The “timeout” setting specifies how many seconds the computer tries to
send print jobs when no connection can be made to the network printer.

• The “auth” setting indicates the user authorization mode.

❖ IPP timeout configuration
Specify how many seconds the computer waits before canceling an interrupt-
ed print job. The time can be entered between 30 to 65535 seconds.

msh> ipp timeout [30 - 65535]

❖ IPP user authorization configuration
Use IPP user authorization to restrict users to print with IPP. The default is
“off”.

msh> ipp auth {basic|digest|off}

• User authorization settings are “basic” and “digest”.

• Use “off” to remove a user's authorization.

• If user authorization is specified, register a user name. You can register up
to 10 users.

❖ IPP user configuration
Use the following command:

msh> ipp user
The following message appears:

msh> Input user number (1 to 10):
Enter the number, user name, and password.

msh> IPP user name:user1
msh> IPP password:*******
After configuring the settings, the following message appears:

User configuration changed.

netware

Use the “netware” command to configure the NetWare settings such as the print
server name or file server name.

❖ Netware Printer Server Names

msh> netware pname

• Enter the NetWare print server name using up to 47 characters.

❖ Netware File Server Names

msh> netware fname

• Enter the NetWare file server name using up to 47 characters.
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❖ Encap type

msh> netware encap [802.3/802.2/snap/ethernet2/auto]

❖ Remote Printer Number

msh> netware rnum

❖ Timeout

msh> netware timeout

❖ Printer server mode

msh> netware mode pserver
msh> netware mode ps

❖ Remote printer mode

msh> netware mode rprinter
msh> netware mode rp

❖ NDS context name

msh> netware context

❖ SAP interval

msh> netware “sap_interval”

❖ Setting login mode for file server

msh> netware login server

❖ Setting login mode for NDS tree

msh> netware login tree

❖ Setting login mode for NDS tree name

msh> netware tree “NDS name”

passwd

Use the “passwd” command to change the remote maintenance password.

❖ Changing the Password

msh> passwd

• Enter the current password.

• Enter the new password.

• Enter the new password once again.

❒ Be sure not to forget or lose the password.
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❒ The password can be entered using up to 32 alphanumeric characters. Pass-
words are case-sensitive. For example, “R” is not the same as “r”.

prnlog

Use the “prnlog” command to obtain printer log information.

❖ Print logs display

msh> prnlog

• Displays 16 previous print jobs.

msh> prnlog ID Number

• Specify the ID number of the displayed print log information to display ad-
ditional details about a print job.

❒ For details about displayed contents, see p.220 “Getting Printer Information
over the Network”.

rendezvous

Use the “rendezvous” command to display rendezvous-related settings.

❖ View settings
Rendezvous settings are displayed.

msh> rendezvous

❖ Current computer name display

msh> rendezvous cname

❖ Display information about the current printer location

msh> rendezvous location

❖ Rendezvous computer name setting
You can specify the rendezvous computer name.

msh> rendezvous cname “computer name”

• The computer name can be entered using up to 63 alphanumeric charac-
ters.

❖ rendezvous Installation location information setting
You can enter information about the location where the printer is installed.

msh> rendezvous location “location”

• Information about location can be entered using up to 32 alphanumeric
characters.
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❖ Setting order of priority for each protocol

• diprint

msh> rendezvous diprint [0-99]

• lpr

msh> rendezvous lpr [0-99]

• ipp

msh> rendezvous ipp [0-99]
You can specify the order of priority for “diprint”, “lpr”, and “ipp”. Smaller num-
bers indicate higher priority.

❖ IP TTL setting

msh> rendezvous ipttl {1-255}
You can specify the IP TTL (the number of routers a packet can pass
through).

❒ The default is 255.

❖ Resetting the computer name and location information
You can reset the computer name and location information.

msh> rendezvous clear {cname | location}

• cname
Reset the computer name. The default computer name will be displayed
when the computer is restarted.

• location
Reset the location information. The previous location information will be
deleted.

❖ Interface configuration

msh> rendezvous linklocal “interface_name”

• If many types of interface are installed, configure the interface that commu-
nicates with linklocal address.
If you do not specify an interface, the Ethernet interface is automatically se-
lected.

• ip1394 can be specified only when the IEEE 1394 interface is installed.

• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface Interface configured

ether Ethernet interface

ip1394 IEEE 1394 interface

wlan IEEE 802.11b interface
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route

Use the “route” command to control the routing table.

❖ All route information display

msh> route

❖ Specified route information display

msh> route “destination”

• Specify the IP address to destination.

❖ Enabling/disabling Specified Destination

msh> route active {host|net} “destination” {on | off}

• You can turn the specified destination on or off. Host becomes the default
setting.

❖ Adding Routing Table

msh> route add {host|net} “destination” “gateway”

• Adds a host or network route to “destination”, and a gateway address to
“gateway” in the table.

• Specify the IP address to destination and gateway.

• Host becomes the default setting.

❖ Setting Default Gateway

msh> route add default gateway

❖ Deleting Specified destination from Routing Table

msh> route delete {host|net} “destination”

• Host becomes the default setting.

• IP address of destination can be specified.

❖ Route Flush

msh> route flush

❒ The maximum number of routing tables is 16.

❒ Set a gateway address when communicating with devices on an external net-
work.

❒ The same gateway address is shared by all interfaces.
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set

Use the “set” command to set the protocol information display “active” or “inac-
tive”.

❖ View settings
The following command displays protocol information (active/inactive).

msh> set tcpip

msh> set appletalk

msh> set netware

msh> set smb

msh> set scsiprint

• scsiprint is available when the optional IEEE 1394 interface board is in-
stalled.

msh> set ip1394

• ip1394 can be specified only when the IEEE 1394 interface is installed.

msh> set protocol

• When protocol is specified, information about TCP/IP, appletalk, netware,
and smb appears.

msh> set lpr

msh> set ftp

msh> set rsh

msh> set diprint

msh> set web

msh> set snmp

msh> set ssl

msh> set nrs

msh> set rfu

msh> set ipp

msh> set http

msh> set rendezvous

❖ Configuration

• Enter “up”to enable protocol, and enter “down” to disable protocol.
You can set the protocol to “active” or “inactive”.

msh> set tcpip {up | down}

• If you disable TCP/IP, you cannot use remote access after logging off. If
you did this by mistake, you can use the control panel to enable remote ac-
cess via TCP/IP.
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• Disabling TCP/IP also disables ip1394, lpr, ftp, rsh, diprint, web, snmp, ssl,
ipp, http, and rendezvous

msh> set appletalk {up | down}

msh> set netware {up | down}

msh> set smb {up | down}

msh> set scsiprint {up | down}

• scsiprint is available when the optional IEEE 1394 interface board is in-
stalled.

msh> set ip1394 {up | down}

• ip1394 can be specified only when the IEEE 1394 interface is installed.

msh> set lpr {up | down}

msh> set ftp {up | down}

msh> set rsh {up | down}

msh> set diprint {up | down}

msh> set web {up | down}

msh> set snmp {up | down}

msh> set ssl {up | down}

• If Secured Sockets Layer (SSL, an encryption protocol) function is not
available for the printer, you cannot use the function by enabling it.

msh> set nrs {up | down}

msh> set rfu {up | down}

msh> set ipp {up | down}

msh> set http {up | down}

msh> set rendezvous {up | down}

show

Use the “show” command to display network interface board configuration set-
tings.

❖ View settings

msh> show

• If “-p” is added, you can view settings one by one.

For details about the information displayed, see p.229 “Configuring the Net-
work Interface Board”.
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slp

Use “slp” command to configure SLP settings.

msh> slp ttl “ttl_val”

• You can search the NetWare server using SLP in the PureIP environment of
NetWare 5/5.1 and Netware 6/6.5. Using the “slp” command, you can config-
ure the value of TTL which can be used by SLP multicast packet.

• The default value of TTL is 1. A search is executed only within a local seg-
ment. If the router does not support multicast, the settings are not available
even if the TTL value is increased.

• The acceptable TTL value is between 1 and 255.

smb

Use the “smb” command to configure or delete the computer or workgroup name
for SMB.

❖ Computer Name settings

msh> smb comp

• Set computer name using up to 15 characters. Names beginning with
“RNP” or “rnp” cannot be entered.

❖ Working Group Name settings

msh> smb group

• Set workgroup name using up to 15 characters

❖ Comment settings

msh> smb comment

• Set comment using up to 31 characters

❖ Notify print job completion

msh> smb notif {on | off}

• To notify print job completion, specify “on”. Otherwise, specify “off”

❖ Deleting Computer Name

msh> smb clear comp

❖ Deleting Group Name

msh> smb clear group

❖ Deleting Comment

msh> smb clear comment
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❖ Protocol settings

msh> smb protocol [netbeui {up | down} | tcpip {up | down}]

• Enable or disable NetBEUI and TCP/IP. Specify “up” to enable, and “down”
to disable.

snmp

Use the “snmp” command to display and edit SNMP configuration settings such
as the community name.

❖ View settings

msh> snmp

• Default access settings 1 is as follows:
Community name:public
IP address:0.0.0.0
Access type:read-only / trap off

• Default access settings 2 is as follows:
Community name:admin
IP address:0.0.0.0
Access type:read-write / trap off

• If “-p” is added, you can view settings one by one.

• To display the current community, specify its registration number.

❖ Display

msh> snmp ?

❖ Community name configuration

msh> snmp “number” name “community_name”

• You can configure ten SNMP access settings numbered 1-10.

• The printer cannot be accessed from SmartDeviceMonitor for Admin or
SmartDeviceMonitor for Client if “public” is not registered in numbers 1-10.
When changing the community name, use SmartDeviceMonitor for Admin
and SNMP Setup Tool to correspond with printer settings.

• The community name can be entered using up to 15 characters.

❖ Deleting community name

msh> snmp “number” clear name

❖ Access type configuration

msh> snmp “number” type “access_type”

Access type Type of access permission

no not accessible
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❖ Protocol configuration

msh> snmp {ip | ipx} {on | off}

• Use the following command to set protocols “active” or “inactive”: If you set
a protocol “inactive”, all access settings for that protocol are disabled.

• Specify “ip” for TCP/IP, or “ipx” for IPX/SPX.

• {on} means “active” and {off} means “inactive”.

• IEEE 1394 interface is available for TCP/IP only.

❖ Configuration of protocol for each registration number

msh> snmp “number” active {ip | ipx} {on | off}

• To change the protocol of access settings, use the following command.
However, if you have disabled a protocol with the above command, activat-
ing it here has no effect.

❖ Access configuration

msh> snmp “number” {ip/addr | ipx} “address”

• You can configure a host address according to the protocol used.

• The network interface board accepts requests only from hosts that have
addresses with access types of “read-only” or “read-write”. Enter “0” to
have network interface board accept requests from any host without requir-
ing a specific type of access.

• Enter a host address to deliver “trap” access type information to.

• To specify TCP/IP, enter “ip” followed by a space, and then the IP address.

• To specify IPX/SPX, enter “ipx” followed by a space, the IPX address fol-
lowed by a decimal, and then the MAC address of the network interface
board.

❖ sysLocation configuration

msh> snmp location

❖ Deleting sysLocation

msh> snmp clear location

❖ sysContact setting

msh> snmp contact

read read only

write read and write

trap user is notified of trap messages

Access type Type of access permission



Monitoring and Configuring the Printer

211

❖ Deleting sysContact

msh> snmp clear contact

❖ SNMP v1v2 function configuration

msh> snmp v1v2 {on | off}

• Specify “on” to enable, and “off” to disable.

❖ SNMP v3 function configuration

msh> snmp v3 {on | off}

• Specify “on” to enable, and “off” to disable.

❖ SNMP TRAP configuration

msh> snmp trap {v1 | v2 | v3} {on | off}

• Specify “on” to enable, and “off” to disable.

❖ Remote Configuration Authorization configuration

msh> snmp remote {on | off}

• Specify “on” to enable, and “off” to disable.

❖ SNMP v3 TRAP configuration display

msh> snmp v3trap

msh> snmp v3trap {1- 5}

• If a number from 1-5 is entered, settings are displayed for that number only.

❖ Configuring a sending address for SNMP v3 TRAP

msh> snmp v3trap {1-5} {ip| ipx} address

❖ Configuring a sending protocol for SNMP v3 TRAP

msh> snmp v3trap {1-5} active {ip/addr | ipx} {on | off}

❖ Configuring a user account for SNMP v3 TRAP

msh> snmp v3trap {1-5} account account_name

• Enter an account name using up to 32 alphanumeric characters.

❖ Deleting an SNMP v3 TRAP user account

msh> snmp v3trap {1-5} clear account

❖ Configuring an SNMP v3 encryption algorithm

msh> snmp v3auth {md5 | sha1}

❖ Configuring SNMP v3 encryption

msh> snmp v3priv {auto | on}
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• If you select “auto”, the print job will be encrypted when encryption is pos-
sible.

• If you select “on”, Clear Text communication is not possible, and encryption
password must be set before encryption communication can be used.

❒ Encryption is possible when the security option is installed correctly and
the password is specified.

sntp

The printer clock can be synchronized with a NTP server clock using Simple Net-
work Time Protocol (SNTP). Use the “sntp” command to change SNTP settings.

❖ View settings

msh> sntp

❖ NTP server address configuration
You can specify the IP address of the NTP server.

msh> sntp server “IP_address”

❖ Interval configuration

msh> sntp interval “polling_time”

• You can specify the interval at which the printer synchronizes with the op-
erator-specified NTP server. The default is 60 minutes.

• The interval can be entered between 16 and 16,384 minutes.

• If you set 0, the printer synchronizes with the NTP server only when you
turn the printer on. After that, the printer does not synchronize with the NTP
server.

❖ Time-zone configuration

msh> sntp timezone “+/-hour_time”

• You can specify the time difference between the printer clock and NTP
server clock. Time is in 24-hour format.

spoolsw

Use the “spoolsw” command to configure Job Spool settings.

You can only specify diprint, lpr, ipp, ftp and smb protocol.

• The “spoolsw” command for configuring Job Spool settings is available only
when the optional hard disk is installed.

❖ View settings
The Job Spool setting appears.
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msh> spoolsw

❖ Job Spool setting

msh> spoolsw spool {on | off}

❒ Specify “on” to enable Job Spool, or “off” to disable it.

❖ Resetting Job spool setting

msh> spoolsw clear job {on | off}

• When the printer power is cut during job spooling, this determines whether
to reprint the spooled job.

❖ Protocol configuration

msh> spoolsw diprint {on | off}
msh> spoolsw lpr {on | off}
msh> spoolsw ipp {on | off}
msh> spoolsw smb {on | off}
msh> spoolsw ftp {on | off}

• You can specify the settings for diprint, lpr, ipp, and smb.

sprint

Use the “sprint” command to make settings for IEEE 1394 (SCSI print).

❖ View settings
IEEE 1394 (SCSI print) settings are displayed.

msh> sprint

❖ Bidirectional configuration for IEEE 1394 (SCSI print)
Use this setting to set IEEE 1394 (SCSI print) bidirectional.
The default is “on”.

msh> sprint bidi {on | off}

status

The printer status can be checked using the following command:

❖ Messages

msh> status

For details, see p.220 “Current Printer Status”.
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syslog

Use the “syslog” command to display the information stored in the printer's sys-
tem log.

❖ View message

msh> syslog

❒ For details about the information displayed, see p.235 “System Log Informa-
tion”.

upnp

Use the “upnp” command to display and configure the universal plug and play.

❖ Public URL display

msh> upnp url

❖ Public URL configuration

msh> upnp url “string”

• Enter the URL string in the character string.

web

Use the “web” command to display and configure parameters on Web Image
Monitor.

❖ View Settings

msh> web

❖ URL Configuration
You can set URLs linked by clicking [URL] on Web Image Monitor.
Specify “1” or “2” for x as the number corresponding to the URL. Up to two
URLs can be registered and specified.

msh> web url http://”The URL or IP address you want to
register”/

❖ Deleting URLs registered as link destinations

msh> web x clear url
Specify “1” or “2” for x as the corresponding number to the URL.

❖ Link name configuration
You can enter the name for [URL] that appears on Web Image Monitor.
Specify “1” or “2” for x as the corresponding number to the link name.
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msh> web name “Name you want to display”

❖ Deleting URL names registered as link destinations

msh> web x clear name
Specify “1” or “2” for x as the number corresponding to the link name.

❖ Help URL Configuration
You can set URLs linked by clicking [Help] or [?] on Web Image Monitor.

msh> web help http://”Help URL or IP address”/help/

❖ Deleting Help URL

msh> web clear help

wiconfig

Use the “wiconfig” command to make settings for IEEE 802.11b.

❖ View settings

msh> wiconfig

❖ View IEEE 802.11b settings

msh> wiconfig cardinfo

• If IEEE 802.11b is not working correctly, its information is not displayed.

❖ Configuration

msh> wiconfig “parameter”

Parameter Value configured

mode [ap|adhoc|802.11adhoc] You can set the infrastructure mode (ap) , the 

802.11 Ad hoc mode (802.11adhoc), or the 

ad hoc mode (adhoc).

The default is ad hoc mode.

ssid ID value You can make settings for the SSID in the in-

frastructure mode.

Usable characters are ASCII 0x20-0x7e (32 

bytes).

An SSID value is set automatically to the 

nearest access point if no setting is made.

If no setting is made for the ad hoc mode, the 

same value as for the infrastructure mode or 

an ASSID value is automatically set.
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channel frequency channel no. You can enable or disable the WEP function. 

To enable the WEP function, specify [on]; to 

disable it, specify [off].

To start the WEP function, enter the correct 

WEP key.

enc [on|off] You can enable or disable the WEP function. 

To enable the WEP function, specify [on]; to 

disable it, specify [off].

To start the WEP function, enter the correct 

WEP key.

key [ key value ] val [1|2|3|4] You can specify the WEP key when entering 

in hexadecimal.

With a 64-bit WEP, you can use 10 digit 

hexadecimals. With a 128-bit WEP, you can 

use 26 digit hexadecimals.

Up to four WEP keys can be registered. 

Specify the number to be registered with 

“val”.

When a WEP is specified by key, the WEP 

specified by key phrase is overwritten.

To use this function, set the same key num-

ber and WEP key for all ports that transmit 

data to each other.

You can omit the numbers with “val”. The key 

number is set to 1 when making these omis-

sions.

keyphrase [ phrase ] val [1|2|3|4] You can specify the WEP key when entering 

in ASCII.

With a 64-bit WEP, you can use 10 digit 

hexadecimals. With a 128-bit WEP, you can 

use 26 digit hexadecimals.

Up to four WEP keys can be registered. 

Specify the number to be registered with 

“val”.

When a WEP is specified by key phrase, the 

WEP specified by key is overwritten.

To use this function, set the same key num-

ber and WEP key for all ports that transmit 

data to each other.

You can omit the numbers with “val”. The key 

number is set to 1 when making these omis-

sions.

encval [1|2|3|4] You can specify which of the four WEP keys 

is used for packet encoding. “1” is set if a 

number is not specified.

Parameter Value configured
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wins

Use the “wins” command to configure WINS server settings.

❖ Viewing settings

msh> wins

• If the IP address obtained from DHCP differs from the WINS IP address,
the DHCP address is the valid address.

❖ Configuration

msh> wins “interface_name” {on | off}

• {on} means “active” and {off} means “inactive”.

• Be sure to specify the interface.

• ip1394 can be specified only when the IEEE 1394 interface is installed.

• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Address configuration
Use the following command to configure a WINS server IP address:

msh> wins “interface_name” {primary|secondary} “IP ad-
dress”

auth [open|shared] You can set an authorization mode when us-

ing WEP. The specified value and authorized 

mode are as follows:

open: open system authorized (default)

shared: shared key authorized rate

rate [auto|11m|5.5m|2m|1m] You can set the IEEE 802.11b transmitting 

speed.

The speed you specify here is the speed at 

which data is sent. You can receive data at 

any speed.

auto: automatically set (default)

11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m: 2 Mbps fixed

1m: 1 Mbps fixed

Interface name Interface configured

ether Ethernet interface

ip1394 IEEE 1394 interface

wlan IEEE 802.11b interface

Parameter Value configured
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• Use the “primary” command to configure a primary WINS server IP ad-
dress.

• Use the “secondary” command to configure a secondary WINS server IP
address.

• Do not use “255.255.255.255” as the IP address.

❖ NBT (NetBIOS over TCP/IP) Scope ID Selection
You can specify the NBT scope ID.

msh> wins “interface_name” scope “scope ID”

• The scope ID can be entered using up to 31 alphanumeric characters.

• Be sure to specify the interface.

• ip1394 can be specified only when the IEEE 1394 interface is installed.

• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured

ether Ethernet interface

ip1394 IEEE 1394 interface

wlan IEEE 802.11b interface
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SNMP

The SNMP agent operating on UDP and IPX is incorporated into the built-in
Ethernet board and optional IEEE 802.11b interface unit of this printer. Also, the
SNMP agent operating on UDP is incorporated in the optional IEEE 1394 inter-
face board.

Using the SNMP manager, you can get information about the printer.

❒ If you changed the printer's community name, change the configuration of the
connected computer accordingly, using SNMP Setup Tool. For details, see
SNMP Setup Tool Help.

The default community names are [public] and [admin]. You can get MIB informa-
tion using these community names.

❖ Start SNMP Setup Tool

• Windows 95/98/Me, Windows 2000, Windows NT 4.0:
Click the [Start] button.
Point to [SmartDeviceMonitor for Admin] on the [Programs] menu.
Click [SNMP Setup Tool].

• Windows XP:
Click the [Start] button.
Point to [SmartDeviceMonitor for Admin] on the [All Programs] menu.
Click [SNMP Setup Tool].

❖ Supported MIBs(SNMPv1/v2)

• MIB-II

• PrinterMIB

• HostResourceMIB

• RicohPrivateMIB

❖ Supported MIBs(SNMPv3)

• MIB-II

• PrinterMIB

• HostResourceMIB

• RicohPrivateMIB

• SNMP-FRAMEWORK-MIB

• SNMP-TARGET-MIB

• SNMP-NOTIFICATION-MIB

• SNMP-USER-BASED-SM-MIB

• SNMP-VIEW-BASED-ACM-MIB
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Getting Printer Information over the 
Network

This section explains details of each item displayed in the printer status and in-
formation.

Current Printer Status

The printer status can be checked using the following commands:

• UNIX: Use the “lpq” command and “rsh”, “rcp”, and “ftp” parameters.

• mshell: Use the “status” command.

Messages Description

Access Restricted The job was canceled because user have no 

authority.

Add staples (Booklet: Back) The staple of booklet finisher (back) is ex-

hausted.

Add staples (Booklet: Both) The staple of booklet finisher is exhausted.

Add staples (Booklet: Front) The staple of booklet finisher (front) is exhaust-

ed.

Adjusting... The machine is initializing or calibrating.

Call Service Center There is a malfunction in the machine.

Canceled The job is reset.

Canceling Job... The job is being reset.

Card/Counter not inserted The machine is waiting for prepaid card or key.

Coin or amount not inserted The machine is waiting for coin to be inserted.

Coin/Key Counter not inserted The machine is waiting for coin or key counter.

Configuring... Setting is being changed.

Cover Open: ADF The document feeder is open.

Cover Open: Duplex Unit The cover of the duplex unit is open.

Cover Open: Finisher The cover of Finisher is open.

Cover Open: Front The front cover is open.

Cover Open: Front/Left The front cover or left cover is open.

Cover Open: Paper Exit / Rear The paper exit cover or rear cover is open.

Cover Open: Right The right cover is open.

Cover Open: Top The top cover is open.

Data Size Error The data size error occurred.
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Empty: Black Toner The black toner cartridge is almost empty.

Empty: Cyan Toner The cyan toner cartridge is almost empty.

Empty: Magenta Toner The magenta toner cartridge is almost empty.

Empty: Yellow Toner The yellow toner cartridge is almost empty.

Energy Saver Mode The machine is in Energy Saver Mode.

Error An error has occurred.

Error at Printer: Red LED An error has occurred.

Error in Printer An error has occurred.

Error: Address Book An error has occurred in the data of the ad-

dress book.

Error: Command Transmission An error has occurred in the machine.

Error: DIMM Value A memory error occurred.

Error: Ethernet Board An Ethernet board error has occurred.

Error: HDD Board A hard disk drive board error has occurred.

Error: IEEE1394 Board An IEEE 1394 interface board error has oc-

curred.

Error: Memory Switch A memory switch error has occurred.

Error: Optional Font An error has occurred in the font file of the ma-

chine.

Error: Optional RAM An error has occurred in the optional memory 

unit.

Error: Parallel I/F Board An error has occurred in the parallel interface.

Error: PDL An error has occurred in the page description 

language.

Error: USB Interface An error has occurred in the USB interface.

Error: Wireless Card Wireless card is not inserted during start up, or 

the IEEE 802.11b interface unit or the wireless 

card is taken out after start up.

Error: Wireless Card or Board An error has occurred in the IEEE 802.11b in-

terface unit.

Exceed Booklet Stapling Limit The printing has exceeded the stapling limit of 

the booklet finisher.

Full: Copy Tray The output paper tray is full.

Full: Finisher Finisher tray is full.

Full: Finisher Shift Tray Shift tray of Finisher is full.

Full: Finisher Shift Tray 1, 2 The shift tray 1 and 2 of Finisher are full.

Full: Finisher Upper Tray The upper tray of Finisher is full.

Messages Description
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Full: Hole Punch Receptacle Punch Chip receptacle for hole punch is full.

Full: Standard Tray The output paper tray is full.

Full: Waste Toner Waste toner is full.

Full: Waste Toner Bottle Waste toner bottle is full.

Hex Dump Mode It is a hex dump mode.

Immed. Trans. not connected It did not connect directly with the other party 

of the transmission.

Immediate Transmission Failed An error has occurred while transmitting direct-

ly.

In Use: Copier The copier is being used.

In Use: Fax The fax is being used.

In Use: Finisher Other functions is using Finisher.

In Use: Input Tray Other functions is using the input tray.

In Use: Staple Unit Other functions is using the staple unit.

Independent-supplier Toner Toner that is not recommended is set.

Key Card not inserted The machine is waiting for key card to be in-

serted.

Key Card/Counter not inserted The machine is waiting for key card or key 

counter to be inserted.

Key Counter not inserted The machine is waiting for key counter to be 

left in it.

Loading Toner... Toner is being supplied.

Low: Black Toner The black toner cartridge is not set correctly, or 

toner is almost running out.

Low: Cyan Toner The cyan toner cartridge is not set correctly, or 

toner is almost running out.

Low: Magenta Toner The magenta toner cartridge is not set correct-

ly, or toner is almost running out.

Low: Toner The black toner cartridge is not set correctly, or 

toner is almost running out.

Low: Yellow Toner The yellow toner cartridge is not set correctly, 

or toner is almost running out.

Malfunction: Booklet Processor There is a problem with booklet finisher.

Malfunction: Ext. Charge Unit There is a problem with external charge unit.

Malfunction: Finisher There is a problem with Finisher.

Malfunction: Interposer There is a problem with Interposer.

Malfunction: LargeCapacity Tray There is a problem with LargeCapacity tray.

Malfunction: Output Tray There is a problem with output tray.
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Malfunction: Staple Unit There is a problem with the staple unit.

Malfunction: Tray 1 There is a problem with tray 1.

Malfunction: Tray 2 There is a problem with tray 2.

Malfunction: Tray 3 There is a problem with tray 3.

Malfunction: Tray 4 There is a problem with tray 4.

Malfunction: Z-folding unit There is a problem with the Z fold unit.

Memory Low: Copy Memory shortage has occurred while the copy 

was operating.

Memory Low: Data Storage Memory shortage has occurred while the doc-

ument was being accumulated.

Memory Low: Fax Scanning Memory shortage has occurred while transmit-

ting the fax.

Memory Low: Scanning Memory shortage has occurred while the 

scanner was working.

Miscellaneous Error Other error has occurred.

Mismatch: Paper Size Indicated paper tray does not contain paper of 

selected size.

Mismatch: Paper Size and Type Indicated paper tray does not contain paper of 

selected size and type.

Mismatch: Paper Type Indicated paper tray does not contain paper of 

selected type.

Near Replacing: Black PCU Prepare the new black photoconductor unit.

Near Replacing: Color PCU Prepare the new color photoconductor unit.

Near Replacing: Develop. Unit C Prepare the new development unit (cyan).

Near Replacing: Develop. Unit K Prepare the new development unit (black).

Near Replacing: Develop. Unit M Prepare the new development unit (magenta).

Near Replacing: Develop. Unit Y Prepare the new development unit (yellow).

Near Replacing: Fusing Unit Prepare the new fusing unit.

Near Replacing: Maintenance Kit Prepare the new maintenance kit.

Near Replacing: Transfer Unit Prepare the new transfer unit.

Nearly Full: Waste Toner Waste toner bottle is nearly full.

Need more Staples Stapler has almost run out of staples.

No Paper: Interposer Tray There is no paper in interposer unit.

No Paper: LCT There is no paper in Large Capacity tray.

No Paper: Selected Tray There is no paper in specified tray.

No Paper: Tray 1 There is no paper in tray 1.

No Paper: Tray 2 There is no paper in tray 2.
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No Paper: Tray 3 There is no paper in tray 3.

No Paper: Tray 4 There is no paper in tray 4.

Not Detected: B2 Lever B2 lever is not correctly set.

Not Detected: Black Toner Black toner is not correctly set.

Not Detected: Cyan Toner Cyan toner is not correctly set.

Not Detected: Develop. Unit (C) The development unit (cyan) is not correctly 

set.

Not Detected: Develop. Unit (K) The development unit (black) is not correctly 

set.

Not Detected: Develop. Unit (M) The development unit (magenta) is not cor-

rectly set.

Not Detected: Develop. Unit (Y) The development unit (yellow) is not correctly 

set.

Not Detected: Duplex Feed Unit The duplex feed unit is not correctly set.

Not Detected: Finisher Finisher is not correctly set.

Not Detected: Fusing Unit The fusing unit is not correctly set.

Not Detected: Input Tray The paper feed tray is not correctly set.

Not Detected: Interposer Interposer unit is not correctly set.

Not Detected: LCT A large amount of paper feed tray is not cor-

rectly set.

Not Detected: Magenta Toner Magenta toner is not correctly set.

Not Detected: PCU (C) The photoconductor unit (cyan) is not correctly 

set.

Not Detected: PCU (K) The photoconductor unit (black) is not correct-

ly set.

Not Detected: PCU (M) The photoconductor unit (magenta) is not cor-

rectly set.

Not Detected: PCU (Y) The photoconductor unit (yellow) is not cor-

rectly set.

Not Detected: Toner Magazine The toner cartridge is not correctly set.

Not Detected: Transfer Roller The transfer roler is not correctly set.

Not Detected: Transfer Unit The transfer unit is not correctly set.

Not Detected: Tray 1 Tray 1 is not correctly set.

Not Detected: Tray 2 Tray 2 is not correctly set.

Not Detected: Tray 3 Tray 3 is not correctly set.

Not Detected: Tray 4 Tray 4 is not correctly set.

Not Detected: WasteToner Bottle Waste toner bottle is not correctly set.
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Not Detected: Yellow Toner Yellow toner is not correctly set.

Not Detected: Z-fold’g Internal The Z fold unit is not correctly set.

Not Reached, Data Deleted Unreached job is deleted.

Not Reached, Data Removed Unreached job is deleted.

Not Reached, Data Stored Unreached job is preserved.

Offline Printer is offline.

Original on Exposure Glass The original remains on the exposure glass.

Panel Off Mode The machine is in Panel-Off mode.

Panel Off Mode>>Printing ava. The machine is in Control Panel-Off mode.

Paper in Duplex Unit The paper remains in the duplex unit.

Paper in Finisher The paper remains in Finisher.

Paper Misfeed: ADF The paper has jammed in Document Feeder.

Paper Misfeed: Duplex Unit The paper has jammed in the duplex unit.

Paper Misfeed: Input Tray The paper has jammed in the input tray.

Paper Misfeed: Internal/Output The paper has jammed inside the machine.

Paper Misfeed: Output Tray The paper has jammed in output tray.

Paper on Finisher Shift Tray 2 The paper remains in Finisher Shift Tray 2.

Paper on FinisherShiftTray1, 2 The paper remains in Finisher Shift Tray 1 and 

2.

Prepaid Card not inserted The machine is waiting for prepaid card to be 

inserted.

Print Complete The print was completed.

Printing Printing is in progress.

Processing Data is being processed.

RC Gate Connection Error Failed connection with RC Gate.

Ready The machine is ready to print.

Replace Black PCU It is time to replace the black photoconductor 

unit.

Replace Charger It is time to replace the charger kit.

Replace Cleaning Web It is time to replace the Cleaning Web.

Replace Color PCU It is time to replace the photoconductor unit 

(color).

Replace Develop. Unit It is time to replace the development unit.

Replace Develop. Unit (Black) It is time to replace the development unit 

(black).
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❒ For details about UNIX commands, see UNIX Supplement.

❒ Check the error contents that may be printed in the configuration page. For
details about printing a configuration page, see p.141 “Printing a Configura-
tion Page”.

Printer configuration

You can check the printer configuration using telnet.

Replace Develop. Unit (Color) It is time to replace the development unit (col-

or).

Replace Develop. Unit (Cyan) It is time to replace the development unit (cy-

an).

Replace Develop. Unit (Magenta) It is time to replace the development unit (ma-

genta).

Replace Develop. Unit (Yellow) It is exchange time of the development unit 

(yellow).

Replace Fusing Unit It is time to replace the fusing unit.

Replace Maintenance Kit It is time to replace the maintenance kit.

Replace PCU It is time to replace the photoconductor unit.

Replace Transfer Belt It is time to replace the transfer belt.

SD Card Authentication failed SD card authentication failed.

Setting Remotely The RDS setting is being processed.

Skipped due to Error Skipped the error.

Storage Complete The storage is complete.

Storage Failed The storage has failed.

Supplies Order Call failed The supply order call has failed.

Suspend / Resume Key Error Finisher stop button was pressed.

Transmission Aborted The transmission was interrupted.

Transmission Complete The transmission completion was completed.

Transmission Failed The transmission has failed.

Tray Error: Chaptering The paper feed tray specification error has oc-

curred because chaptering as well as the nor-

mal paper use the same tray for printing.

Tray Error: Duplex Printing Selected paper tray cannot be used for duplex 

printing.

Unit Left Open: ADF Document feeder is opened.

Warming Up... The machine is warming up.
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This section explains the checking procedure for input/output tray and printer
language.

• UNIX: Use the “info” command and “rsh”, “rcp”, and “ftp” parameters.

• mshell: Use the “info” command.

❖ Input Tray

❖ Output Tray

❖ Emulation

❒ For details about UNIX commands and parameters, see UNIX Supplement.

❒ For details about mshell “info” commands, see p.200 “info”.

Item Description

 No. ID number of the paper tray

Name Name of the paper tray

PaperSize Size of paper loaded in the paper tray

status Current status of the paper tray

• Normal:Normal

• NoInputTray: No tray

• PaperEnd:No paper

Item Description

No. ID number of the output tray

Name Name of the output tray

status Current status of the output tray

• Normal:Normal

• PaperExist:Paper exist

• OverFlow:Paper is full

• Error:Other errors

Item Description

No. ID number of the printer language used by the 

printer

Name Name of the printer language used in the print-

er

Version Version of the printer language
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Understanding the Displayed Information

This section explains how to read status information returned by the network in-
terface board.

Print Job Information

Use the following command to display print job information:

• UNIX: Use the “info” command and “rsh“, “rcp”, and “ftp” parameters.

• mshell: Use the “info” command.

❒ For details about UNIX commands and parameters, see UNIX Supplement.

❒ For details about mshell “info” commands, see p.200 “info”.

Print Log Information

This is a record of the most recent 16 jobs printed.

Use the following command to display print log information:

• UNIX: Use the “prnlog” command and “rsh”, “rcp”, and “ftp” parameters.

• telnet : Use the “prnlog” command. See p.203 “prnlog”

Item Description

Rank Print job status.

• Active

Printing or preparing for printing.

• Waiting

Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is 0 bytes.

Item Description

ID Print request ID.

User Print request user name.

Page Number of pages printed
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❒ For details about UNIX commands and parameters, see UNIX Supplement.

❒ For details about mshell prnlog commands, see p.203 “prnlog”.

Configuring the Network Interface Board

Use the following command to display network interface board settings:

• telnet : Use the “show” command.

Result Print Request Result

Communication Result

• OK

Print was completed normally. However, the print result may 

not be as required due to printer problems.

• NG

Printing was not completed normally.

• Canceled

An “rcp”, “rsh”, or “lpr” command print request was canceled, 

possibly due to the printing application. Not applicable to the 

“ftp” or “rprinter” command.

Time Time the print requested was received.

Time of print request reception

User ID Printer driver-configured User ID.

Appears when the print request ID is specified.

JobName Name of the document for printing

Appears when the print request ID is specified.

Item Description

Common

 mode

 Protocol Up/Down [up] means “active” and [down] means “inactive”.

 appletalk 

 TCP/IP

 netware

 SMB

IP over 1394

SCSI print

Ethernet interface Internal version number

Syslog priority

NVRAM version Internal version number

Item Description
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Device name Printer name

Comment Comment

location Location of the printer in the SNMP and Rendezvous in-

formation

Contact Administrator information for the printer and contact in-

formation in the SNMP information

Soft switch

appletalk

 mode AppleTalk protocol in selection

 Net Network number

 Object Macintosh printer name

 Type Type of printer

 Zone Name of the zone that the printer belongs to

TCP/IP

 mode [up] means “active” and [down] means “inactive”.

 ftp

 lpr

 rsh

 telnet

 diprint

 web

 http

 ftpc

 snmp

 ipp

 autonet

 rendezvous

 ssl

rfu

nbt

EncapType Frame type

 dhcp Dynamic Host Configuration Protocol (on/off)

Host name

 Address IP address

 netmask Subnet mask

Item Description
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 broadcast Broadcast address

 DNS Domain DNS domain type

 gateway Default gateway address

Access Range[ ] Access control range

Time server NTP server address

Time Zone NTP server time difference

Time server polling time NTP server interval

SYSLOG server

 Home page URL URL of homepage.

 Home page link name URL of home page

netware

 EncapType Frame type

 RPRINTER number Remote printer number

 Print server name Print server name

 File server name Name of the connect file server

 Context name Context of print server

 Switch

 mode Active mode

 NDS/Bindery (this value is fixed)

 Packet negotiation 

 Login Mode Login mode

 Print job timeout Packet timeout

 protocol Protocol used

 SAP interval time

 NDS Tree Name NDS tree name

SMB

 Switch

 mode (this value is fixed)

 Direct print (this value is fixed)

 Notification Notification of print job completion

 Workgroup name Name of the workgroup

 Computer name Name of the computer

 Comment Comment

 Share name[1] Share name (model of the printer)
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 protocol

IEEE 802.11b

Device name Printer name

dhcp DHCP (on/off)

Address IP address

netmask Subnet mask

broadcast Broadcast address

DNS Domain DNS domaintype

ssid SSID used

Channel range Channels available for use

Channel Channel used

Communication mode IEEE 802.11b interface transmitting mode

Authentication

TX Rate IEEE 802.11b interface speed

WEP encryption WEP enabled or disabled

Encryption key WEP key

IP over 1394

Host name

DHCP DHCP (on/off)

Address IP address

netmask Subnet mask

broadcast Broadcast address

DNS Domain

SCSI print

Bidi. Bidirectional setting (on/off)

Bluetooth

Bluetooth mode Bluetooth connection mode

UPnP

URL

dns

Server[X]: IP address of the DNS server

Selected DNS Server Selected DNS server

Domain Name

ether Domain name on an Ethernet connection

Item Description
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wlan Domain name on a wireless LAN connection

ip1394

rendezvous

Computer Name Computer name

Rendezvous Name (ether) Rendezvous name on an Ethernet connection

Rendezvous Name (wlan) Rendezvous name on a wireless LAN connection

Rendezvous Name (ip1394) Rendezvous name on an IP over 1394 connection

location Location of the printer

 Priority (diprint) diprint priority number

 Priority (lpr) lpr priority number

Priority (ipp) ipp priority number

IP TTL IP TTL value

LinkLocal Route for Multi I/F:

Ethernet (ether)

[IEEE 802.11b (wlan)] appears when IEEE 802.11b is se-

lected. [IP over 1394 (ip1394)] appears when IEEE1394 is 

selected.

DDNS

ether Dynamic DNS function on an Ethernet connection 

(on/off)

wlan Dynamic DNS function on a wireless LAN connection 

(on/off)

ip1394 Dynamic DNS function on an IP over 1394 connection 

(on/off)

wins

ether

Primary WINS IP address of the primary WINS server on an Ethernet 

connection

Secondary WINS IP address of the secondary WINS server on an Ether-

net connection

ip1394

Primary WINS IP address of the primary WINS server on an IP over 

1394 connection

Secondary WINS IP address of the secondary WINS server on an IP over 

1394 connection

SNMP

SNMPv1v2

SNMPv3

protocol

Item Description
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v1Trap

v2Trap

v3Trap

SNMPv1v2Remoto Setting

SNMPv3 Privacy

Shell mode Mode of the remote maintenance tool

Item Description
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Message List

This is a list of messages that appear in the printer's system log. The system log
can be viewed using the “syslog” command.

System Log Information

Use the following command to display the system log information:

• UNIX: Use the “syslog” command and “rsh”, “rcp”, and “ftp” parameters.

• telnet : Use the “syslog” command.

Message Problem and solutions

Access to NetWare server <file server name> 

denied. Either there is no account for this print 

server on the NetWare server or the password 

was incorrect.

(In the print server mode) Login to the file serv-

er failed. Make sure that the print server is reg-

istered on the file server. If a password is 

specified for the print server, delete it.

add_sess: bad trap addr:<IpAddress>, com-

munity:<community name>

The IP address (0.0.0.0.) is unavailable when 

the community access type is TRAP. Specify 

the host IP address for the TRAP destination.

add_sess: community<community name> al-

ready defined.

The same community name already exists. 

Use another community name.

add_sess_ipx: bad trap addr: <IPXaddress>, 

community:<community name>

The IPX address (00:00:00:00:00:00) is un-

available when the community access type is 

TRAP. Specify the host IPX address for the 

TRAP destination.

add_sess_ipx: community <community name> 

already defined.

The same community name already exists. 

Use another community name.

ANONYMOUS FTP LOGIN FROM <IP ad-

dress>, <password>

An anonymous login has been made with a 

password <password> from the host <IP ad-

dress>.

anpd start. (AppleTalk) The ANPD (AppleTalk Network Package Dae-

mon) service has started.

Attach FileServer= <file server name> Connection to the file server as the nearest 

server has been established.

Attach to print queue <print queue name> (In the print server mode) Attached to the print 

queue.

Cannot create service connection (In the remote printer mode) Connection to the 

file server has not been established. The num-

ber of file server users may have exceeded the 

maximum capacity of the file server.

Cannot find rprinter (<print server 

name>/<printer number>)

The printer with the number displayed on the 

print server does not exist. Make sure that the 

printer number is registered on the print server.
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Change IP address from DHCP Server. The IP address changes when DHCP lease is 

renewed. To always assign the same IP ad-

dress, set a static IP address to the DHCP 

server.

child process exec error! (process name) The network service failed to start. Turn the 

printer off and then on. If this does not work, 

contact your service or sales representative.

Connected DHCP Server(<DHCP server ad-

dress>).

The IP address was successfully received 

from the DHCP server.

connection from <IP address> Login was from the host IP address.

Could not attach to FileServer<error number> (In the remote printer mode) Connection to the 

file server has not been established. The file 

server has refused the connection. Check the 

file server configuration.

Could not attach to PServer<print server> (In the remote printer mode) Connection to the 

print server has not been established. The 

print server has refused the connection. Check 

the print server configuration.

Current Interface Speed:xxxMbps Speed of the network (10 Mbps or 100 Mbps)

Current IP address <current IP address> The IP address <current IP address> was re-

ceived from the dhcp server.

Current IPX address<IPX address> Current ipx address

DHCP lease time expired. DHCP lease time has expired. The printer tries 

to discover the DHCP server again. The IP ad-

dress until now becomes invalid.

DHCP server not found. The DHCP server was not found. Make sure 

that the DHCP is on the network.

dhcpcd start. The DHCPCD service (dhcp client service) 

has started.

Duplicate IP=<IP address>(from <MAC ad-

dress>).

The same IP address is used. Each IP address 

must be unique. Check the address of the de-

vice indicated in [MAC address].

Established SPX Connection with PServ-

er,(RPSocket=<socket number>, con-

nID=<connection ID>)

(In the remote printer mode) Connection to the 

print server has been established.

exiting The lpd service has ended and the system is 

exiting the process.

Exit pserver (In the print server mode) The print server 

function is disabled because the necessary 

print server settings have not been made.

Frametype =<frame type name> The frame type name is configured to be used 

on NetWare.

httpd start. The httpd service has started.

Message Problem and solutions
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inetd start. The inetd service has started.

IPP cancel-job: permission denied. The printer could not authenticate the name of 

the user attempting to cancel a job.

ipp disable. Printing with ipp is disabled.

ipp enable. Printing with ipp is enabled.

IPP job canceled. jobid=%d. The spooled job was canceled due to error or 

user request.

LeaseTime=<lease time>(sec), Renew-

Time=<renew time>(sec).

The resource lease time received from the 

DHCP server is displayed in [lease time] in 

seconds. The renewal time is displayed in [re-

new time] in seconds.

Login to fileserver <file server name> 

(<IPX|IP>,<NDS|BINDERY|NDS|BINDERY>)

(In the print server mode) Login to the file serv-

er is in the NDS or BINDERY mode.

multid start. Data transmission service for multiprotocols 

has started.

nbstart start. (NetBEUI) The service for NetBEUI protocol stack setting 

has started.

NBT Registration Broadcast(<NetBIOS 

name>)

Use a local broadcast to map the NetBIOS 

name with the IP address.

nbtd start. The nbtd service has started (available only in 

the DHCP mode).

NetBEUI Computer Name =<computer name> The NetBEUI computer name is specified.

nmsd start. (NetBEUI) The nmsd (Name Server Daemon) service has 

started.

npriter start. (NetWare) (In the remote printer mode) The NetWare ser-

vice has started.

nwstart start. (NetWare) The service for NetWare protocol stack setting 

has started.

Open log file <file name> (In the print server mode) The specified log file 

has been opened.

papd start. (AppleTalk) The AppleTalk print service has started.

phy release file open failed. Replacing the network interface board is re-

quired. Contact your sales or service repre-

sentative.

Print queue <print queue name> cannot be 

serviced by printer 0, <print server name>

(In the print server mode) The print queue can-

not be established. Make sure that print queue 

exists on the specified file server.

Print server <print server name>has no printer. (In the print server mode) The printer is not as-

signed to the print server. Using NWadmin, as-

sign the printer, and then restart it.

print session full No more print jobs can be accepted.

Message Problem and solutions
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Printer <printer name> has no queue (In the print server mode) The print queue is 

not assigned to the printer. Using NWadmin, 

assign the print queue to the printer, and then 

restart it.

pserver start. (NetWare) (In the print server mode) The NetWare ser-

vice has started.

Required computer name (<Computer name>) 

is duplicated name

The start job found the computer name by add-

ing the computer name to the suffix (0,1...). Set 

a new computer name that is unique.

Required file server (<file server name>) not 

found

The required file server is not found.

restarted. The lpd service has started.

sap enable, saptype=<SAP type>, sap-

name=<SAP name>

The SAP function has started. The SAP packet 

is issued to advertise the service on the SAP 

table on the NetWare server.

session <community name> already defined. The requested community name is not de-

fined.

session_ipx <community name> not defined. The requested community name is not de-

fined.

Set context to <NDS context name> An NDS context name has been set.

shutdown signal received. network service re-

booting...

The network service is rebooting.

smbd start. (NetBEUI) The smbd service has started.

SMTPC: failed to get smtp server ip-address. The SMTP server IP address could not be ob-

tained. This could be because:

• The specified DNS server could not be 

found.

• No connection to the network has been es-

tablished.

• The specified DNS server could not be 

found.

• An incorrect DNS server is specified.

• The specified SMTP server IP address 

could not be found in the DNS server.

SMTPC: failed to connect smtp server. time-

out.

Connection to the SMTP server failed due to 

timeout. This could be because:

• The specified SMTP server name is incor-

rect.

• No connection to the network has been es-

tablished.

• The network configuration is incorrect, so 

there is no response from the SMTP serv-

er.

Message Problem and solutions
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SMTPC: refused connect by smtp server. Connection to the SMTP server is denied. This 

could be because:

• A server other than the SMTP server has 

been specified.

• The specified SMTP server port number is 

incorrect.

SMTPC: no smtp server. connection close. Connection to the SMTP server failed due to 

no response from SMTP. This could be be-

cause:

• A server other than the SMTP server has 

been specified.

• The specified SMTP server port number is 

incorrect.

SMTPC: failed to connect smtp server. Connection to the SMTP server failed. This 

could be because:

• No connection to the network has been es-

tablished.

• The network configuration is incorrect, so 

there is no response from the SMTP serv-

er.

• The specified SMTP server name is incor-

rect.

• An incorrect SMTP server is specified.

• The specified SMTP server IP address 

could not be found in the DNS server.

• A server other than the SMTP server has 

been specified.

• The specified SMTP server port number is 

incorrect.

SMTPC: username or password wasn’t cor-

rect. [response code] (information)

Connection to the SMTP server failed. This 

could be because:

• The specified SMTP user name is incor-

rect.

• The specified SMTP password is incorrect.

Check the SMTP user name and password.

Snmp over ip is ready. Communication over TCP/IP with snmp is 

available.

Snmp over IP over 1394 is ready. Communication over IP over 1394 with snmp 

is available.

Snmp over ipx is ready. Communication over IPX with snmp is avail-

able.

SNMPD: account is unavailable:

Same account name be used.

User account is disabled. This could be be-

cause it use the same account name as the 

administrator account.

Message Problem and solutions
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❒ For details about UNIX commands and parameters, see UNIX Supplement.

❒ For details about “syslog” command, see p.214 “syslog”.

SNMPD: account is unavailable:

The authentication password is not set up.

User account is disabled. This could be be-

cause the authentication password is not set, 

and only the encryption account is set.

SNMPD: account is unavailable:

encryption is impossible.

Encryption is not possible and account is dis-

abled. This could be because:

• Security option is not installed.

• Encryption password has not been speci-

fied.

SNMPD: trap account is unavailable. v3Trap cannot be sent. This could be because 

the Trap destination account is different from 

the account specified by the printer.

snmpd start. The snmpd service has started.

started. The direct print service has started.

Started. The rendezvous function is enabled.

Terminated. The rendezvous function is disabled.

The print server received error <error number> 

during attempt to log in to the network. Access 

to the network was denied.Verify that the print 

server name and password are correct. 

Login to the file server failed. The print server 

is not registered or a password is specified. 

Register the print server without specifying a 

password.

WINS name refresh :Server No Response There was no response to the update request 

from the print server. Check that the WINS 

server address is correct and the WINS server 

is working properly.

WINS name registration/refresh error code(er-

rornumber)

Set unique NetBIOS names.

Check that the WINS server address is correct 

and the WINS server is working properly.

WINS name registration:Server No Response There was no response to the registration re-

quest from the server. Check that the WINS 

server address is correct and the WINS server 

is working properly.

WINS server address0.0.0.0 The WINS server was not specified. Specify 

the WINS server address to match the printer 

name with WINS.

WINS Server=<WINS server address> Net-

BIOS Name=<NetBIOS name>

The printer name was successfully registered.

WINS wrong scopeID The scope ID is incorrect.

Specify the correct scope ID.

Message Problem and solutions
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Using a Printer Server

Preparing Printer Server

This section explains how to configure the printer as a Windows network printer.
The printer is configured to enabling network clients to use it. When the network
printer is connected via SmartDeviceMonitor for Client, you can set the printing
notification function to notify clients of the results of their print jobs.

❒ Under Windows 2000, Windows XP Professional, or Windows Server 2000,
to change printer properties in the [Printer] folder, you need Printer Manage-
ment access authentication; under Windows NT 4.0, Full Control access au-
thentication. Log on to the file server as an Administrator or member of the
PowerUsers group.

A Open the [Printers] window from the [Start] menu.

The [Printers] window appears.

B Click the icon of the printer you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

C On the [Sharing] tab, click [Shared as:].

D To share the printer with users using a different version of Windows,
click [Additional Drivers...].

❒ If you have installed an alternative driver by selecting [Shared as:] during the
printer driver installation, this step can be ignored.

E Click [OK]. Close the printer properties.

Printing notification via SmartDeviceMonitor for Client

Follow the procedure below to configure the printer to use the printing notification
function of SmartDeviceMonitor for Client.

Setting the print server

❒ Under Windows 2000, Windows XP Professional, or Windows Server 2000,
to change printer properties in the [Printer] folder, you need Printer Manage-
ment access authentication; under Windows NT 4.0, Full Control access au-
thentication. Log on to the file server as an Administrator or member of the
PowerUsers group.

A From the [Start] button on the task bar, point to [Program], point to [Smart-
DeviceMonitor for Client], and then click [Print Server Setting].
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The print server setting dialog box appears.

B Select the [Notify Client of Printing] check box, and click [OK].

After print server setting is made, a dialog box appears. Confirm the dialog
box content, and click [OK].

Click [Cancel] to interrupt the procedure.

C A dialog box appears for client setting. Click [OK].

The print server setting is complete. Each client must be set to receive print
notification.

❒ Current printing jobs restart from the beginning after the spooler pauses
briefly.

❒ When the expansion function is not used, the function is automatically set
as available.

Setting a Client

A From the [Start] button on the task bar, point to [Program], point to [Smart-
DeviceMonitor for Client], and then click [Setting Expansion Function].

A dialog box for setting the expansion function appears.

B Select the [Use the expansion function] check box in [Notify Printing].

C Select the [Notify when using the print server] check box.

D Click [OK].

The dialog box for setting the expansion function closes. The client setting is
completed.

❒ Set the printing notification function on the printer driver as well as on
SmartDeviceMonitor for Client.
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Using NetWare

This section describes the setting procedure for network printers in the NetWare
environment. In the NetWare environment, you can connect the printer as a
“print server” or “remote printer”.

❖ Setting procedure

• When using the printer as a print server

A Installing SmartDeviceMonitor for Admin

B Setting the network interface board.

C Turning the printer off and then back on.

• When using the printer as a remote printer

A Installing SmartDeviceMonitor for Admin.

B Setting the network interface board.

C Setting NetWare.

D Starting the print server.

❒ This procedure assumes an environment is already prepared for normal Net-
Ware running the printing service setting.

❒ The procedure is explained with the following example settings:

• File server’s name …CAREE

• Print server’s name …PSERV

• Printer’s name …R-PRN

• Queue name …R-QUEUE

❖ Using SmartDeviceMonitor for Admin
To use the printer in a NetWare environment, use SmartDeviceMonitor for Ad-
min to set the NetWare printing environment.

❒ The NetWare Client provided by Novell is required to set the printing envi-
ronment using SmartDeviceMonitor for Admin under the following environ-
ments:

• NDS mode in Windows 95/98/Me

• NDS or Bindery mode in Windows 2000/XP, Windows NT 4.0

For details about installing SmartDeviceMonitor for Admin, see p.178 “In-
stalling SmartDeviceMonitor for Admin”.
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❖ Printers listed by SmartDeviceMonitor for Admin
SmartDeviceMonitor for Admin lists printers connected to the network. If you
cannot identify the printer you want to configure, print configuration page, and
then check the printer name.

Setting Up as a Print Server (NetWare 3.x)

Follow the procedure below to connect the printer as a print server using Net-
Ware 3.x.

A Log on to the file server as a supervisor or supervisor equivalent.

B Start NIB Setup Tool from the [Start] menu.

C Click [Wizard], and then click [OK].

D Select a printer you want to configure.

E Enter the printer name in the [Device Name] box and a comment in the
[Comment] box, and then click [Next].

F Select the [NetWare] check box, and then click [Next].

G Click [Bindery mode], enter the file server name in the [File Server Name:] box,
and then click [Next].

In the [File Server Name:] box, enter the name of the file server in which a print
server is created. You can also click [Browse] to browse through available file
servers.

H Enter the print server name in the [Print Server Name] box, the printer name
in the [Printer Name] box, and the print queue name in the [Print Queue Name]
box, and then click [Next].

• In the [Print Server Name] box, enter the name of the NetWare print server
using up to 47 characters.

• In the [Printer Name] box, enter the name of the NetWare printer.

• In the [Print Queue Name] box, enter the name of the print queue to be added
to NetWare.

I Check the settings, and then click [Next].

The settings are applied, and NIB Setup Tool quits.

J Turn the printer off and then on again.

❒ To check that the configuration is made correctly, enter the following from
the command prompt.

F:> USERLIST
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❒ If the printer works as configured, the name of the print server appears as
a connected user.

❒ If you cannot identify the printer you want to configure, check the printer
name with the configuration page printed from the printer. For details about
printing a configuration page, see p.141 “Printing a Configuration Page”.

❒ If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

For details about changing the printer's frame type (“NW Frame Type”),
see “Configuring the Printer”, Printer Reference.

Setting Up as a Print Server (NetWare 4.x, 5/5.1, 6/6.5)

Follow the procedure below to connect the printer as a print server using Net-
Ware 4.x, NetWare 5/5.1, or NetWare 6.0.

❒ When using the printer as a print server in NetWare 4.x, NetWare 5/5.1, or
NetWare 6.0, set it to the NDS mode.

❒ When using NetWare 5/5.1 or NetWare 6.0, set the printer as a print server.

A Log on to the file server as a supervisor or supervisor equivalent.

B Start NIB Setup Tool on the [Start] menu.

C Click [Wizard], and then click [OK].

D Select a printer you want to configure.

E Enter the printer name in the [Device Name] box and a comment in the
[Comment] box, and then click [Next].

F Select the [NetWare] check box, and then click [Next].

G Click [NDS mode], enter the file server name in the [File Server Name:] box,
the NDS tree name in the [NDS Tree:] box, and the context in the [NDS Con-
text] box, and then click [Next].

In the [File Server Name:] box, enter the name of the file server in which a print
server is created. You can also click [Browse] to browse through available file
servers and NDS context names.

In the [NDS Tree:] box, enter the name of the NDS tree in which a print server
is created using up to 32 alphanumeric characters. Hyphens and underscores
can also be used. You can also click [Browse] to browse through available
NDS trees.
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For a context, object names are entered from the lowest object with each ob-
ject separated by a period. For example, if you want to create a print server in
NET under DS, enter “NET.DS”.

H Enter the print server name in the [Print Server Name] box, the printer name
in the [Printer Name] box, the print queue name in the [Print Queue Name]
box, and the print queue volume in the [Print Queue Volume] box, and then
click [Next].

• In the [Print Server Name] box, enter the name of the NetWare print server
using up to 47 characters.

• In the [Printer Name] box, enter the name of the NetWare printer.

• In [Print Queue Name] box, enter the print queue volume.

• In [Print Queue Volume], type the print queue volume. For a volume, object
names are entered from the lowest object with each object separated by a
period. You can also click [Browse] to browse through available volumes.

I Check the settings, and then click [Next].

The settings are applied, and NIB Setup Tool quits.

J Turn the printer off and then on again.

❒ To check that the configuration is made correctly, enter the following from
the command prompt.

F:> NLIST USER /A/B

❒ If the printer works as configured, the name of the print server appears as
a connected user.

❒ If you cannot identify the printer you want to configure, check the printer
name with the configuration page printed from the printer. For details about
printing a configuration page, see p.141 “Printing a Configuration Page”.

❒ If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

For details about changing the printer's frame type (“NW Frame Type”),
see “Configuring the Printer”, Printer Reference.

When using the printer in a pure IP environment of NetWare 5/5.1 or Net-
Ware 6.0/6.5, see p.246 “Using Pure IP in the NetWare 5/5.1 or 6/6.5 En-
vironment”.

Using Pure IP in the NetWare 5/5.1 or 6/6.5 Environment

Follow the procedure below to connect the printer as a print server in a pure IP
environment of NetWare 5/5.1.
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❒ When creating a queued print server in a pure IP environment of NetWare
5/5.1 or NetWare 6.0, create a print queue on the file server using NetWare
Administrator.

❒ This printer is not available as a remote printer for use in a pure IP environ-
ment.

❒ To use the printer in a pure IP environment, set it to TCP/IP.

Setting up using NIB Setup Tool

A Log on to the file server as an administrator or administrator equivalent.

B Start NIB Setup Tool on the [Start] menu.

C Click [Property Sheet], and then click [OK].

D Select a printer you want to configure.

E On the [NetWare] tab, Select [File Server Mode] or [NDS mode] in the [Logon
Mode] area.

When [File Server Mode] is selected, the network connection is established
based on the string entered in the [File Server Name(F):] box.

When [NDS mode] is selected, the network connection is established based on
the string entered in the [NDS Tree:] box.

F In the [Print Server Name] box, enter the name of the print server.

G In the [File Server Name:] box, enter the name of the file server in which a
print server is created.

You can also click [Browse] to browse through available file servers.

H Enter the NDS tree name in the [NDS Tree:] box.

Enter up to 32 alphanumeric characters. Hyphens and underscores can also
be used.

I In the [NDS Context] box, enter the context of the print server.

You can also click [Browse] to browse through available NDS trees and NDS
contexts.

For a context, object names are entered from the lowest object with each ob-
ject separated by a period. For example, if you want to create a print server in
Net under DS, enter “NET.DS”.
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J In the [Print Server Operation Mode] area, click [As Print Server].

K Click [OK] to close the [NIB Setup Tool] dialog box.

Setting up using NWadmin

A From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

B Select the object in which the print queue is located in the directory tree,
and then click [Create] on the [Object] menu.

C In the [Class of new object] box, click [Print Queue], and then click [OK].

D In the [Print Queue Name] box, enter the name of the print queue.

E In the [Print Queue Volume] box, click [Browse].

F In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

G Check the settings, and then click [Create].

H Select the object in which the printer is located, and then click [Create]
on the [Object] menu.

I In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

J In the [Printer name] box, enter the printer name

K Select the [Define additional properties] check box, and then click [Create].

L Click [Assignments], and then click [Add] in the [Assignments] area.

M In the [Available objects] box, click the queue you, and then click [OK].

N Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

O Click [Manual load] in the [Communication type] area, and then click [OK].

P Check the settings, and then click [OK].

Q Select a context specified using NIB Setup Tool, and then click [Create]
on the [Object] menu.

R In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].
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S In the [Print Server Name] box, enter the print server name.

Use the same print server name specified using NIB Setup Tool.

T Select the [Define additional properties] check box, and then click [Create].

U Click [Assignments], and then click [Add] in the [Assignments] area.

V In the [Available objects] box, click the queue you created, and then click
[OK].

W Check the settings, and then click [OK].

X Start the print server by entering the following from the console of the
NetWare server.

If the print server is in operation, quit and restart it.

❖ To exit

CAREE: unload pserver

❖ To start

CAREE: load pserver print_server_name

Setting Up as a Remote Printer (NetWare 3.x)

Follow the procedure below to use the printer as a remote printer under NetWare
3.x.

Setting up using NIB Setup Tool

A Log on to the file server as a supervisor or supervisor equivalent.

B Start NIB Setup Tool from [Start] menu.

C Click [Property Sheet], and then click [OK].

D Select a printer you want to configure.

E On the [NetWare] tab, enter the name of the print server in the [Print Server
Name] box.

F In the [File Server Name:] box, enter the name of the file server in which a
print server is created.

You can also click [Browse] to browse through available file servers.

G In the [Print Server Operation Mode] area, click [As Remote Printer].

H In the [Remote Printer No.] box, enter the printer number.
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Use the same printer number created in the print server.

I A confirmation message appears. Click [OK].

J On the [NIB] menu, click [Exit].

Setting up using PCONSOLE

A Enter “PCONSOLE” from the command prompt.

F:> PCONSOLE

B Create a print queue.

When using the existing print queue, go to the procedure for creating a printer.

C From the [Available Options] menu, select [Print Queue Information], and then
press the {Enter} key.

D Press {Insert} key, and then enter a print queue name.

E Press {ESC} key to return to the [Available Options] menu.

F Set up the network connection to a printer.

G On the [Available Options] menu, click [Print Server Information], and then
press the {ENTER} key.

H To create a new print server, press the {INSERT} key, and then enter a
print server name.

For a currently defined print server, select a print server in the [Print Server] list.

Use the same printer name specified using NIB Setup Tool.

I From the [Print Server Information] menu, select [Print Server Configuration].

J From the [Print Server Configuration] menu, select [Printer Configuration].

K Select the printer indicated as [Not Installed].

Use the same printer number specified as the remote printer number using
NIB Setup Tool.

L To change the printer name, enter a new name.

A name “Printer x” is assigned to the printer. The “x” stands for the number of
the selected printer.

M As type, select [Remote Parallel, LPT1].

The IRQ, Buffer size, Starting form, and Queue service mode are automati-
cally configured.

N Press the {ESC} key, and then click [Yes] on the confirmation message.
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O Press the {ESC} key to return to [Print Server Configuration Menu].

P Assign print queues to the created printer.

Q From [Print Server Configuration Menu], select [Queues Serviced By Printer].

R Select the printer created.

S Press the {INSERT} key to select a queue serviced by the printer.

You can select several queues.

T Follow the instructions on the screen to make other necessary settings.

Following these steps, check that the queues are assigned.

U Press the {ESC} key until “Exit?” appears, and then select [Yes] to exit
PCONSOLE.

V Start the print server by entering the following from the console of the
NetWare server.

If the print server is in operation, quit and restart it.

❖ To quit

CAREE: unload pserver

❖ To start

CAREE: load pserver print_server_name

❒ If the printer works as configured, the message “Waiting for job” appears.

Setting Up as a Remote Printer (NetWare 4.x, 5/5.1, 6/6.5)

Follow the procedure below to use the printer as a remote printer under NetWare
4.x, 5/5.1 and 6.

❒ To use the printer as a remote printer under NetWare 4.x/5/5.1, set it to NDS
mode.

❒ Do not use the printer as a remote printer when Pure IP is used.

Setting up using NIB Setup Tool

A Log on to the file server as an administrator or administrator equivalent.

B Start NIB Setup Tool from [Start] menu.

C Click [Property Sheet], and then click [OK].
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D Select a printer you want to configure.

E Click [NetWare].

F In the [Logon Mode] area, click [File Server Mode] or [NDS mode].

If [File Server Mode] is selected, the network connection is established based
on the string you entered.

If [NDS mode] is selected, the network connection is established based on the
string you entered.

G In the [Print Server Name(P):] box, enter the name of the print server.

Use the same print server name in NWadmin. Enter up to 47 alphanumeric
characters.

H In the [File Server Name(F):] box, enter the name of the file server in which
a print server is created.

You can also click [Browse...] to browse through available file servers. Enter
up to 47 alphanumeric characters.

I In the [NDS Tree(T):] box, enter the NDS tree name and create the file serv-
er.

You can also click [Browse...] to browse through available NDS trees and NDS
contexts. Enter up to 32 alphanumeric characters. Hyphens and underscores
can also be used.

J In the [NDS Context(C):] box, enter a context in which the print server is
created.

Enter up to 127 alphanumeric characters.

For context, object names from Root are entered from the lowest object, with
each object separated by a period. For example, to create a print server in the
NETWORK object under the organization object DS of Root, enter “NET-
WORK.DS”.

K In the [Print Server Option Mode] area, click [As Remote Printer(R)].

L In the [Remote Printer No.(N)] box, enter the printer number. Use the same
printer number created.

M Click [OK] to close [NIB Setup Tool].

Setting up using NWadmin

A From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.
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B Set up the network connection to a print queue. Select the object in
which the print queue is located in the directory tree, and then click [Cre-
ate] on the [Object] menu.

C In the [Class of new object] box, click [Print Queue], and then click [OK].

D In the [Print Queue Name] box, enter the name of the print queue.

E In the [Print Queue Volume] box, click [Browse].

F In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

G Check the settings, and then click [Create].

H Set up the network connection to a printer. Select the object in which the
printer is located, and then click [Create] on the [Object] menu.

I In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

J In the [Printer name] box, enter the printer name

K Select the [Define additional properties] check box, and then click [Create].

L Assign print queues to the created printer. Click [Assignments], and then
click [Add] in the [Assignments] area.

M In the [Available objects] box, click the queue you created, and then click
[OK].

N Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

O Click [Manual load] in the [Communication type] area, and then click [OK].
Check the settings, and then click [OK].

P Set up the network connection to a print server. Select a context speci-
fied using NIB Setup Tool, and then click [Create] on the [Object] menu.

Q In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

R In the [Print Server Name] box, enter the print server name.

Use the same print server name specified using NIB Setup Tool.

S Select the [Define additional properties] check box, and then click [Create].

T Assign the printer to the created print server. Click [Assignments], and
then click [Add] in the [Assignments] area.
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U In the [Available objects] box, click the queue you created, and then click
[OK].

V In the [Printers] area, click the printer you assigned, and then click [Printer
Number]

W Enter the printer number, and then click [OK]. Check the settings, and
then click [OK].

Use the same printer number specified as the remote printer number using
NIB Setup Tool.

X Start the print server by entering the following from the console of the
NetWare server.

If the print server is in operation, quit and restart it.

❖ To exit

CAREE: unload pserver

❖ To start

CAREE: load pserver print_server_name
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Special Operations under Windows

Printing Files Directly from Windows

You can print files directly using Windows commands. For example, you can
print PostScript files for PostScript 3.

❖ Windows 95/98/Me
You can print files directly using “ftp” command.

❖ Windows 2000/XP, Windows Server 2003, Windows NT 4.0
You can print files directly using “lpr”, “rcp” or “ftp” command.

Setup

Follow the procedure below to make network environment settings.

A Enable TCP/IP with the control panel, and then set up the printer’s net-
work environment about TCP/IP including IP addresses.

TCP/IP of the printer is set as default.

B Install a TCP/IP in Windows to set up the network environment.

Consult the network administrator for the local setting information.

C To print under Windows 2000/XP, Windows Server 2003, or Windows NT
4.0, install “Printing service for UNIX” as the network application. To
print under Windows NT 4.0, install “Microsoft TCP/IP printing” as the
network application.

For details about setting up IP address, see Printer Reference.

For details about setting the IP address of the printer using DHCP, see
p.290 “Using DHCP”.

This completes the setup for specifying a printer using an IP address when
printing. When using a host name to specify a printer, proceed to p.255
“Using a Host Name Instead of an IP Address” and continue the setup.

Using a Host Name Instead of an IP Address

When a host name is defined, you can specify a printer by host name instead of
IP address. The host names vary depending on the network environment.

When using DNS

Use the host name set to the data file on the DNS server.
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When setting the IP address of a printer using DHCP

Use the printer name on the configuration page as the host name.

For details about printing a configuration page, see p.141 “Printing a Config-
uration Page”.

In other cases

Add the IP address and host name of the network printer to the hosts file on the
computer used for printing. Methods of addition vary depending on operating
systems.

Windows 95/98/Me

A Copy WINDOWSHOSTS.SAM to the same directory and name it
“HOSTS” with no extension.

B Open the “WINDOWSHOSTS” file created using memo pad files, for in-
stance.

C Add an IP address and host name to the hosts file using the following
format:

192.168.15.16 host  # NP

”192.168.15.16” is the IP address, “host” is the printer's host name, and “#NP”
is replaced by comments. Insert a space or tab between “192.168.15.16” and
“host”, between “host” and “#NP” respectively, using one line for this format.

D Save the file.

Windows 2000/XP, Windows Server 2003, Windows NT 4.0

A Open the hosts file using memo pad files, for instance.

The hosts file is in the following folder:

WINNTSYSTEM32DRIVERSETCHOSTS

”WINNT” is the directory of the installation destination for Windows 2000/XP,
Windows Server 2003, and Windows NT 4.0.

B Add an IP address and host name to the hosts file using the following
format:

192.168.15.16 host  # NP

”192.168.15.16” is the IP address, “host” is the printer's host name, and “#NP”
is replaced by comments. Insert a space or tab between “192.168.15.16” and
“host”, between “host” and “#NP” respectively, using one line for this format.
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C Save the file.

Printing Commands

The following explains printing operations using the “lpr”, “rcp”, and “ftp” com-
mands.

Enter commands using the command prompt window. The location of the com-
mand prompts varies depending on operating systems:

• Windows 95/98
[Start] - [Programs] - [MS-DOS Prompt]

• Windows Me
[Start] - [Programs] - [Accessories] - [MS-DOS Prompt]

• Windows 2000
[Start] - [Programs] - [Accessories] - [Command Prompt]

• Windows XP, Windows Server 2003
[Start] - [All Programs] - [Accessories] - [Command Prompt]

• Windows NT 4.0
[Start] - [Programs] - [Command Prompt]

❒ Match the data format of the file to be printed with the emulation mode of the
printer.

❒ If the message “print requests full” appears, no print jobs can be accepted. Try
again when sessions end. For each command, the amount of possible ses-
sions is indicated as follows:

• lpr: 5(When the spool printing function is available: 10)

• rcp, rsh: 5

• ftp: 3

❒ Enter the file name in a format including the path from the directory executing
commands.

The “option” specified in a command is an intrinsic printer option and its syn-
tax is similar to printing from UNIX. For details, see UNIX Supplement.

lpr

❖ When specifying a printer by IP address

c:> lpr -Sprinter's IP address [-Poption] [-ol] \pass
name\file name
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❖ When using a host name instead of an IP address

c:> lpr -Sprinter's host name [-Poption] [-ol] \pass
name\file name
When printing a binary file, add the “-ol” option (lowercase O, and lowercase
L).

When using a printer with the host name “host” to print a PostScript file named
“file 1” located in the “C:\PRINT” directory, the command line is as follows:

c:> lpr -Shost -Pfiletype=RPS -ol C:\PRINT\file1

rcp

First, register the printer's host name in the hosts file.

c:> rcp [-b] \pass name\file name [pass name\file name...]
printer's host name:[option]

❒ In file names, “*” and “?” can be used as wild cards.

❒ When printing a binary file, add the “-b” option.

When using a printer with the host name “host” to print a PostScript file named
“file 1” or “file 2” located in the “C:\PRINT” directory, the command line is as fol-
lows:

c:> rcp -b C:\PRINT\file1 C:\PRINT\file2 host:filetype=RPS

For details about registering the printer's host name in the hosts file, see
p.255 “Using a Host Name Instead of an IP Address”.

ftp

Use the “put” or “mput” command according to the number of files to be printed.

❖ When one file is printed

ftp> put \pass name\file name [option]

❖ When multiple files are printed

ftp> mput \pass name\file name [\pass name\file name...]
[option]

Follow the procedure below to print using the “ftp” command.

A Formulate the printer's IP address or the host name of the hosts file
printer as an argument and use the “ftp” command.

% ftp printer's IP address

B Enter the user name and password, and then press the {# Enter} key.

There is no default user name while “password” is the default password.
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User:
Password:

CWhen printing a binary file, set the file mode to binary.

ftp> bin

When printing a binary file in ASCII mode, print may not come out correctly.

D Specify files to be printed.

The following shows the examples of printing a PostScript file named “file 1”
in the “C:\PRINT” directory and printing file 1 and file 2.

ftp> put C:\PRINT\file1 filetype=RPS
ftp> mput C:\PRINT\file1 C:\PRINT\file2

E Quit ftp.

ftp> bye

❒ “=”, “,”, “_”, and “;”cannot be used for filenames. File names will be read as
option strings.

❒ For “mput” command, option can not be defined.

❒ For “mput” command, “*” and “?” can be used as wild cards in file names.

❒ When printing a binary file in ASCII mode, print may not come out correctly.
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Mac OS Configuration

Mac OS

This section explains how to configure a Mac OS to use EtherTalk and USB.

The following explains how to configure Mac OS 9.1. If you are not using Mac
OS 9.1, see the manual of the Mac OS you are using for details

❒ For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)

❒ The PostScript 3 printer driver is stored in the following folder on the CD-
ROM.

Mac OS 8 and 9:PS Driver:(language):Disk1

Installing the PostScript 3 Printer Driver and PPD File

It is necessary to install a printer driver and PPD files to print from a Mac OS.

Follow the procedure below to install a printer driver and a PPD file into a Mac
OS using Mac OS 8.6 and higher.

PostScript 3 Printer Driver

A Insert the CD-ROM into the CD-ROM drive.

B Double-click the CD-ROM drive icon.

C Double-click the [Mac OS 8 and 9] folder.

D Double-click the [PS Driver] folder.

E Double-click the folder of the language you use.

F Open [DISK1], and then double-click the installer icon.

G Follow the instructions on the screen.

PPD Files

A Double-click the CD-ROM drive icon.

B Double-click the [Mac OS 8 and 9] folder.

C Double-click the [Printer Descriptions] folder.

D Double-click the folder of the language you use.
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E Open the [DISK1] folder.

F Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions]
under [System Folder].

G Restart the Mac OS.

Setting Up PPD Files

❒ Make sure that the printers are connected to an AppleTalk network before
performing the following procedure.

A On the [Apple] menu, click [Chooser].

B Click the Adobe PS icon.

C In the [Select a PostScript Printer:] list, click the name of the printer you want
to use.

D Click [Create].

E Click the printer you want to use, and then click [Select].

A PPD file is set up and the Adobe PS icon appears at the left of the printer
name in the list. Follow the procedure on p.262 “Setting Up Options” to make
option settings; otherwise close the [Chooser] dialog box.

Creating a Desktop Printer Icon

❒ Make sure that printers are connected to the USB before performing the fol-
lowing procedure.

To use a printer connected by USB, create a desktop printer icon.

A Double-click [Desktop Printer Utility] in the [AdobePS Components] folder.

B Click [AdobePS] in [With:], click [Printer (USB)] in [Create Desktop], and then
click [OK].

C Click [Change] in [USB Printer Selection].

D Select the model you are using in [Select a USB Printer:], and then click [OK].

E Click [Auto Setup] in [PostScriptTM Printer Description (PPD) File].

F Click [Create].

G Enter the printer name, and then click [Save].
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The printer icon appears on the desktop.

H Quit Desktop Printer Utility.

Setting Up Options

A On the [Apple] menu, click [Chooser].

B Click the Adobe PS icon.

C In the [Select the PostScript Printer:] list, click the name of the printer you
want to use, and then click [Setup].

D Click [Configure].

A list of options appears.

E Select the option you want to set up, and then select an appropriate set-
ting for it.

F Click [OK].

The list of options closes.

G Click [OK].

The [Chooser] dialog box appears.

H Close the [Chooser] dialog box.

❒ If the option you want to select is not displayed, PPD files may not be set
up correctly. To complete the setup, check the name of the PPD file dis-
played in the dialog box.

Installing the ColorSync Profiles

ColorSync profiles enable a printer to print colors consistent with those on the
computer display. You must install the ColorSync profile to use this function.

Follow the procedure below to install the ColorSync profiles.

A Start a Mac OS.

B Double-click the hard disk icon, and then open the appropriate folder for
installing the ColorSync profiles.

The location of the appropriate folder may vary depending on the version of
the Mac OS. The following are examples:

• System: Preferences: ColorSync profiles

• System: ColorSync profiles
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C Insert the CD-ROM into the CD-ROM drive.

The CD-ROM drive icon appears.

D Double-click the CD-ROM drive icon.

The contents of the CD-ROM appear.

E Double-click the [Mac OS 8 and 9] folder.

F Double-click the [ColorSyncTM Profiles] folder.

G Drag the file to the [ColorSyncTM Profiles] folder on the hard disk.

The ColorSync profiles are installed.

❒ The ColorSync profiles are consistent with color characteristics defined by
the International Color Consortium (ICC).

❒ For some computer displays, particular settings need to be created by Col-
orSync. For details, see the appropriate manuals for your computer dis-
play.

Installing Adobe Type Manager

❒ Quit all applications currently running before installation. Install ATM after you
restart the computer.

A Start a Mac OS.

B Insert the CD-ROM into the CD-ROM drive.

C Double-click the CD-ROM drive con.

D Double-click the [Mac OS 8 and 9] folder.

E Double-click the [ATM] folder.

F Double-click the ATM 4.6.3 installer icon.

G Follow the instructions on the screen.

HWhen the procedure is complete, restart the computer. ATM will be com-
pletely installed only after restarting.

I On the [Apple] menu, open [Control Panel], and then click [~ATM].

J The ATM control panel opens.
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❒ For details about installation, see the operating instructions in the ATM
folder.

Installing Screen fonts

Follow the procedure below to install screen fonts.

The screen fonts described below can be found in the [Fonts] folder on the CD-
ROM.

A Start a Mac OS.

B Insert the CD-ROM into the CD-ROM drive.

The CD-ROM drive icon appears.

C Double-click the CD-ROM drive icon.

The contents of the CD-ROM appear.

D Double-click the [Mac OS 8 and 9] folder.

E Double-click the [Fonts] folder.

F Double-click the [Screen font] folder.

G Double-click the [TrueType] or [Type1] folder.

Select the font type you want to use.

H Copy the fonts you want to install in [Fonts] under [System Folder].

A confirmation message appears.

I Click [OK].

The fonts are installed.

J Restart the Mac OS.

Using USB Interface

Follow the procedure below to setup USB connection.

A Open the [AdobePS Component] folder on the hard disk.

B Double-click [Desktop Printer Utility].

C Click [AdobePS] in [With:], click [Printer (USB)] in [Create Desktop], and then
click [OK]. 

D Click [Change] in [PostScriptTM Printer Description (PPD) File].
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E Select the PPD files of the connected printer, and then click [Select].

F Click [Change] in [USB Printer Selection].

G Select the model you are using in [Select a USB Printer:], and then click [OK].

H Click [Create].

The following message appears.

I Specify the file location and the name, and then click [Save].

J Specify the file location and the name, and then click [Save].

The printer icon appears on the desktop.

K Quit Desktop Printer Utility.

❒ The procedures used to configure Mac OS may vary depending on the Mac
OS version. The following describes how to configure Mac OS 9.1. If you
are using a different version of Mac OS, use the following procedures as a
reference and see the manuals for your Mac OS version.

❒ Mac OS supports only the standard USB ports for this printer.

❒ When printing with a USB connection to a Macintosh computer, printer lan-
guage does not change automatically. Use the control panel on this printer
to change printer language to [Auto Detect] or [PS] before printing.

Changing to EtherTalk

Follow the procedure below to configure to a Mac OS to use EtherTalk.

A Open [Control Panel], and then double-click the AppleTalk icon.

B On the [Connect via:] pop-up menu, click [Ethernet].

C If you change zones, select a name on the [Current zone:] pop-up menu.

D Close the AppleTalk control panel.

E Restart the computer.

❒ The procedures used to configure Mac OS may vary depending on the Mac
OS version. The following describes how to configure Mac OS 9.1. If you
are using a different version of Mac OS, use the following procedures as a
reference and see the manuals for your Mac OS version.

❒ Confirm the Connection to the Printer with TCP/IP
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For information about installing applications required for EtherTalk, see the
Mac OS manuals.
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Mac OS X

This section explains how to configure a Mac OS X to use EtherTalk and USB.

Follow the procedure below to configure Mac OS X 10.1. If you are not using Mac
OS X 10.1, see the manual of the Mac OS X you are using for details.

❒ For Mac OS X 10.1 or higher.

❒ The PPD files are stored in the following folder on the CD-ROM.

Mac OS X:PPD Installer

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

❒ You need an administrator name and a password (phrase). For details, con-
sult your network administrator.

A Insert the CD-ROM into the CD-ROM drive.

B Double-click the CD-ROM drive icon.

C Double-click the [Mac OS X] folder.

D Double-click the installer icon.

E Follow the instructions on the screen.

Setting Up the PPD File

A Start Print Center.

B Click [Add Printer].

Click [AppleTalk] on the first pop-up menu.

If the zone is set, select the zone from the second pop-up menu.

C Select the PPD file for the model you are using from the [Printer Model:]
pop-up menu, and then click [Add].
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Setting Up Options

❒ No printer option settings can be made under Mac OS X. No new settings for
options not installed can be made.

Using USB Interface

Follow the procedure below to setup USB connection.

A Start Print Center.

B Click [Add].

C Click [USB] on the pop-up menu.

The connected printer appears.

D Select the printer, and then select its manufacturer from the [Printer Mod-
el:] pop-up menu.

A list of printer types appears.

E Select the name of the connected printer from the list of printer models,
and then click [Add].

F Close the [Printer List] dialog box, and then quit Print Center.

❒ When printing with a USB connection to a Macintosh computer, printer lan-
guage does not change automatically. Use the control panel on this printer
to change printer language to [Auto Detect] or [PS] before printing.

❒ USB2.0 can be used only with Mac OS X 10.3.3 or higher.

Using Rendezvous

Follow the procedure below to print using Rendezvous under Mac OS X 10.2.3
or higher. Ethernet and wireless LAN connections can also be used.

A Start Print Center.

B Click [Add].

C Click [Rendezvous] on the pop-up menu.

The connected printer appears.

D Select the printer, and then select its manufacturer from the [Printer Mod-
el:] pop-up menu.
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A list of printer types appears.

E Select the name of the connected printer from the list of printer models,
and then click [Add].

F Close the [Printer List] dialog box, and then quit Print Center.

❒ When printing with a Rendezvous connection to a Macintosh computer,
printer language does not change automatically. Use the control panel on
this printer to change printer language to [Auto Detect] or [PS] before print-
ing.

Changing to EtherTalk

❒ You need an administrator name and a password (phrase). For details, con-
sult your network administrator

Follow the procedure below to configure a Mac OS X to use EtherTalk.

For information about installing applications required for EtherTalk, see the
Mac OS manuals.

A Open [System Preference], and then click the Network icon.

B Click the [AppleTalk] tab.

C Select the [Make AppleTalk Active] check box.

D To change AppleTalk zones, select a name from the [AppleTalk Zone:] pop-
up menu.

EWhen the settings are made, click [Apple Now].
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Configuring the Printer

Use the control panel to enable AppleTalk. (The default is active.)
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Using PostScript 3

Job Type

You can select the type of print job.

❒ If you use Mac OS X, this function is not available.

❖ Normal
Select this for normal printing. The print job starts immediately after the print
command is given.

❖ Sample Print
Use this function to print the first set of a multiple-set print job. After checking
the results, the remaining sets can be printed using the control panel. This
function can protect you from printing a large quantity of misprints.

❖ Locked Print
Use this function to print confidential documents. Documents will not be print-
ed automatically unless a password is entered using the control panel.

Using Sample Print

❒ To use this function, the optional hard disk must be installed on the printer.

❒ The number of pages the printer can save varies depending on the contents
of the print images. At most, the printer can save 30 jobs or 1000 pages for
Sample Print and Locked Print.

❒ If you turn off the power, the job saved on the hard disk will be deleted.

❒ Sample Print files will not appear on the display panel if they have already
been executed or deleted using the Web browser before you select “Sample
Print“ from the control panel.

❒ Sample Print files printed or deleted using Web Image Monitor after you select
[Sample Print] using the control panel will appear on the display panel. Howev-
er, an error message will appear if you try to print or delete those Sample Print
files.

❒ If you use Mac OS X, Sample Print function cannot be used.

❒ If the application has a collate option, make sure that it is not selected before
sending a print job. By default, sample print jobs are automatically collated by
the printer driver. If the collate option is selected in the application print dialog
box, more prints than intended may be printed.

A In an application, select the menu command to print.
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The print dialog box appears.

B On the pop-up menu, click [Job Log].

C In [Job Type:], click [Sample Print], and then select the appropriate setting.

D In [User ID:], enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-
9) characters.

Set this to identify the user associated with the job.

The user ID can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

E After making the necessary settings you want, click [Print].

The Sample Print job is sent to the printer and one set is printed.

F Check the sample print to confirm that the settings are correct.

If the settings are correct, print the remaining sets.

If not, you can delete the saved job.

For details about printing the remaining sets, see p.107 “Printing the Re-
maining Sets”.

For details about deleting a Sample Print file, see p.108 “Deleting a Sample
Print File”.

Using Locked Print

❒ To use this function, the optional hard disk must be installed on the printer.

❒ The number of pages the printer can save varies depending on the contents
of the print images. At most, the printer can save 30 jobs or 1000 pages for
Sample Print and Locked Print.

❒ If you turn off the power, the job saved on the hard disk will be deleted.

❒ Locked Print files will not appear on the display panel if they have already
been printed or deleted using Web Image Monitor before you select [Locked
Print] using the control panel.

❒ Locked Print files printed or deleted using Web Image Monitor after you have
selected [Locked Print] using the control panel will still appear on the display
panel. However, an error message will appear if you try to print or delete those
Locked Print files.

❒ If you use Mac OS X, Locked Print function cannot be used.

❒ If the application has a collate option, make sure that it is not selected before
sending a print job. By default, locked print jobs are automatically collated by
the printer driver. If the collate option is selected in the application print dialog
box, more prints than intended may be printed.
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❒ Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.

• When there are 30 Sample Print and Locked Print jobs saved on the hard
disk.

• When the total number of pages saved on the hard disk exceeds 1000 pag-
es.

A In an application, select the menu command to print.

The print dialog box appears.

B On the pop-up menu, click [Job Log].

C In [Job Type:], click [Locked Print], and then select the appropriate setting.

D In [User ID:], enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-
9) characters, and then enter a 4-digit password in [Password:].

Set this to identify the user associated with the job.

E After making the necessary settings you want, click [Print].

The Locked Print job is sent to the printer.

F Enter the password using the control panel, and then specify whether to
print or delete the job.

For details about entering the password, see p.111 “Entering a Password”.

For details about deleting the job, see p.112 “Deleting a Locked Print File”.

Duplex Printing

Use this function to select duplex printing.

❒ To use this function, the optional duplex unit must be installed on the printer.

❒ You cannot perform duplex printing when using the bypass tray.

❖ None
Disables duplex printing.

❖ Flip on Long Edge
Prints so you can open it to the long edge when bound along the long edge.

❖ Flip on Short Edge
Prints so you can open it to the short edge when bound along the short edge.
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❒ Availability of these items varies depending on the operating system you are
using. Click the button that means [Flip on Long Edge] or [Flip on Short Edge].

Color Mode

Use this function to select whether the document is printed in color or black and
white.

❖ Color
Prints color documents in full color.

❒ Color images are printed using CMYK toner, Cyan, Magenta, Yellow, and
Black. CMYK represents the three primary subtractive colors.

❒ If you want to adjust the print color, use the settings in the Advanced dialog
box accessed from the Advanced button on the [Print Quality] tab.

❖ Black and White
Prints everything, including color documents, in black and white. Black and
White printing is faster than Color. To stop black and white areas being printed
with CMYK toner, select [Black and White] in the printer driver as well as in the
application.

Gradation

Use this function to select a type of gradation suited to your requirements.

❖ Fast
Prints quickly but loses smoothness.

❖ Standard
Prints with good gradation.

Color Profile

Use this function to select the color profile pattern.

❖ Auto
Use this setting to automatically configure the best color profile pattern based
on the appearance of the document to be printed.

❖ Photographic
Use this setting to enhance reproduction of photos and graphics that include
midtones.
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❖ Presentation
Use this setting to enhance reproduction of documents containing text and
graphics. This CRD is best for printing colored charts, graphs, presentation
materials and so on. If you use this CRD for printing photographs, color and
gradation might not reproduce so well.

❖ Solid Color
Use this setting to print specific single colors, logos and so on.

❖ User Setting
Use this setting to print images using a CRD downloaded from your applica-
tion.

❖ CLP Simulation
Prints the output colors similar to the colors displayed on the computer
screen.

❒ Use this function to select a color rendering dictionary (CRD). The CRD is re-
ferred to color matching, so you should select the appropriate CRD for the
document you are printing. The selected CRD is also referred to when [Fine]
or [Super Fine] is selected for “ Color Setting ”. The following items are avail-
able: [Auto], [Photographic], [Presentation], and [Solid Color].

Color Setting

Use this function to select the correction method used for color conversion.

❒ The color rendering dictionary selected in the Color Profile setting is used.

❖ Off
No modification to the color setting.

❖ Fine
Select this setting to perform color matching based on the printer's built-in col-
or rendering dictionaries, and to perform CMYK conversion. This setting per-
forms printing at an output target of Monitor γ = 1.8.

❖ Super Fine
Select this setting to use a color rendering dictionary similar to the Fine setting
but is capable of producing output that is more vivid. Use this setting to em-
phasize lighter colors. This setting performs printing at an output target of
Monitor γ = 2.2.
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❒ Use this function to select a color rendering dictionary (CRD). The CRD is re-
ferred to color matching, so you should select the appropriate CRD for the
document you are printing. The selected CRD is also referred to when [Fine]
or [Super Fine] is selected for “Color Setting”. The following items are available:
[Auto], [Photographic], [Presentation], and [Solid Color].

CMYK Simulation Profile

You can simulate the color tone of the printing ink.

You can select the printing ink standard from US OffsetPrint, Euroscale, Japan-
Color and PaletteColor.

Dithering

Use this function to set the Image Rendering mode.

❖ Photographic
Performs dithering in an appropriate form for photographs.

❖ Text
Performs dithering in an appropriate form for text.

Gray Reproduction

Use this function to select Black Color mode for text and line art.

❖ Black by K
Select this setting to use a black toner.

❖ Black/Gray by K
Black portions are printed in gray.

❖ CMY+K
Select this setting to use all toners.

Color Matching

Use this function to select whether or not you want the colors in the documents
to be adjusted before printing, so that the printed page matches the colors on the
screen closer.

❖ Image Color Control
Open the [Image Color Matching] dialog box, and then click this button to specify
exactly how you want the colors on your screen adjusted before printing.
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Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of the
printer and so on.

❒ If a Macintosh and printer are connected by USB, you cannot use Printer Util-
ity for Mac.

❒ Printer Utility for Mac is included on the CD-ROM labeled “Printer Drivers and
Utilities”.

❒ Printer Utility for Mac requires Mac OS 7.6.1-9.x, or Mac OS X 10.1.x or
10.2.1. Mac OS X 10.0.x and 10.2 are not supported.

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the machine.

A Start the Macintosh.

B Insert the CD-ROM into the CD-ROM drive.

The CD-ROM icon appears.

C Double-click the hard disk icon to open it.

D Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

E Double-click the [Mac OS 8 and 9] folder.

❒ Under Mac OS X, double-click the [Mac OS X] folder.

F Double-click the [PS Utility] folder on the CD-ROM.

G Double-click the [Printer Utility for Mac] folder.

H Double-click the folder of the language you use.

I Move the “Printer Utility for Mac” file to the Macintosh hard disk using a
drag-and-drop operation.

J Drag the CD-ROM icon to the Trash to eject the CD-ROM.

Printer Utility for Mac is installed.
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Starting Printer Utility for Mac

Mac OS

❒ Before starting Printer Utility for Mac, make sure the printer is selected in
[Chooser] on the Apple menu.

A Double-click the Printer Utility for Mac icon.

The [Printer Utility for Mac] dialog box appears.

B Click [OK].

Printer Utility for Mac will take a few seconds to start.

Mac OS X

A Double-click the Printer Utility for Mac icon.

The [Printer Utility for Mac] dialog box appears.

B Click [OK].

C In the [Available Printers:] box, select the printer you want to use.

❒ If you change zones, select a name from [Available Network Zones:].

❒ Click [Choose Printer...] on the Printer Utility for Mac menu if you want to
change the printer.

D Select the printer you want to use.

Printer Utility for Mac will take a few seconds to start.

E Click [Choose].

Printer Utility for Mac Functions

Downloading PS Fonts

You can download the PS fonts to the printer memory or hard disk drive.

❒ The following procedure to download the fonts assume that you are a system
administrator. If you are not, be sure to consult your system administrator.

❒ During the download, do not turn off the power switch, operate the panel or
open or close the cover.

❒ If the printer restarts, all the printer settings return to the defaults.
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❒ Confirm that a Macintosh and the printer are connected with Appletalk.

A Select [Download PS Fonts...] on the [File] menu.

B Click [Add to list].

The dialog box to select fonts appears.

C Select the desired font files, and then click [Open].

The list of selectable font names appears.

D After adding all the fonts you want to download, click [OK].

The dialog box of selected fonts to download appears.

E Click [Download].

The fonts begin to download, and the download status is shown.

FWhen the completion message appears, click [OK].

G Click [Cancel].

❒ Some fonts cannot be downloaded.

❒ Before downloading, read the documentation about the fonts you want to
use.

Displaying Printer Fonts

You can display the available fonts currently downloaded to the printer. Fonts in
the printer memory and hard disk drive can be displayed.

A Select [Display Printer's Fonts...] on the [File] menu.

A dialog box appears.

B Select [Printer's memory] or [Printer's disk].

C Click [OK].

❒ The fonts displayed in italics are the default fonts.

Deleting Fonts

You can delete fonts from the printer memory or hard disk drive.

❒ You cannot delete the fonts displayed in italic.

A Select [Display Printer's fonts] on the [File] menu.

A dialog box appears.
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B Select [Printer's memory] or [Printer's disk].

C Select the fonts you want to delete.

D Click [Delete].

A confirmation message appears.

E Confirm the fonts you want to delete and the printer name from which
you want to delete the fonts.

F Click [Continue], and then click [OK].

G Click [OK].

Initializing the Printer Disk

When initializing the printer hard disk, all the fonts downloaded to the printer hard
disk drive are deleted. Before initializing, be sure to check the fonts on the hard
disk drive.

❒ When initializing the printer hard disk drive from the control panel, all of the
data on the printer hard disk drive is deleted. Before initializing, be sure to
check the data on the hard disk drive.

❒ Do not turn off the power switch until initializing is completed, otherwise the
hard disk drive might be damaged.

A Select [Initialize Printer's Disk...] on the [File] menu.

The confirmation message appears. To cancel initialization, click [Cancel].

B Click [Execute].

Initializing starts.

CWhen the completion message appears, click [OK].

Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints
Fonts Sample”.

A Select [Page Setup...] on the [File] menu.

B Select the paper size.

Printing Font Catalog

You can print the names of fonts available on the printer.

A Select [Print Fonts Catalogue] on the [File] menu.
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B Click [Print].

❒ The paper selected under [Page Setup] is used.

Printing Font Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

A Select [Print Fonts Sample...] on the [File] menu.

B Click [Print].

❒ Print by using the paper selected on [Page Setup].

Renaming the Printer

You can change the printer name displayed under Appletalk. If you connect sev-
eral printers on the network, assign different names so you can identify them. If
several printers have the same name, a digit appears next to the printer name in
[Chooser].

❒ You can enter up to 31 digits and letters.

❒ Do not use symbols, for example “*”, “:”, “=”, “@”, “~”.

Mac OS

A On the [File] menu, click [Rename Printer...].

B In the [New Name:] filed enter a new name.

C Click [Rename].

The printer name is changed.

D Click [OK].

E On the Apple menu, click [Chooser].

F Click the [AdobePS] icon.

G Select the printer whose name you changed, and then close the [Chooser]
dialog box.

❒ If there are several Appletalk zones, select the zone the machine belongs
to.
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Mac OS X

A On the [File] menu, click [Rename Printer...].

B In the [New Name:] filed enter a new name.

C Click [Rename].

The printer name is changed.

D Click [OK].

E On the [Printer Utility for Mac] menu, click [Choose Printer...].

F In the [Available Network Zones:] list, select the zone for the Macintosh in
use.

G In the [Available Printers:] list, select the printer whose name you changed,
and then click [Choose].

Restarting the Printer

You can restart the printer.

A Select [Restart Printer] on the [File] menu.

B Confirm the message that appears on the screen, and then click [Restart].

The printer restarts.

❒ The fonts downloaded in the printer memory will be deleted.

❒ If the printer restarts, all the printer settings return to the defaults.

Downloading PostScript Files

You can download a Postscript file to the printer.

A Select [Download PostScript File...] on the [Utility] menu.

B Select the file name to download, click the file name, and then click
[Open].

C Type the log file name, and then click [Save].

The selected file is downloaded.

❒ Errors are recorded in the log file.

Selecting the Zone

You can change the zone to which the printer belongs under Appletalk.
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❒ Confirm that a Macintosh and printer are connected with Appletalk.

Mac OS

A On the [Utility] menu, click [Select Zone...].

The zone to which the printer belongs and the available zone list appear.

B Select the zone in which you want to locate the printer, and then click
[Change].

A confirmation message appears.

C Click [Continue].

A confirmation message appears.

D Click [OK].

E On the Apple menu, click [Chooser].

F Click the [AdobePS] icon.

G In the [Appletalk zone:] list, select the zone you changed.

H In the [Select a PostScript Printer:] list, select the printer you want to use.

I Close the [Chooser] dialog box.

Mac OS X

A On the [Utility] menu, click [Select Zone...].

The zone to which the printer belongs and the available zone list appear.

B Select the zone which you want to locate the printer in, and then click
[Change].

A confirmation message appears.

C Click [Continue].

A confirmation message appears.

D Click [OK].

E On the [Printer Utility for Mac] menu, click [Choose Printer...].

F In the [Available Network Zones:] list, select the zone you changed.

G In the [Available Printers:] list, select the model of printer in use, and then
click [Choose].
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Displaying the Printer Status

You can display and confirm the current status of the printer.

A Select [Display Printer Status...] on the [Utility] menu.

The current status of the printer appears.

B Confirm the current status of the printer.

You can confirm the memory capacity, the VM (Virtual Memory) space, the
hard disk drive status and available space on the hard disk drive. You can also
confirm the zone to which the printer belongs.

C Click [OK].

Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the
printer.

❒ “Launch Dialogue Console” is recommended for users with an understanding
of PostScript.

❒ Do not download any file other than PostScript files to the printer.

❒ “Launch Dialogue Console” must be used at your own responsibility.

A Select [Launch Dialogue Console...] on the [Utility] menu.

Open the editing screen. The Dialogue Console menu bar appears.

B Type the PostScript command in the editor screen.

To edit a PostScript file, select [Open] on the [File] menu to open it.

You can search or replace a character string by using the [Search] menu.

C After editing the PostScript file, select [Download Top Window] on [Console]
menu to start printing.

The PostScript file is sent to the printer.

The [Reply from Printer] box opens, depending on the PostScript file you sent.

D Select [Return To Main Menu] on the [Console] menu to close the PostScript
file.
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Appendix

Software and Utilities Included on the CD-
ROM

The following softwares and utilities are included in the CD-ROMs that come with
the printer.

❖ Font Manager 2000
For installing new screen fonts, or organizing and managing fonts already in
the system. For details about Font Manager 2000, see the manual on the CD-
ROM labeled “Printer Drivers and Utilities”.

❖ SmartDeviceMonitor for Admin
For the system administrator to manage network printers.

SmartDeviceMonitor for Admin Help

❖ SmartDeviceMonitor for Client
For users to manage their network print status.

SmartDeviceMonitor for Client Help

❖ 1394 Utility
For the optional IEEE 1394 interface unit. For details, see the Readme file or
the manual provided with the optional IEEE 1394 interface unit.

❖ USB Printing Support
For connection to Windows 98 SE/Me computers via USB.

Viewing the contents of the CD-ROM

Follow the procedure below to view the contents of the CD-ROM.

A Insert the CD-ROM into the CD-ROM drive.

The installer starts.

B Click [Browse This CD-ROM].

Explorer starts and displays the contents of the CD-ROM.

Printer Drivers for This Printer

Printing requires installing a printer driver appropriate to your operating system.
The following drivers are included on the CD-ROM provided with this printer.
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❖ PCL 6/5e printer driver
This printer driver allows the computer to communicate with the printer via a
printer language.
The following operating system is supported.

• Windows 95/98/Me, Windows 2000/XP, Windows Server 2003, and Win-
dows NT 4.0

❒ For Windows NT 4.0, Service Pack 6 or higher is required.

❒ You can only print in black and white with PCL 5e driver.

❖ RPCS printer driver
This printer driver allows the computer to communicate with the printer using
a printer language. In addition to the conventional user interface, another pre-
set user interface is provided.
The following operating system is supported.

• Windows 95/98/Me, Windows 2000/XP, Windows Server 2003, and Win-
dows NT 4.0

❒ For Windows NT 4.0, Service Pack 6 or higher is required.

❖ PostScript Printer Drivers and PPD files
PostScript printer drivers and the PPD files are included on the CD-ROM pro-
vided with this printer. PostScript printer drivers allow the computer to com-
municate with the printer using a printer language. PPD files allow the printer
driver to enable specific printer functions.
The following operating system is supported.

• Windows 95/98/Me, Windows 2000/XP, Windows Server 2003, Windows
NT 4.0, Mac OS, and Mac OS X

❒ The PostScript printer drivers and PostScript Printer Description (PPD)
files are included on the CD-ROM labeled “Printer Drivers and Utilities”.

❒ For Mac OS, version 8.6 or higher is required. (Mac OS X Classic environ-
ment is supported.)

❖ PPD files
PPD files are included on the CD-ROM provided with this printer. PPD files
allow the printer driver to enable specific printer functions.

SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin is an application that uses TCP/IP and IPX/SPX
to monitor network printers. It can monitor multiple network printers using IP ad-
dress. We recommend that network administrators use this application.
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❖ File path
SmartDeviceMonitor for Admin is stored in the following folder on the CD-
ROM.

NETWORK\NETMON\admin\DISK1

❖ Available functions
SmartDeviceMonitor for Admin has the following functions to check:

• printer supplies such as paper or toner;

• results of print jobs executed from the computer.

For information about using SmartDeviceMonitor for Admin, see SmartDe-
viceMonitor for Admin Help.

SmartDeviceMonitor for Client

SmartDeviceMonitor for Client has the following functions. We recommend that
users install this application.

Operating system Protocol stack

Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare Client provided with Windows 95/98

Novell Client provided with Windows 95/98

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or Win-

dow NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX/SPX provided with Windows Server 2003

NetWare Client provided with Windows Server 2003

Novell Client provided with Windows Server 2003

Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows 

NT

Novell Client provided with Windows 2000 or Win-

dows NT
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• Printing in a peer-to-peer network, using TCP/IP, NetBEUI, and IPP from Win-
dows 95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0.

• Constantly monitoring the status of devices on the network using TCP/IP and
IPX/SPX.

❖ File path
SmartDeviceMonitor for Client is stored in the following folder on the CD-
ROM.

NETWORK\NETMON\CLIENT\DISK1

❖ Available functions
SmartDeviceMonitor for Client has the following functions.

• Peer-to-peer print function

• Prints directly on the network printer without sending any data to a print
server.

Operating system Protocol stack

Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetBEUI provided with Windows 95/98/Me

NetWare Client provided with Windows 95/98/Me

Novell Client provided with Windows 95/98/Me

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetBEUI provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX/SPX provided with Windows Server 2003

NetWare Client provided with Windows Server 2003

Novell Client provided with Windows Server 2003

Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

NetBEUI provided with Windows NT

Client Service for NetWare provided with Windows 

NT

Novell Client provided with Windows 2000 or Win-

dows NT
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• Prints on a substitute printer when there are too many jobs waiting on
the specified printer, or when an error disables printing (Recovery Print-
ing).

• Allocates multiple print jobs to multiple printers (Parallel Printing).

• Executes prior group registration of printers specified for Recovery
Printing or Parallel Printing.

• Notification function

• Displays an error message when there is an error on the specified print-
er while transferring or printing data.

• Notifies a print completion. You can also be notified of the print condi-
tion, such as displaying the notice only when Recovery Printing is exe-
cuted.

• Monitoring function

• Checks printer supplies such as paper or toner.

• Simultaneously monitors multiple printers in use.

• Checks the printer's network settings and detailed information of print-
ers.

• Enables you to check the print job log using the user ID

❒ For Recovery Printing or Parallel Printing, the options on the printers must
be the same. If a necessary option is not installed, a printer cannot be used
for Recovery Printing or Parallel Printing.

❒ For Recovery Printing or Parallel Printing, the paper loaded in the printers
must be the same. When a tray is selected for printing, load the same pa-
per in that tray in all printers.

❒ For Recovery Printing or Parallel Printing, the print results may be different
if the printers are not the same model or have exactly the same options.

❒ If you select Sample Print or Locked Print, you cannot select Recovery
Printing or Parallel Printing.

For information about using SmartDeviceMonitor for Client, see SmartDe-
viceMonitor for Client Help
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Cautions to Take When Using in a network

Connecting a Dial-up Router to a Network

When the NetWare file server and printer are on opposite sides of a router, pack-
ets are sent back and forth, causing communication charges to be incurred. Be-
cause packet transmission is a specification of NetWare, you need to change the
configuration of the router. If the network you are using does not allow you to
configure the router, configure the printer instead.

Configuring the router

Filter packets so that they do not pass over the dial-up router.

❒ The MAC address of the printer doing the filtering is printed on the printer con-
figuration page. For details about printing a configuration page, see p.141
“Printing a Configuration Page”.

❒ For details about configuring the printer if the router cannot be configured, see
the instructions below.

Configuring the printer with NetWare

A Configure the file server.

B Set the frame type for a NetWare environment.

For details about selecting a frame type, see p.158 “Host Interface menu
parameters”.

Configuring the printer without NetWare

AWhen not printing, the network interface board sends packets over the
network. Set NetWare to “inactive”.

For details about selecting protocols, see p.158 “Host Interface menu pa-
rameters”.

Using DHCP

This printer can be used in a DHCP environment. In a WINS server environment,
the printer name can simultaneously be registered with a WINS server.

Note the following points when an Ethernet interface and an IEEE 1394 (IP over
1394) interface are simultaneously installed.
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❖ When static IP addresses are set for each interface

• IP address: When set at the same value, the Ethernet interface is pre-
ferred.

• Subnet mask: When a value overlaps, the Ethernet interface is preferred.

• Gateway address: The value set is used. For the gateway address, set the
gateway address located in the subnetwork set by the interface. If the value
is outside the subnet range set by the interface, it operates as “0.0.0.0”.

❖ When each setting is acquired from the DHCP server

• IP address, subnet mask: Set for each value leased by the DHCP server
operating on a connected interface. When overlapping IP addresses or
identical IP addresses in the subnetwork are set, only the highest priority
active value is set for the interface.

❒ The default priority interface is Ethernet.

• AutoNet: An automatic private address (169.254. xxx.xxx) is set for high
priority interfaces.

❒ The default priority interface is IEEE 1394 (IP over 1394).

• Gateway address, DNS server address, domain name: Settings are made
for DHCP-acquired values that have the highest interface priority.
If the gateway address is outside the subnetwork range set by the inter-
face, it operates as “0.0.0.0”.

❒ The default priority interface is Ethernet.

❖ When the settings of the static IP addresses and the DHCP acquired value overlap

• IP address, subnet mask: When the static IP address and DHCP-acquired
value (IP address) are the same, or the static subnet mask value and
DHCP-acquired subnet mask value overlap, the interface set by the static
IP address is available using its value set. The interface set by DHCP is
reset to the default.

• Gateway address: Use the manually set value.

• If a gateway address is set outside the interface subnetwork range, it op-
erates as “0.0.0.0”.

❒ When the static IP address is not set, or is set as “0.0.0.0”, the interface
setting the DHCP-acquired value is activated.

❒ Supported DHCP server operating systems are: Windows 2000 Server, Win-
dows NT 4.0 Server Service Pack 4 or higher, NetWare, and UNIX standard.
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❒ The IP address acquired from DHCP can be checked on the configuration
page. For information about printing a configuration page, see p.141 “Printing
a Configuration Page”.

❒ When using WINS server, set the WINS server as shown on p.292 “Configur-
ing the WINS Server”.

❒ Under the WINS server, host names can be used for remote network printer
ports.

❒ If you are not using the WINS server, reserve the printer's IP address in the
DHCP server so the same IP address is assigned every time.

❒ When there are multiple DHCP servers, make the same reservation for all.
This printer uses information from the DHCP server that responds first.

❒ The DHCP relay-agent is not supported. If you are using the DHCP relay-
agent on an ISDN line network, expensive line charges will be incurred. This
is because your computer connects to the ISDN line whenever a packet is
transferred from the printer.

Using AutoNet

If the printer IP address is not assigned by a DHCP server automatically, a tem-
porary IP address starting with 169.254, which is not used on the network, can
be automatically selected by the printer.

You must change this setting to “on” to use AutoNet.

See p.193 “autonet”.

❒ The DHCP-assigned IP address has priority over that selected by AutoNet.
The printer reboots at this time, and is temporarily unable to print.

❒ You can check the current IP address on the configuration page. For details
about printing a configuration page, see p.141 “Printing a Configuration
Page”.

❒ When AutoNet is running, the printer name is not registered on the WINS
server.

❒ No communication can take place except between units started up using Au-
toNet. However, communication can take place with Macintosh computers
running Mac OS X 10.2.3 or higher versions.

Configuring the WINS Server

The printer can be configured to register its NetBIOS name with a WINS server
when the power is turned on. This enables the NetBIOS name of the printer to
be specified from SmartDeviceMonitor for Admin even in a DHCP environment.

This section explains configuring the WINS server.
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❒ The WINS server is supported with Windows NT 4.0 Server Service Pack 4
or higher, and Windows 2000 Servers WINS Manager.

❒ For details about the WINS server settings, see Windows Help.

❒ If there is no reply from the WINS server, the NetBIOS name is registered by
broadcast.

❒ The NetBIOS name can be entered using up to 13 alphanumeric characters.

Using Web Image Monitor

A Start a Web browser.

B Enter “http: //(printer's address)/” in the address bar to access the print-
er whose settings you want to change.

Top Page of Web Image Monitor appears.

C Click [Login].

The dialog box for entering the user name and password appears.

D Enter the user name and password, and then click [OK].

To use the default account, enter “admin” as user name, and leave the pass-
word blank.

E In the left area, click [Configuration], and then click [Network].

F Click [TCP/IP].

G Check that [Enable] is selected for [WINS] in the [Ethernet+IEEE 802.11b] col-
umn, and then enter the WINS server IP address in [Primary WINS Server]
and [Secondary WINS Server].

❒ When installing the optional expansion 1394 board and using IP over 1394
simultaneously, perform the same operations in the [IP over 1394] column.

H Click [Apply].

I Quit Web Image Monitor.

Using telnet

See p.191 “Using telnet”.
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Using the Dynamic DNS Function

Dynamic DNS is a function which dynamically updates (registers and deletes)
records (A record and PTR record) managed by the DNS server. When a DNS
server is part of the network environment to which this printer, a DNS client, is
connected, records can be dynamically updated using this function.

Updating

Updating procedure varies depending on whether the printer IP address is static
or acquired by DHCP.

❒ When the dynamic DNS function is not used, records managed by the DNS
server must be updated manually, if the printer's IP address is changed.

❒ To update the record using the printer, the DNS server has to have one of the
following:

• No security settings made.

• If security settings are made, an IP-specified client (this printer) permits up-
dating.

❖ For a static IP setting
If the IP address or host name is changed, the A and PTR records are updat-
ed.
If the A record is registered, CNAME is also registered. CNAMEs that can be
registered are as follows:

• Ethernet and IEEE 802.11b
RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the
MAC address)

• IEEE 1394
RNPXXXXXXXXXX (XXXXXXXXXX represents the lower 3-7 bytes of the
MAC Address in hexadecimal)

❖ For DHCP settings
As a substitute for the printer, the DHCP server updates the record, and one
of the following occurs:

• When the printer acquires the IP address from the DHCP server, the DHCP
server updates the A and PTR records.

• When the printer acquires the IP address from the DHCP server, the printer
updates the A record, and the DHCP server updates the PTR record.

If the A record is registered, CNAME is also registered. CNAMEs that can be
registered are as follows:

• Ethernet and IEEE 802.11b
RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the
MAC address)
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• IEEE 1394
RNPXXXXXXXXXX (XXXXXXXXXX represents the lower 3-7 bytes of the
MAC Address in hexadecimal)

❒ Dynamic update using message authentication (TSIG, SIG(0)) is not support-
ed.

DNS servers targeted for operation

❖ For static IP setting

• Microsoft DNS servers with standard Windows 2000 Server/Windows
Server 2003 features

• BIND 8.2.3 or higher

❖ For DHCP setup, when the printer updates the A record

• Microsoft DNS servers with standard Windows 2000 Server/Windows
Server 2003 features

• BIND 8.2.3 or higher

❖ For DHCP setup, when the DHCP server updates records

• Microsoft DNS servers with standard Windows 2000 Server/Windows
Server 2003 features

• BIND 8.2.3 or higher

• DNS servers with standard NetWare 5 (or a higher version) features

DHCP servers targeted for operation

As a substitute for the printer, DHCP servers capable of updating the A record
and PTR record are as follows:

• Microsoft DHCP servers with standard Windows 2000 Server (Service Pack
3 or higher versions)/Windows Server 2003 features

• ISC DHCP 3.0 or higher

• DHCP server with standard NetWare 5 features

Setting the dynamic DNS function

Make settings with telnet using the “dns” command. For details, see p.196 “dns”.
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Configuring SSL Encryption

This section describes how to configure SSL (secure sockets layer) encryption.
Using SSL encryption, you can issue a server certificate to authorize use of the
printer.

This can be specified only when the optional network date protection unit is in-
stalled.

SSL (Secure Sockets Layer) Encryption

This can be specified by the network administrator.

To protect the communication path and establish encrypted communication, cre-
ate and install the server certificate.

There are two ways of installing a server certificate: create and install a self-cer-
tificate using the machine, or request a certificate from a certificate authority and
install it.

❖ Configuration flow (self-signed certificate)

A Creating and installing the server certificate
Install the server certificate using Web Image Monitor.

B Enabling SSL
Enable the [SSL/TLS] setting using Web Image Monitor.

❖ Configuration flow (certificate issued by a certificate authority)

A Creating the server certificate
Create the server certificate using Web Image Monitor.
The application procedure after creating the certificate depends on the cer-
tificate authority. Follow the procedure specified by the certificate authority.

B Installing the server certificate
Install the server certificate using Web Image Monitor.

C Enabling SSL
Enable the [SSL/TLS] setting using Web Image Monitor.
Creating and installing the Server Certificate (Self-Signed Certificate)
Create and install the server certificate using Web Image Monitor.

Creating and Installing the Self-Signed Certificate

Create and install the server certificate using Web Image Monitor.

This section explains the use of a self-certificate as the server certificate.

A Open a Web browser.

B Enter “http://(printer's-address)/” in the address bar to access the print-
er.
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C Log on to the printer.

The network administrator can log on.

Enter the login user name and login password.

D Click [Configuration], then click [Security], and then click [Certificates].

E Click [Create].

F Make the necessary settings.

For details about the displayed items and selectable items, see Web Image
Monitor Help.

G Click [OK].

The setting is changed.

H Click [OK].

A security warning dialog box appears.

I Check the details, and then click [OK].

[Installed] appears under [Certificate Status] to show that a server certificate for
the printer has been installed.

J Log off from the printer.

❒ Click [Delete] to delete the server certificate from the printer.

Creating the Server Certificate (Certificate Issued by a Certificate Authority)

Create the server certificate using Web Image Monitor.

This section explains the use of a certificate issued by a certificate authority as
the server certificate.

A Open a Web browser.

B Enter “http://(printer's-address)/” in the address bar to access the print-
er.

C Log on to the printer.

The network administrator can log on.

Enter the login user name and login password.

D Click [Configuration], then click [Security], and then click [Certificates].

The [Certificates] page appears.

E Click [Request].
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F Make the necessary settings.

For details about the displayed items and selectable items, see Web Image
Monitor Help.

G Click [OK].

[Requesting] appears for [Certificate Status] in the [Certificates] area.

Quoting the character string displayed in [Certificate Request Contents:], apply
to the certificate authority for a certificate.

H Log off from the printer.

I Apply to the certificate authority for the server certificate.

The application procedure depends on the certificate authority. For details,
contact the certificate authority.

When applying, use the data created with Web Image Monitor.

❒ By using Web Image Monitor, you can create the contents of the server
certificate but you cannot send the application.

❒ Click [Cancel Request] to cancel the request for the server certificate.

Installing the Server Certificate (Certificate Issued by a Certificate Authority)

Install the server certificate using Web Image Monitor.

This section explains the use of a certificate issued by a certificate authority as
the server certificate.

Enter the server certificate contents issued by the certificate authority.

A Open a Web browser.

B Enter “http://(printer's-address)/” in the address bar to access the print-
er.

C Log on to the printer.

The network administrator can log on.

Enter the login user name and login password.

D Click [Cancel], then click [Security], and then click [Certificates].

The [Certificates] page appears.

E Click [Install].

F Enter the contents of the server certificate.

In the [Certificate Request] box, enter the contents of the server certificate re-
ceived from the certificate authority.
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For details about the displayed items and selectable items, see Web Image
Monitor Help.

G Click [OK].

[Installed] appears under [Certificate Status] to show that a server certificate for
the printer has been installed.

H Log off from the printer.

Enabling SSL

After installing the server certificate in the printer, enable the SSL setting.

This procedure is used for a self-signed certificate or a certificate issued by a cer-
tificate authority.

A Open a Web browser.

B Enter “http://(printer's-address)/” in the address bar to access the print-
er.

C Log on to the printer.

The network administrator can log on.

Enter the login user name and login password.

D Click [Cancel], then click [Security], and then click [SSL/TLS].

The [SSL/TLS] page appears.

E Click [Enable] for [SSL/TLS].

F Click [Apply].

The SSL setting is enabled.

G Log off from the printer.

❒ If you set [Permit SSL/TLS Communication] to [Ciphertext Only], enter “ht-
tps://(printer's address)/” to access the printer.

User Settings for SSL (Secure Sockets Layer)

If you have installed a server certificate and enabled SSL (Secure Sockets Lay-
er), you need to install the certificate on the user’s computer.

The network administrator must explain the procedure for installing the certifi-
cate to users.

If a warning dialog box appears while accessing the machine using the Web
browser or IPP, start the Certificate Import Wizard and install a certificate.
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AWhen the [Security Alert] dialog box appears, click [View Certificate].

The [Certificate] dialog box appears.

To be able to respond to inquiries from users about such problems as expiry
of the certificate, check the contents of the certificate.

B On the [General] tab, click [Install Certificate...].

Certificate Import Wizard starts.

C Install the certificate by following the Certificate Import Wizard instruc-
tions.

❒ For details about how to install the certificate, see the Web browser Help.

❒ If a certificate issued by a certificate authority is installed in the printer, con-
firm the certificate store location with the certificate authority.

For details about where to store the certificate when accessing the printer
using IPP, see the Web Image Monitor Help.
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Installing Font Manager 2000

❒ Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, install-
ing applications by Auto Run requires administrator permission. To install a
printer driver by Auto Run, log on using an account that has administrator per-
mission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

C Click [Font Manager 2000].

D Follow the instructions on the screen.
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Using Adobe PageMaker Version 6.0, 6.5, 
or 7.0

Under Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT 4.0
with Adobe PageMaker, you need to copy PPD files to the PageMaker folder.

PPD files have the .ppd extension in the folder “DRIVERS\PS\WIN9X_ME \(Lan-
guage)\DISK1\” on the CD-ROM.

The “WIN9X_ME” folder inside the “PS” folder is for Windows 95/98/Me. Use the
folder at this level that is appropriate for the operating system you are currently
using.

The third folder “(Language)” may be substituted by an appropriate language
name.

Copy the “.ppd” file to the PageMaker folder.

• For PageMaker 6.0 default installation
The directory is “C:\PM6\RSRC\PPD4”.

• For PageMaker 6.5 default installation
The directory is “C:\PM65\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

• For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

❒ If the driver is not set correctly after copying the “.ppd” file, printing may not
be performed properly.

❒ When using PageMaker, the optional features that can be selected by the
printer driver will not be active. The following procedure describes how to ac-
tivate the optional printer features.

A On the [File] menu, click [Print].
The [Print Document] dialog box appears.

B Make the necessary settings in the [Features] box.
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When Using Windows Terminal 
Service/MetaFrame

The following explains how to use Windows Terminal Service and Maintenance.

Operating Environment

The following operating systems and MetaFrame versions are supported.

❖ Windows NT Server 4.0 Terminal Server Edition

• MetaFrame 1.8 SP3/FR1 SP3/SP4

• MetaFrame XP 1.0 SP1/SP2/FR1

❖ Windows 2000 Server/Advanced Server

• MetaFrame 1.8 SP3/FR1 SP3/SP4

• MetaFrame XP 1.0 SP1/SP2/FR1/FR2

Supported Printer Drivers

❖ When Windows Terminal Service is operating

• PCL printer drivers

• PostScript 3

❒ The RPCS printer driver is not supported.

❒ Some RPCS printer driver functions do not work if Windows Terminal Service
is installed.

Limitations

The following limitations apply to the Windows Terminal Service environment.

These limitations are built in Windows Terminal Service or MetaFrame.

❖ Windows Terminal Service
In an environment where Windows Terminal Service is installed, some printer
driver functions are unavailable, even if no Windows Terminal Service func-
tions are used. Use the install mode to install SmartDeviceMonitor for Client
in an environment where Terminal Service is running on a Windows NT Serv-
er 4.0 Terminal Server Edition or Windows 2000 Server family computer. The
following are the two methods of installation using the install mode:
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A Use [Add/Remove Programs] in [Control Panel] to install SmartDeviceMonitor
for Client.

B Enter the following command in the MS-DOS command prompt:

CHANGE USER /INSTALL
To quit the install mode, enter the following command in the MS-DOS com-
mand prompt:

CHANGE USER /EXECUTE

For more information, see Windows Help.

❖ MetaFrame's [Auto-creating client printers]
Using [Auto-creating client printers], you can select a logical printer created by
copying the client's local printer data to the MetaFrame server. We strongly
recommend testing this function in your network environment before using it
for your work.

• The settings for optional equipment will not be stored in the server after the
equipment is disconnected. The settings for optional equipment will be re-
stored to its defaults each time the client computer logs on to the server.

• When printing a large number of bitmap images or using the server in a
WAN environment over dial-up lines such as ISDN, printing may not be
possible or errors may occur, depending on data transfer rates.

• When using MetaFrame XP 1.0 or higher versions, we recommend making
settings in [Client Printer bandwidth] under [Citrix Management Console] accord-
ing to the environment.

• If a print error occurs on the server and the print job or a printer created in
[Auto-creating client printers] cannot be deleted, we recommend the follow-
ing:

• MetaFrame 1.8 SP3, MetaFrame XP 1.0 SP1/FR1
Make settings in [Delete unfinished print jobs] in the registry. For details,
see the Readme file provided with MetaFrame.

• MetaFrame XP 1.0 FR2
Make settings in [Delete pending print jobs at logout] under [Printer Proper-
ties Management] of Citrix Management Console.

❖ MetaFrame's [Printer driver replication]
Using [Printer driver replication], you can distribute printer drivers across all
servers in a server farm. We strongly recommend testing this function in your
network environment before using it for your work.

• If the printer drivers are not properly copied, install them directly onto each
server.
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Information about Installed Applications

expat

Use of the software installed on this product, including the controller (hereinafter
“software”) and the expat Version 1.95.2 application software (hereinafter “expat
1.95.2”), is subject to the following conditions:

The product manufacturer provides warranty and support to the software of the
product including expat 1.95.2 and the product manufacturer allows the initial de-
veloper of expat 1.95.2 to be free from these obligations.

Copyright © 1998, 1999, 2000 Thai Open Source Software Center Ltd

and Clark Cooper

Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the “Software”), to deal in the
Software without restriction, including without limitation the rights to use, copy,
modify, merge, publish, distribute, sublicense, and/or sell copies of the Software,
and to permit persons to whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY
KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WAR-
RANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PUR-
POSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHER-
WISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFT-
WARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

❒ Information on expat 1.95.2 is available at:

http://expat.sourceforge.net/

JPEG LIBRARY

• The software installed on this product is based in part on the work of the In-
dependent JPEG Group.

NetBSD

Copyright Notice of NetBSD

For all users to use this product:
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This product contains NetBSD operating system:

For the most part, the software constituting the NetBSD operating system is not
in the public domain; its authors retain their copyright.

The following text shows the copyright notice used for many of the NetBSD
source code. For exact copyright notice applicable for each of the files/binaries,
the source code tree must be consulted.

A full source code can be found at http://www.netbsd.org/.

Copyright © 1999, 2000 The NetBSD Foundation, Inc.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

A Redistributions of source code must retain the above copyright notice, this list
of conditions and the following disclaimer.

B Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or oth-
er materials provided with the distribution.

C All advertising materials mentioning features or use of this software must dis-
play the following acknowledgment:
This product includes software developed by the NetBSD Foundation, Inc.
and its contributors.

D Neither the name of The NetBSD Foundation nor the names of its contributors
may be used to endorse or promote products derived from this software with-
out specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND
CONTRIBUTORS ''AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DIS-
CLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEM-
PLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF AD-
VISED OF THE POSSIBILITY OF SUCH DAMAGE.

Authors Name List

All product names mentioned herein are trademarks of their respective owners.

The following notices are required to satisfy the license terms of the software that
we have mentioned in this document:

• This product includes software developed by the University of California, Ber-
keley and its contributors.
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• This product includes software developed by Jonathan R. Stone for the Net-
BSD Project.

• This product includes software developed by the NetBSD Foundation, Inc.
and its contributors.

• This product includes software developed by Manuel Bouyer.

• This product includes software developed by Charles Hannum.

• This product includes software developed by Charles M. Hannum.

• This product includes software developed by Christopher G. Demetriou.

• This product includes software developed by TooLs GmbH.

• This product includes software developed by Terrence R. Lambert.

• This product includes software developed by Adam Glass and Charles Han-
num.

• This product includes software developed by Theo de Raadt.

• This product includes software developed by Jonathan Stone and Jason R.
Thorpe for the NetBSD Project.

• This product includes software developed by the University of California,
Lawrence Berkeley Laboratory and its contributors.

• This product includes software developed by Christos Zoulas.

• This product includes software developed by Christopher G. Demetriou for
the NetBSD Project.

• This product includes software developed by Paul Kranenburg.

• This product includes software developed by Adam Glass.

• This product includes software developed by Jonathan Stone.

• This product includes software developed by Jonathan Stone for the NetBSD
Project.

• This product includes software developed by Winning Strategies, Inc.

• This product includes software developed by Frank van der Linden for the
NetBSD Project.

• This product includes software developed for the NetBSD Project by Frank
van der Linden

• This product includes software developed for the NetBSD Project by Jason R.
Thorpe.

• The software was developed by the University of California, Berkeley.

• This product includes software developed by Chris Provenzano, the Universi-
ty of California, Berkeley, and contributors.

Samba(Ver 2.2.2-1.1)

Copyright © Andrew Tridgell 1994-1998
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This program is free software; you can redistribute it and/or modify it under the
terms of the GNU General Public License as published by the Free Software
Foundation; either version 2 of the License, or (at your option) any later version.
This program is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or FIT-
NESS FOR A PARTICULAR PURPOSE. See the GNU General Public License
for more details. You should have received a copy of the GNU General Public
License along with this program; if not, write to the Free Software Foundation,
Inc., 675 Mass Ave, Cambridge, MA 02139, USA.

RSA BSAFE®

• This product includes RSA BSAFE® cryptographic or security protocol soft-
ware from RSA Security Inc.

• RSA is a registered trademark and BSAFE is a registered trademark of RSA
Security Inc.in the United States and/or other countries.

• RSA Security Inc. All rights reserved.
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